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Preface

This redbook will help you install, tailor and configure Netfinity Director in a
Windows NT environment. It provides details on the Server, Console and Client
components that are distributed with Netfinity Director. The Client component was
introduced in an earlier redbook, Universal Manageability: Enterprise
Management Integration, SG24-5388. This new redbook uses that as a base for
explaining how all of the functions integrate together to provide a cohesive
management platform for the Windows 32-bit operating systems.

This book can be used by systems integrators or planners to help establish a new
framework for systems management. The step-by-step approach taken in each
chapter helps the novice see and understand how each function works.

This book also helps position Netfinity Manager customers for their eventual
migration to this new product.

The team that wrote this redbook

This redbook was produced by a team of specialists from around the world
working at the International Technical Support Organization, Raleigh Center.

Barry Nusbaum is a Consulting International Technical support representative at
the International Technical Support Organization, Raleigh Center. He writes
extensively and teaches IBM classes worldwide on all areas of systems
management on the NT and AIX platform. He is also currently working on projects
related to the e-business Application Framework and WebSphere. Before joining
the ITSO seven years ago, he worked in Professional Services in the United
States as a National Communications Specialist. You can reach him by e-mail at
bnusbaum@us.ibm.com.

Manfred Ertl is a pre-sales System Engineer with Netfinity Server Systems in
Germany. He teaches technical courses on the IBM Netfinity Server to Business
Partners. He also teaches the marketing sales representatives of Business Partners
during large marketing events. He has 23 years of IBM experience, the last five with
the Personal Systems Group. Before he joined the Netfinity pre-sales team he
worked at the IBM education center and later he was the Country Program Manager
for the PC Institute in Germany. You can reach him by e-mail at ertl@de.ibm.com.

Johann Klotz is a pre-sales Netfinity Servers System Engineer for the Personal
System Group in France. He has been working for IBM since 1997. His areas of
expertise include Netfinity servers, operating systems, and technical support.

Carsten Lund is a pre-sales Netfinity Servers System Engineer in Denmark. He
has worked for IBM since 1991, where he has worked for the Personal System
Group since 1997. He also teaches PC Institute courses. His areas of expertise
include Netfinity servers, systems management and database systems.

Thanks to the following people for their invaluable contributions to this project:

Margaret Ticknor, Shawn Walsh, David Watts
International Technical Support Organization, Raleigh Center
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Julianne Bielski, David Feisthammel, Eric Rasmussen,Goran Wibran
IBM RTP

Yvonne Couderc, Stephan Hilby, Gilles Piedeloup
IBM France

Comments welcome

Your comments are important to us!

We want our redbooks to be as helpful as possible. Please send us your
comments about this or other redbooks in one of the following ways:

• Fax the evaluation form found in “IBM Redbooks evaluation” on page 317 to
the fax number shown on the form.

• Use the online evaluation form found at http://www.redbooks.ibm.com/

• Send your comments in an internet note to redbook@us.ibm.com
viii Netfinity Director - Integration and Tools



Chapter 1. Netfinity Director functions

This chapter provides an overview of the base Netfinity Director functions. We
show what Netfinity Director is, the main management tasks it can perform, and
the management standards it utilizes.

1.1 Netfinity Director base functions

Netfinity Director is the IBM systems management software that is used to
manage small-to-medium-size environments that consist of servers, workstations
and mobile systems. While the immediate focus is on newer IBM hardware, you
can use the software developers kit (SDK) that is available with Netfinity Director
to add support for older hardware as well as non-IBM hardware. It can run on the
same system as Netfinity Manager and it allows you to perform many different
systems management tasks with the goal of reducing the total cost of ownership
(TCO). It is likely that it will replace Netfinity Manager sometime in the future.

There are two versions of Netfinity Director, a light and a full one. When you
install the product, you have to a enter a license key. The license key determines
if you will install the light or the full version. The full version adds the following
features:

• An SNMP browser

• The ability to perform Software Distribution

• Expanded group management functions

• Application management

• Internet services

• Support for an AS/400 server

For example, you can enable Event Actions Plans for an entire group. See
3.3.2.1, “Event action plans” on page 118, for more information on Event Action
Plans.

Netfinity Director is divided into three components:

1. Each system that is managed has an agent, including the system that is the
management server.

2. The server component is the central task that collects management
information from the agents and controls the security privileges of
administrators.

3. A console is provided to connect to the server (using TCP/IP only) and
provides an administrator-specific graphical interface to the management and
administration tasks.

Following is a list of the main Netfinity Director features:

• Inventory management
• CIM compliance
• DMI compliance
• Resource monitoring
• File transfer
• Remote control
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• Task scheduling
• Process management
• Event Management and logging
• Cluster Browser for MicroSoft Cluster Server (MSCS) systems
• Managing Netfinity Manager MPM Agents

These functions and their configuration are discussed in Chapter 3, “Core
functions” on page 71.

1.2 Netfinity Director additional features

The Netfinity Director characteristics we discussed in 1.1, “Netfinity Director base
functions” on page 1 are hardware independent. They are available for managing
IBM or non-IBM hardware. However, IBM provides a set of additional tools (called
Life Cycle Tools) specific to its Intel-based systems. We explain these tools in the
following section.

1.2.1 Life Cycle Tools
Life Cycle Tools (LCT) are add-on software components that help systems
administrators or help-desk technicians manage their tasks. They are called Life
Cycle Tools because they can be used at various stages in the life of a managed
system (for example, during setup, operating system installation, management or
administration).

We can distinguish between two kinds of LCT: those that are dedicated to server
administration and those that are used to manage clients systems (desktops,
mobiles and graphical workstations).

Table 1. List of Life Cycle Tools

1.2.1.1 Server Life Cycle Tools
With IBM Netfinity Servers you can use a Service Processor or an Advanced
Management Adapter, which allows you to control Netfinity Servers remotely,
even if a system is powered off. The Advanced System Management tool helps
you perform the management actions. For examples and more details see 4.2.1,
“Advanced System Manager” on page 174. Note that the direct connection to the
Service Processor is not implemented yet.

Capacity Manager is a Java-based utility with which you can monitor and track
the use of your systems resources on different target computers. The results of
this monitoring can be displayed graphically. Capacity Manager provides a
forecasting tool which, based on the collection of data during a 21-day period
(minimum), will tell you when utilization of system resources might become

Server Life Cycle Tools UMS Desktop Extensions

Cluster Manager CMOS Configurator

Capacity Manager Alert on LAN

RAID Manager CoSession Remote 32

Update Connector Manager PC Doctor

Advanced System Management ConfigSafe

LAN Client Control Manager CMOS Configurator
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critical on the monitored systems. It provides a wizard which helps determine
bottlenecks and provides some recommendations about what actions to take in
such events. For examples and more details see 4.2.2, “Capacity Manager” on
page 180.

The Cluster Manager is also known as IBM System Cluster Manager (ICSM). It is
a graphical tool which allows you to monitor the status of the different nodes on
different Microsoft clusters. It also provides some wizards to help manage the
resources and the groups of the clusters. For examples and more details see
4.2.3, “Cluster Manager” on page 181.

With the RAID Manager, you can remotely obtain an overview of the RAID
configuration of a server (for example, you can see the number of RAID adapters,
levels of firmware used, and the RAID configuration elements, such as stripe
size). Based upon the data you see with the RAID Manager, you can take some
actions, such as adding or removing some logical drives, using the Logical Drive
Migration (which changes the RAID level of an array), or increasing the size of an
array. For examples and more details see 4.2.5, “ServeRAID Manager” on page
186.

1.2.1.2 Cross-Brand Life Cycle Tools
Cross-Brand Life Cycle Tools are those that apply across all IBM brands: Netfinity
servers, Intellistation workstations, PC 300s and ThinkPads.

By accessing UM Services with a Web browser, the MMC, or the Netfinity
Director Console, you have the opportunity to access or define information
related to all of the equipment that is supported by the Cross-Brand Life Cycle
Tools. It integrates all of the tools into a single Netfinity Director GUI.

Alert on LAN
Alert on LAN is a hardware and software technology implemented in a computer
and its network adapter, to enable the system to transmit an alert from a
DMI-compliant manageability chip even when the system is powered off. This
technology has been co-developed by IBM and Intel, within the framework of the
IBM/Intel Advanced Manageability Alliance.

You can find extensive information on Alert on LAN and IBM/Intel Advanced
Manageability Alliance at the following URLs:

http://www.pc.ibm.com/us/desktop/alertonlan/index.html.

http://www.intel.com/network/network_strategy/aol.htm

An example of an application for this is when someone removes the processor of
a computer. An initial alert is sent to the administrator console, because the
chassis had been removed, and a second alert is also sent because the
processor itself was removed.

Thus, Alert on LAN helps you to:

• Protect your assets, by notifying you of hardware configuration changes.

• Reduce response times. Alert on LAN allows you to respond without
waiting for the user to complain about a system change, thus maintaining
their productivity.
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Alert on LAN 2, which was incorporated into selected IBM network devices in
1999, will extend these capabilities, by allowing the network administrator to send
a corrective action to the client system (for example, a reboot request if the
system is hung).

Currently, Alert on LAN can notify you of the following system changes:

• System unplugged from power source

• System unplugged from network

• Chassis intrusion

• Processor removal

• System environmental errors (high temperatures, fan speed or voltage
fluctuations)

• Operating systems error

• System power-on errors

• System is hung

How it works
An Alert on LAN system needs three key components:

4. An Alert on LAN motherboard
5. A BIOS implementing this technology
6. An Alert on LAN network adapter

Even when a system is powered down, two kind of packets are sent by the
computer: some status packets, generated at regular intervals (called a heartbeat
timer period) that informs the manager of the health of the system (for example,
temperature or voltage), and some alert packets that are sent when an error
occurs, for example, a chassis intrusion or an operating system error.

The system is never really powered down. The on/off switch just places it in a
state where almost no power is used, but enough is used to allow the network
adapter to send information packets. A complete shutdown of the computer
requires you to unplug its power cord. At that point no more packets can be sent
and the management software can alert the administrator that the remote
computer is no longer responding.

Note: Alert on LAN is available from UM Services under the Configuration tab
and the Configure Alert on LAN task in the Netfinity Director Console.

Supported systems

Currently, the Alert on LAN features are supported on the PC 300 PL (Models
6862 or 6892) with the on-board Ethernet 10/100 controller, or with the IBM
token-ring with Alert on LAN (only one Wake on LAN device supported per
system). Other supported systems are the Intellistation E Pro, M Pro, and Z Pro
(Models 6893, 6889 and 6865), only with their embedded Ethernet 10/100
adapter. Lastly, the IBM PC 300 GL Models 6265, 6275, 6285 are supported with
the IBM Token-Ring w/ Alert on LAN adapter.

To disable the on-board 10/100 Ethernet adapter of the 300 PL, change switch 1
position 6 from on to off.
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Note: You can check the supported systems at:
http://www.pc.ibm.com/us/desktop/alertonlan/syssupport.html.

In order for this technology to be useful, system administrators need to use a
management software that can detect Alert on LAN packets, for example, IBM
Netfinity Manager, or Intel LANDesk Client Manager Administrator.

Information on management software can be retrieved from:

http://www.pc.ibm.com/us/desktop/alertonlan/softreqs.html.

Asset ID is a function that lets a system administrator write data on an EEPROM
(embedded on the motherboard of the managed computer). The data can be
related to the user of the system, or to some management item, such as the
leasing information for the computer.

Figure 1. Asset ID sample

Figure 1 shows an example of the Asset ID function. Other information can be
related to the serial numbers for the main system’s components (for example,
motherboard, memory, processors, hard drives or power supply), or to the user.
Some blank fields allow the system administrator to write any information he or
she chooses to the Asset ID EEPROM.

By accessing UM Services with a Web browser or the MMC, you have the
opportunity to define this information.

1.2.1.3 UM Desktop Extensions
Most of the Desktop Life Cycle Tools are implemented in the UMS Desktop
Extensions (discussed in 1.2.1.4, “UMS Desktop Extensions” on page 6). Some
Netfinity Director functions 5
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are part of the base UM Services product. We discuss here these implemented in
the base product.

Alert on LAN is more widely discussed in “Alert on LAN” on page 3. This feature
allows a system administrator to be warned, for a compliant computer, of events
such as the removal of some system’s component, or chassis intrusion.

1.2.1.4 UMS Desktop Extensions
The UMS Desktop Extensions are an additional layer of software added to UM
Services. It extends the administration capabilities on the target on which it is
installed. UM Services allow you to review and modify the configuration of a
target system. The UMS Desktop Extensions bring you more powerful tools to
take specific administration actions on the managed computer.

CMOS Configurator
This applet lets you modify some basic configurations elements of the system’s
BIOS. The changes are applied after the reboot of the target system. You can
modify the power on and administrator passwords. If you set up passwords, you
will need the passwords for any future modifications with this tool. In terms of
other security concerns, other tabs of the CMOS configurator let you activate and
deactivate the floppy and IDE controller, enable the AssetCare or Asset ID
functions, or disable the keyboard on the target system at boot time during
adapter ROM initialization.

You also have the opportunity to modify some power management settings. You
can switch on or off:

• ACPI BIOS mode
• APM BIOS mode
• Wake on-LAN
• Modem ring detect
• PCI Wakeup
• Serial port A ring detect

Artisoft Remote Utilities
These utilities allow you to launch a graphical remote control, or a file transfer
session between your station and the target machine.

Due to bandwidth considerations, you may want to modify the incoming display of
the remote machine by modifying some display characteristics:

• Customize the screen resolution
• Display the wallpaper or do not display it
• Display the background patterns or do not display it
• Disable the screen saver
• Disable the active desktop
• Disable desktop animation

The rule of thumb for the best performance is easy to understand: the more
options you have enabled, the slower the remote control. A recommended
configuration would be to choose a custom resolution of 640 pixels, with 16
colors, and to leave the other options unchecked. On the other hand, if you are
investigating a problem (such as a system hang or General Protection Fault) that
you cannot easily reproduce, keep in mind that one of the conditions of the
problem might be related to the presence of one of these configuration elements.
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Figure 2. Remote Control options from the Artisoft Remote Utilities

Note: If you choose to modify some features, they will be changed on the remote
machine. This is not an operation that is transparent to the user. For example, if
you change the screen resolution from 800x600 to 640x480, the user will see
their display change to 640x480.

To help save bandwidth, three options are available for file transfer:

1. Intelligent Transfer: Only the part of a file that has changed since the last
transfer will be sent rather than the entire file.

2. Include Subdirectories: Transfers all of the subdirectories in a folder.

3. Keep Partial file: If the Intelligent Transfer option is checked, selecting this
option will keep track of a file transfer and if it does not complete (for example,
due to a time out), then it will be resumed when you re-launch the file transfer.
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Figure 3. The File Transfer window

Note: If you selected the Web-based Remote Control option in the client
configuration part of install, and then you install Artisoft Remote Utilities, Artisoft
prevents the Remote Control tool from showing up.

ConfigSafe
ConfigSafe is a tool that maintains a snapshot of the Windows configuration files.
Different snapshots can be archived with a date and time stamp.

Note: There is a DOS program called sos.exe, located in the CFGSAGE folder,
which allows you to restore the system configuration files when the user cannot
reboot the operating system.

EZ Admin
If you do not want your support team losing time and money on solving problems
caused by a bad configuration change made by an end user, you can disable
common features of the Windows operating systems. Based on the Microsoft
systems’ policies, you can perform the following actions:
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Table 2. EZ Admin actions

Figure 4. The EZ Admin Shell and System tab

PC-Doctor
PC-Doctor is a remote diagnostic tool. From the Web browser you can launch a
series of tests related to storage devices (for example, hard drive, floppy,
CD-ROM and memory), the video subsystem and the CPU of the remotely
managed computer. You can also determine a potential point of failure on the
target system.

EZ Admin tab Actions available

Control Panel Hide Display Settings tab

Shell and System Remove Run Command from Start menu

Hide Network Neighborhood

Disable Save Settings at exit

Remove the Task bar from settings on the
Start Menu

No entire Network in Network Neighborhood

Disable Registry Editing Tools

Applications Run a list of specified applications only
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Figure 5. A memory test for the remote system 9.24.106.25

1.3 Our environment

To work on the Netfinity Director product, our lab environment consisted of three
Netfinity 3000 (Model 8476) servers, with Netfinity Director server and its console
installed. The server managed three remote PC 300 PL (Model 6862) located on
the same token-ring network and a Netfinity 5500 (Model 8660) server located on
an Ethernet network, going over an 8271 bridge.

The desktops were installed with the factory preloaded operating system, but in
order to cover various aspects of the agent product, one was installed in dual
boot mode (Windows 95 and Novell NetWare 5.0), another with three operating
systems (Windows 95, Windows NT, and OS/2 Warp V4) and the final with just its
native operating system (Windows 95).

Table 3. System configurations

System Set up information

23-M227 Netfinity 3000 (8476-31U)
IP address: 9.24.104.45
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1.4 Standards

Netfinity Director implements many industry standards. We show examples of
these standards throughout this publication. A basic description as well as a
pointer to places that have more information on them is shown in the following
section.

1.4.1 Implementations
XML is used by UM Services (not Netfinity Director) in conjunction with
cimv20.dtd, to format the management data that flows back and forth between the
administrator’s remote Web browser and the HTTP server on the UM Services
system. DMI is installed (with a startup setting of Manual) by UM Services to
provide support for the UM Desktop extensions (for example, EZ Admin) and to
support the DMI browser that ships with UM Services. SNMP is used by UM
Services as a tactical standard for providing inventory and alert data to
management platforms that do not yet support CIM. Netfinity Director uses SNMP
in event actions in order to send alert data to management platforms that do not
recognize Netfinity Director events.

SF5CEINX IBM PC 300 PL (6862-R1U)

Operating System: Windows 95 4.00.950 B
IP (DHCP): 9.24.106.29

23-ff426 Netfinity 3000 (8476-31U)

Windows NT 4 Server Service Pack 4
IP address (DHCP) : 9.24.106.158

23-8p4vl IBM PC 300 PL (6862-R1U)

Windows NT 4 Workstation Service Pack 5
IP address (DHCP): 9.24.106.27

JKL-SRV or 23-FF406 Netfinity 3000 (8476-31U)

Windows NT 4 Server SP 3 / SP 4
IP address (DHCP): 9.24.106.130

NF5500 Netfinity 5500 (8660-4RU

Windows NT4 Server Service Pack 4
IP address (DHCP): 9.24.105.202

CLARK / FOZZY /
JABBATH

IBM PC 300 PL (6862-R1U)

Windows 95 4.00.950 B / OS/2 Warp V4 no fixpack
/ Windows NT 4 Server Service Pack 4

IP address (DHCP): 9.24.106.25

System Set up information
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1.4.2 What is CIM and why is it important?
The Common Information Model (CIM) is a standard defined by the Distributed
Management Task Force (DMTF). Version 2.2 of the standard was released in
June 1999 (and is available from the Web site http://www.dmtf.org). CIM is a set
of methodologies and syntaxes (also called a language) which describes the
management features and capabilities of any device (integrated or peripherals) or
software that is part of a computer. The CIM model is implemented in systems
using Managed Object Format (MOF) files. That means each hardware
component or piece of software that is CIM-compliant must be provided with its
set of MOF files to be managed.

There are six base MOF files that have been validated and released by the
DMTF. Each vendor must provide its set of MOF files to have its hardware or
software manageable using CIM instrumentation. These MOF files, available
from the DMTF’s Web site, are listed below:

Figure 6. The MOF files provided by the DMTF

When you install UM Services on a system, you will not see these files, because
they are integrated with a set of MOF files provided with UM Services. During the
installation stage of the Netfinity Director agent, one phase is dedicated to the
installation of MOF files. For example, the following window appears during the
installation process:

Figure 7. A MOF file provided with UM Services Plus is parsed

The MOF file above is related to the utility ConfigSafe. Thus, ConfigSafe will be
manageable from a management tool. The MOF file tells the management tool
what actions and administrative tasks can be done with ConfigSafe.

If you look into the cfgsafeu.mof file, you see the following:
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Figure 8. The content of a MOF file

According to the abstract, you can see that this MOF file tells the management
agent that among the different actions or information available with ConfigSafe,
there are some that permit it to see the names of the snapshots taken, associated
with a date.

CIM is an important model for better manageability, because it allows you to
perform powerful management tasks, independent of the management software
used.

The CIM model is divided into two main parts:

1. CIM specifications

These are the descriptions of the CIM language, naming conventions (called
the Meta Schema, a formal definition of the model), and integration with other
management models, such as SNMPs, MIBs or the DMTFs MIFs (CIM
specifications use a PDF file specification).

To organize the information related to an object, CIM first defines the notion of
schema, which is a group of classes with a single owner. A class is a container
for a set of instances, for example, objects having the same properties and
methods. Properties can be of different types (for example, a string when the
property contains a character string, or boolean if it just accepts 0 or 1 as
values).

The following window helps you understand these concepts:
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Figure 9. The Netfinity Director CIM browser

In Figure 9 you have one schema, root, which has several classes: CIMV2,
Default, IBMPSG, and Security. These classes appear with their fully qualified
class-name (for example, root\IBMPSG). Some classes can include other
classes. The class Win32_ShareToDirectory (which is highlighted in Figure 9) has
several instances. The one which is selected has a property called __SERVER,
which is a string type. In addition, the __SERVER property contains (as a string)
the NetBIOS name of the server, 23-FF406. The instance specifies this as one of
a shared directory for the server. We can see the name of the share in another
property, Share, and this sharing name is ADMIN$ shown in Figure 10:
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Figure 10. The __SERVER property contains the string "23-FF406"

CIM Schema
The CIM Schema is a repository for some of the management information. Three
layers are shown in the CIM Schema.

First, there is the Core Schema. It is a small set of classes, associations and
properties that provide a basic vocabulary for analyzing and describing systems.

The Common Model is a set of classes related to some items concerning specific
areas of the object to manage, but independent from a particular implementation.
There are currently five common areas: systems, applications, networks, devices
and physical.

Figure 11. Description of the error conditions for a printer (from the device’s MOF file)

Figure 11 is an example of the common model devices. It shows an abstract of
the CIM-Device21.mof file, which is a file provided by the DMTF.

Lastly, we have the Extension Schemas, which are technology-specific
extensions of the Common Schema. They can be of two types: Specific General,
meaning this schema is related to some generic specifications, such as Unix98,
or Product Specific, meaning it is related to a particular product (an application or
an operating system).

We saw that CIM was implemented on a system through the use of some MOF
files. Thus, the management tool can access information related to hardware or
software.

To make a comparison, we could say that the CIM specifications are like a
meta-language (a language which describes a language) and that the CIM
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schema is the language itself, containing syntax and vocabulary related to some
general and particular topics.

Management tools can understand the hardware and software that are included
in a system and how to manage them.

1.4.3 What is XML and why is it important?
The Extensible Markup Language, or XML, is a subset of SGML, a language used
to describe documents and their content. XML means eXtensible Markup
Language, and it is currently being defined by the W3C, a consortium that resides
in Switzerland and which has been designing and standardizing the HTML
language. More details can be found at http://www.w3.org/XML or
http://www.ibm.com/xml.

XML complements HTML, because it addresses several HTML limitations that are
covered in 1.4.3.1, “HTML limitations and XML addressing” on page 16. But
beyond this scope, it is a platform-independent data-manipulation language, and
thus complementary with Java (enables the creation of platform-independent
programs) and the Internet (enables platform-independent networking). However,
keep in mind that, as HTML was supposed to be, XML is a language that
describes the information it contains.

1.4.3.1 HTML limitations and XML addressing
Due to the lack of dynamic Web pages, it is inconvenient to display Web pages
using HTML for the following reasons:

• The displaying of Web pages is not the original purpose of HTML

HTML’s original purpose was to describe a document’s contents and to link it
to other information. There is no attention paid to how the document should be
displayed in a browser. For example, the role of the <title> tag is to indicate
that it is followed by the title of the document. Most of the HTML elements
have been introduced by browser vendors, for presentational purposes.

• The HTML standard is not respected

In terms of the tools a Web site has been designed with, you can get a
different rendering depending upon what is used. Sometimes, you may see
nothing displayed on your screen due to the Web browser you use.

• HTML is not efficient for the layout of Web pages

Although browser vendors introduced presentational elements, the limitations
of HTML require you to try different tricks to obtain the exact desired display.
For example, if you want to display text with a left indentation, you can use the
<ul> </ul> tags before and after your text. Or you can use <pre> </pre> tags,
or the &nbsp command to obtain what you want. In terms of the Web browser
used, the display will not be the same.

XML remedies these statements and provides more flexibility:

• The author of a document has full control over the way it is displayed.

A subpart of XML, called eXtensible Style sheet Language (XSL), allows the
authors of a document to have full control of fonts, colors, and positioning for
the different elements they want to display on the user’s screen.

• The authors can define their own markup tags inside an XML page.
16 Netfinity Director - Integration and Tools

http://www.ibm.com/xml
http://www.ibm.com/xml
http://www.w3.org/XML


This explains why XML is called a "meta-language". By using XML syntax and
rules, you can create your own tags to describe the information contained in your
documents.

Both style sheets and tags that you create are contained in a separate file from
the XML file, called a DTD (Document Type Definition). DTD files contain the
layout information (colors, fonts and disposition) used to display the different
elements of the XML file, and are used by the XML browser to render the content
of an XML file.

At the present time, XSL is not formally defined, meaning that there is no official
browser to read and display XML information. This part of the XML specifications
is being finalized by the W3C.

1.4.3.2 Searching and agents
Because XML describes the information contained in files and the meaning of the
elements of XML files, it allows search agents to seek information with better
precision than with HTML. Figure 12 shows a sample HTML page in which some
XML code has been inserted. The data displayed on the page is documented with
some tags. For example, the <name> ViaVoice</name> informs you about the
name of the software to which the page is related. When search agents are
XML-compliant, they will be able to analyze Web pages in a smarter and more
flexible way than is done today.

Figure 12. IBM is committed to XML, and therefore uses it in some Web pages
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1.4.3.3 Exchanging information between different systems
One of the goals of XML is the standardization of document types. Because it is
platform-independent, an XML document will be readable from any platform or
program that tries to read it.

Thus, it will allow a better exchange of information between enterprises, making
XML a key component of an e-business strategy.

Currently, XML is not a full standard (for example, XSL is in its final phase of
evaluation). What’s more, it is a harder language than HTML to learn and use. On
the other hand, there is broad support from the industry for XML. It has the
backing of AOL/Netscape, SUN, Oracle, IBM, and Microsoft. Thus, Microsoft
Internet Explorer 5.0 supports XML and an early version of XSL. This language is
also used in Microsoft’s Channel Definition Format (.CDF files describe how Web
servers should push information to desktops).

1.4.4 SNMP’s role
The Simple Network Management Protocol (SNMP) is a result of the work done
by the Internet Engineering Task Force (IETF). It appeared in the 1980s, and the
first Request For Comments (RFC) is dated February 1989 (RFC 1089: SNMP
over Ethernet). There are several versions of SNMP (V1, V2, V2.6, V3), but the
only one that has been standardized by the IETF is Version 1 (RFC 2570, which
describes version 3, is categorized as informational by the authors). The versions
that followed V1 are not standardized, because the authors could not agree on
the security features.

SNMP is a communications protocol, by which a client program (called a network
manager) connects over a TCP/IP network to a server program (called the SNMP
agent). The network manager can thus request some information on the status of
some devices and set some values related to the device. From a technical point
of view, these messages are known as protocol data units (PDUs).

The SNMP agent can transmit information by sending traps to the network
manager (for example, when a managed object does not respond) or by issuing
snmpset commands. The agent has a database in which manageable objects are
described, with the kind of actions that can be done on them. This database is
called a Management Information Base (MIB). There is only one official MIB
accepted by the IETF, but each vendor can furnish a specific MIB related to a
peripheral or the software it sells or they can provide MIB extensions.

SNMP is often used to control and monitor network devices, because it has been
designed as a tool to manage bandwidth on networks. This is what makes SNMP
useful and explains why it is widely used. You can manage virtually any device,
for example, a computer, but also routers, communications controllers, hubs,
switches, bridges and printers. There are some security concerns (SNMP Version
1 PDUs are not encrypted, and there are no authentication mechanisms), but
they are not covered in this book.

1.4.4.1 SNMP and Netfinity Director
When you access the Netfinity Director agent on a system it can use an SNMP
layer to forward alerts to some hosts. Since it does not come with any SNMP
driver you have to install the one that comes with your Windows system. If you
also install the UM Services code then you can do the SNMP installation
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separately, or during the UM Services install process. If you choose the first way,
you have to configure the SNMP agent by accessing the target system with a
Web browser, and if you install it with UM Services, you have the opportunity to
perform some additional configuration steps on this protocol.

Note: Only UM Services can send SNMP traps. The only way to get Netfinity
Director to natively send SNMP traps is by configuring the Send an SNMP Trap
alert action at the server. So, either you install and configure the Windows SNMP
agent on the client along with UM Services, or you use the Director server's Send
an SNMP Trap alert action and install the Windows SNMP agent on the server
only. Both UM Services and the Netfinity Director console contain the Configure
SNMP Agent tool so you can remotely configure the SNMP agent's trap
destination and community.

There is no SNMP browser in Netfinity Director, but it can forward SNMP traps
and messages to others hosts. This means you must configure SNMP agents on
managed desktops, ThinkPads and Netfinity Director servers.

Since there are no tools in Windows 9x to configure SNMP it is up to the
management agent to specify the name of the community and the addresses of
the hosts to which traps should be forwarded.

Note: SNMP parameters are stored in the Windows registry at the following key:

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\SNMP
\Parameters

If you had the UM Services installed on your client system, then it is
recommended that you use either the SNMP service under the Configuration tab
in the UM Services browser interface, or the Configure SNMP Agent task from the
Netfinity Director Console to modify the SNMP parameters. You should avoid
directly accessing the registry because you might introduce errors into your
system. If you want to know more about the registry entries see the following
window:

Figure 13. SNMP parameters are stored in the windows registry
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1.4.4.2 Installing SNMP on a Windows 95 system
To install SNMP, launch the Network applet from the Windows 95 control panel:

.

Figure 14. The Network applet

Click Add and on the following window and click Service.

Figure 15. SNMP is implemented as a Win32-based agent service in Windows 95

On the following window click Have Disk.
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Figure 16. The SNMP agent is not listed by default

You then have to specify the full path to the code. It resides in the
\Admin\Nettools\Snmp directory on the Windows 95 CD-ROM.

Figure 17. The path to the code

Figure 18. SNMP service

Once you obtain the above dialog box, click OK. This brings you back to the
Network control panel.
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Figure 19. The SNMP agent is added to the network component list

The installation begins when you click the bottom OK button.

If you are asked to overwrite some existing files that are newer than the ones
being copied, click No.

During the installation, it is possible that Windows 95 might ask you for the path
to the Windows 95 files (usually, in d:\win95, where d: can be replaced by the
drive letter of your CD-ROM drive).

Once the file copy is finished, click Yes to restart your computer.

Later, if you install UM Services on the computer, do not forget to check the box
SNMP access and trap forwarding to enable the feature.
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Figure 20. Continue installing UM Services

An additional step needs to be completed for SNMP configuration. You must
indicate the name of the community to which the target systems belong and the
IP addresses (a maximum of three) of the systems to whom the SNMP’s traps are
to be forwarded.

To do this, you must launch a supported Web browser to reach the target system.
For the URL enter http://ip_address_of_the_target:411, if you configured the
client agent to listen on port 411 (411 is the default port). After logging in, select
the Tasks tab and select the SNMP function in the left pane (you may have to
collapse the tasks tree to select the SNMP function).

A page similar to the following window then appears:
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Figure 21. The SNMP configuration

Click the Add button and a dialog box appears where you can enter the
community name.

Figure 22. Dialog box to enter the community name for the system

Click the Add button located under the Trap Destination window to obtain the
following dialog box asking you for the IP or IPX destination address of the host
to which you should send the traps:
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Figure 23. Dialog box to enter a destination address for trap forwarding

Click OK to validate. Once you have entered all the addresses of the SNMP
hosts, click Apply on the bottom to record the changes. You should see a
configuration window like the following:

Figure 24. The SNMP configuration has been remotely applied

Once you click Apply, the SNMP agent stops and it is restarted on the remote
computer. There is no need to reboot it for the changes to take effect.

1.4.4.3 Installing SNMP during UM Services installation on Windows 9x
For a Windows 9x-based system, the UM Services installation program will open
the Network control panel. The procedure is the same one that was used to install
SNMP separately from UM Services, except the installation program configures
the SNMP agent.
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Note: If you uninstall IBM UM Services, you have to manually remove SNMP.

You have to check the box SNMP acccess and trap forwarding during the
installation of UM Services.

Figure 25. Enabling of SNMP support

The installation program detects if SNMP is installed or not. If not, it asks you to
proceed with the installation:

Figure 26. UM Services program has detected that no SNMP agent was installed

Click Yes to launch the network control panel. Do not click No since Windows will
ask you to restart the computer and that ends the UM Services installation.

You have to indicate the community name and the IP address of one or more
systems to which the traps should be sent.
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Figure 27. SNMP configuration during UM Services installation

When the installation program finishes, click Yes to restart the computer. UM
Services activates when you start up Windows and SNMP.

1.4.4.4 Installing SNMP on a Windows NT system
In the control panel for Windows NT 4.0, launch the network applet:

Figure 28. Icon for the Network applet

The following window appears:
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Figure 29. Perform Network configuration in Windows NT 4.0

Click the Services tab, and choose Add. In the list of the services shipped with
Windows NT 4.0, you should see the SNMP service.

Figure 30. Add the SNMP service

Click OK. Windows then asks you for the location of the source files.
28 Netfinity Director - Integration and Tools



Figure 31. The CD-ROM drive is e:

After a short file copy, Windows NT asks you for some configuration information
related to the SNMP service.

Figure 32. The Agent tab of the Microsoft SNMP properties

In the Agent tab, fill in the name of the contact (the person who is in charge of the
computer) and the location of the system. These fields are optional. Check the
boxes related to the network services present on the computer.

In the Traps tab, enter the name of a community, and click the Add button. You
can then select the Add button under the Trap destinations tab, to enter the
destination address to which the traps are to be forwarded. You can have several
communities on your network, each one with a dedicated address. We used
TCP/IP here, but IPX addresses can also be used.
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Figure 33. The Traps tab of the SNMP properties

The third tab is related to security considerations. You can specify some
permissions for each community you declared. It is a good security practice to
specify from whom your system can accept SNMP packets, thus protecting the
computer from malicious intentions.

Figure 34. Network management security management
30 Netfinity Director - Integration and Tools



When you have finished the SNMP configuration, click the OK button on the
bottom, which brings you back to the Services tab in the Network applet. You
should see SNMP Service now displayed in the list of the installed services.

Figure 35. The SNMP service is installed

Click the Close button. Windows will ask you to restart the computer. Click Yes.

When you install UM Services on the system, the box SNMP access and trap
forwarding must be checked.

Figure 36. This allows SNMP support with UM Services
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1.4.4.5 Installing SNMP during UM Services install on Windows NT
As specified in Figure 36, once you have launched the installation program for
UM Services on a Windows NT 4.0 system, the SNMP box must be checked.

Then, during the install process, the program will detect if SNMP is already
installed. If this is not the case, it will ask you to proceed with the installation of
the SNMP service, by displaying the following dialog box:

Figure 37. UM service installation program detected that SNMP was not installed

Clicking No will cancel the SNMP installation process, and you will go on with UM
Services installation. If you click Yes, the program will bring up the Network
control panel and some instructions to proceed. These are the same as if you
installed SNMP separately from UM Services, except you have to click No when
Windows NT asks you to restart the computer. Once done, close the UM Services
instructions for installing SNMP by clicking Next. Then, you will be able to
continue with the UM Services installation.

Note: Whichever way you choose to install the SNMP Agent, an additional step
is necessary to have a fully enabled SNMP agent in Windows NT (and therefore
Netfinity Director or UM Services).

SNMP is installed in Windows NT in two parts: an SNMP service and an SNMP
Trap Service. The trap service does not start automatically at startup. If you want
that to occur you can change it using the Services icon in the control panel.

Figure 38. The Services applet from Windows NT control panel

Select SNMP Trap Service -> Startup. The following window will appear:
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Figure 39. Control the startup of services

Check Automatic to have the SNMP Trap service automatically started at each
boot of the operating system. Then click OK.

You can then click Start to launch it immediately. Then click Close.

Note: You can use the SNMP Trap service only to listen for traps, not send them.
Therefore, unless you have a Trap listener installed, there is no need to enable
the SNMP Trap service.

1.4.5 How is DMI used?
Desktop Management Interface (DMI) is a standard that is the result of the work
of the Distributed Management Task Force. The current version is 2.0 and that
became available in June 1998. It introduces security features, such as
authentication functions, logging and security indicators.

DMI can be thought of as the predecessor to CIM even though it works in
different ways. It is considered to be dedicated to a computer’s management and
does not allow any management on networks devices (such as bridges, routers
and printers) as SNMP does. Even though DMI has been standardized it has not
been as widely adopted by the industry as CIM has.

DMI is code that is implemented in your system’s BIOS and in the operating
system. It acts as a layer of abstraction between the management software and
the system’s components. It is accessible locally (through operating system’s
functions) or remotely through remote procedures calls (RPC).

Thus, the software implemented in the operating system is called a service
provider. It gets some requests through RPC calls. To satisfy them it gathers
component information by using the RPCs in conjunction with application
programming interfaces (APIs) provided within the DMI specifications, which are
functions called by applications, and component descriptions stored in databases
called Management Information Files (MIF). Each component that is part of a
system has a MIF file to describe its manageable characteristics, and after being
installed in a system, it is added to the MIF database. Installed means the MIF file
is presented to the DMI service provider for inclusion in the MIF database.
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1.4.6 WFM 2.0
The Wired For Management specifications, published by Intel (located at
http://www.intel.com), are the result of the industry initiatives to define a common
platform to make computers easily manageable and thus reduce the Total Cost of
Ownership (TCO).

TCO can be defined in several ways. Some definitions focus only on acquisition
costs (buying hardware, software and using administrative tools), while others
take into account the lost of productivity when, for example, a user calls the
helpdesk in order to get information on how to use some software. Usually, the
first method has a cost of $2000-$3000 per computer, and the second of around
$8000.

The best manageability is the one that reduces the TCO. In order to reach this
goal, computer industry vendors define standards to help make the management
of their platforms easier. But while CIM, DMI and SNMP cover some of the needs,
the Wired for Management specifications list all the required technologies, and
dictate several recommendations.

WFM covers BIOS, hardware, software, and instrumentation requirements, and
can be considered as a reference source for developers of management
applications. Three types of computers are considered by these specifications:
desktops, mobiles, and servers.

Such a distinction is made for each platform’s characteristics. For example, a
mobile user must pay special attention to power management, whereas systems
administrators focus on the down-time related to servers. WFM 2.0 is not itself a
technology, but a set of requirements or recommendations regarding the
technologies to use on computer platforms.

1.4.6.1 Power Management: ACPI
The Advanced Configuration and Power Interface (ACPI) is a power management
specification developed by Intel, Microsoft and Toshiba. It is an interface between
the operating system, the hardware and the BIOS that implements suspend,
resume, and restart functions. A feature of ACPI is the OnNow function, which
allows a computer to be awakened by an external device, such as a keyboard or
a mouse.

A system can have four distinct power states: working, sleeping, soft off, and
mechanical off.

1.4.6.2 BIOS implementation: SMBIOS
The System Management BIOS (SMBIOS) is a specification which, when
implemented in a computer’s BIOS, allows one to export some management data
in a standard table format. Instrumentation software can then retrieve the
information and use it for management purposes. SMBIOS V2.2 is required for
any system that wants to be WFM 2.0-compliant.

A BIOS with management abilities is a critical requirement since it is the only
code that can detect some configuration or system settings, in particular during
the boot stage.
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SMBIOS must be able to export some data related to the manufacturer of the
computer, the characteristics of the present processors, information related to
physical slots, memory type, system enclosure and its characteristics.

The current SMBIOS specification is Version 2.3, dated August 1998, and lists all
the data a SMBIOS must and may export.

Figure 40 shows the signature of a SMBIOS-compliant BIOS:

Figure 40. Header of a SMBIOS

The _SM_ string indicates that the BIOS of this computer (a PC 300 PL) is
compliant with SMBIOS specifications. At byte 06h and 07h, we have indications
on the major and the minor revision of the SMBIOS specifications implemented in
this system (the values 02h and 01h indicate that it is SMBIOS 2.1 compliant).

1.4.6.3 Preboot execution environment and boot integrity services
PXE is required for platforms that have a LAN adapter. PXE includes a protocol
and interfaces that enable a system to download from a server a bootable
environment that is related to the state of the computer. That means that the
server decides which bootable code it must send to the target system, but its
choice can be influenced by the information that the client provides.

Let’s consider what happens if you have an IBM PC 300 PL client system on the
network on which you want to restore an operating system, using LAN Client
Control Manager.

1. From the LCCM console, you assign an icon representing the client, some
batch files that contain instructions to partition, format, and install an operating
system.

2. Click the Process button from the LCCM console and LCCM sends a
Wake-On-LAN command to the client.

3. The Ethernet network adapter embedded in the client gets the wake-up
command and powers up the system.

4. According to the alternative boot sequence, the computer will boot to the
network, meaning that, using the PXE environment code, it sends a DHCP
request (broadcast) on the LAN.

5. A server responds to the requests and forward to the client some IP
configuration values, and possibly (depending on the network implementation)
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the location and file name of a bootable image. The type of bootable image
sent usually depends of the type of network adapter installed on the client.

6. The client uses TFTP (Trivial File Transfer Protocol) to download this bootable
image. LCCM provides a set of bootable images, which usually consists of a
bootable IBM PC DOS 7.0 floppy image, with a network stack (a network
driver, and protocol stacks, as TCP/IP and NetBIOS functions).

7. Once the image is downloaded into the client’s memory, the bootstrap loader
locates its position and boots that image.

8. When the boot process on the image is complete, the client can download
from the LCCM server the batch files necessary to complete an operating
system installation. Often, these are scripts that support unattended mode.
That is so that it can automatically perform some operations such as
partitioning the hardfile, formatting it, and then installing the operating system
itself.

The Boot Integrity Services is a set of code located on the target system, which
calculates a digital signature with the downloaded image and compare it to the
one sent by the server to allow for the detection of corrupted data. These services
have the status recommended, so they are not used by all WFM 2.0 compliant
systems.

1.4.6.4 Instrumentation (DMI, CIM, SNMP)
Instrumentation is a common methodology and syntax for defining the
management features and capabilities of all hardware, software and attached
devices for a platform. The characteristics of the different instrumentations
available on PC platforms are discussed in 1.4.2, “What is CIM and why is it
important?” on page 12, 1.4.4, “SNMP’s role” on page 18, and 1.4.5, “How is DMI
used?” on page 33. WFM 2.0 guidelines encourage the use of the WBEM/CIM
model, which requires that one of three management frameworks (DMI 2.0,
SNMP, WBEM/CIM) be installed and active on a system, and that the
instrumentation supports removable devices (such as PC Cards and Hot Swap
drives).

1.4.6.5 Network PC guidelines
These guidelines are a set of recommendations resulting from an initiative of the
computer industry. They are dated from August 1997 and available on the Intel
Web site.

These guidelines are part of the WFM 2.0 specifications, and explain why and
how to implement certain features that help to reduce the TCO for Windows
platforms, and to ease the manageability of the platforms.

These features include, but are not limited to: instrumentation, network boot
capabilities, controlled and managed upgrade capabilities, and a sealed case that
prevents end-user access for changing the system hardware or software
configuration.
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Chapter 2. Installation and customization

This chapter shows the environment that is needed to support Netfinity Director
as well as how to install it on servers and clients. Netfinity Director consists of
four separate installation modules:

Figure 41. Installation options

1. Netfinity Director Server

The Netfinity Director Server includes the data files, Java class libraries and
security control point needed to manage the Netfinity Director environment. It
also includes a database for storing inventory. For further information see
2.2.1, “Prerequisites for Netfinity Director Server” on page 38.

2. Netfinity Director Console

The Netfinity Director Console is the graphical user interface to the Netfinity
Director Server. It can be installed on the same system as the server or on a
separate system connected via TCP/IP to the server. It can be customized for
different administrators and you can install an unlimited number of consoles to
support your environment. For further information see 2.2.4.1, “Prerequisites
for Netfinity Director Console” on page 51.

3. Netfinity Director Client

The Netfinity Director Client, which includes UM Services, runs on the client
endpoints. The Netfinity Director Server installation process installs the client
when it installs the server. The Netfinity Director Client can use a variety of
protocols to report to the server as indicated in 2.2.6.1, “Prerequisites for
Netfinity Director Client” on page 55, and it runs on many different operating
systems.

4. Workgroup/Enterprise Integration

This installs the upward integration modules to interface with Tivoli NetView,
SMS, Unicenter TNG and Alert on LAN. For more details on upward
integration modules see Universal Manageability: Enterprise Management
Integration, SG24-5388.
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2.1 Our environment

To work on the Netfinity Director product, our lab environment consisted of three
Netfinity 3000 (Model 8476) servers, with Netfinity Director Server and its console
installed. These servers managed three remote PC 300 PL systems (Model 6862)
located on the same token-ring network, and a Netfinity 5500 (Model 8660)
server located on an Ethernet network. The operating system that we used was
Windows NT Version 4.0 with Service Pack 4.

The desktops were installed with the factory-preloaded Windows 95, but in order
to cover different product functions in this chapter we added additional operating
systems to some of the systems. The preloaded Windows 95 system was used to
install the Netfinity Director Client and the Desktop Extensions. More information
about this installation can be found in 2.2.6, “Install Netfinity Director Client” on
page 55. Novell NetWare 5.0 was used on the desktop to install the Netfinity
Director Client on it. More information about this installation is in 2.4, “NetWare
V5.0 agents” on page 62. Some comparisons between Netfinity Manager and
Netfinity Director were done using Windows NT Workstation Version 4.0 Service
Pack 5. More information about that can be found in 6.1, “Running Netfinity
Director and Netfinity Manager together” on page 235.

2.2 Installation of the Netfinity Director Server

Netfinity Director’s operation is built around the concept of management systems.
A management system is a system or device that can be recognized by the
Netfinity Director server.

2.2.1 Prerequisites for Netfinity Director Server
The Netfinity Director requires the following hardware and software:

• Pentium Processor - 166 MHz or faster

• 64 MB RAM

• 85 MB of free disk space

• Windows NT 4.0 Workstation or Windows NT 4.0 Server

• Service Pack 4 or higher

• TCP/IP networking protocol

Note: This is a mandatory protocol that makes it possible to communicate with
the Netfinity Director Console whether the console is local or remote. In
addition, TCP/IP can be used to communicate with the clients.

• IPX, NetBIOS, SNA and SLIP are also supported for communication with the
clients

• A network adapter that supports the protocols listed above

2.2.2 Installation procedure for Netfinity Director Server
Before you begin the installation make sure that you are logged on as an
administrator or an ID with equivalent privileges. The Netfinity Director installation
can be started either by inserting the CD into the CD-ROM drive or by executing
ibmsetup.exe (X:\win32\install\ibmsetup.exe).
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This starts a wizard that guides you through the installation process as follows:

Figure 42. Setup program

After clicking Next, you have to agree to the license agreement. If you agree with
the terms click Yes. Then you have the choice of which components to install.

Figure 43. Installation on Windows NT

If you are performing the installation on Windows NT you can choose to:

• Install Netfinity Director Server

With this selection the Director Server and the Netfinity Director Console will
be installed on the same machine during the installation process.

• Install Netfinity Director Console
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During this installation program you can install the Netfinity Director Console
on a separate system anywhere in your network. In that case you can control
the Netfinity Director Server from another location.

• Install Netfinity Director Client

This is used for the installation of the client that will report to the Netfinity
Director.

• Workgroup/Enterprise Integrator

This is used to install upward integration modules.

Note: The readme file gives you a lot of hints and tips for the Intel LANDesk
environment and the SQL server database (it is approximately 22 pages).

The installation on a Windows 9x system only has a choice of:

• Netfinity Director Console

• Netfinity Director Client

• View Readme

Click the button Server to start your installation.

Note: If you have a beta level of Netfinity Director installed you must completely
uninstall the beta code before you install this product.

Click Next to proceed. The next window is for the license agreement.

Since the installation of the server also installs the UM Services code, the next
window (shown in Figure 44) shows the configuration options for UM Services:

Figure 44. UM Services

We added Web Based Remote Control and Tivoli Management Agent to the
default options that were presented:
40 Netfinity Director - Integration and Tools



Figure 45. Added options

You then need to provide a user ID that has administrator rights:

Figure 46. Administrator user ID

You can add UM Services to your start menu. Following that, the code prepares
to install:
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Figure 47. Start menu

In order to install the code you need a valid Netfinity Director license key:

Figure 48. License key

Note: The license key is not case-sensitive.
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Figure 49. Destination Directory of Netfinity Director

This wizard will ask for the installation path where the Netfinity Director should be
installed. To change the default path (other disks or directories) click Browse or
just click Next if you accept the default path.

After selecting the disk and directories you will be asked to commit the path for
the installation program. Click Yes to continue with the installation.

Figure 50. Confirmation of selected destination directory for installing Netfinity Director

Select or accept the path to install the directory for creating the software
distribution package. Click Next if you accept the path.
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Figure 51. Software package destination directory

During this step you can select the destination where you will install the software
package. Click Next if you accept the path.

Figure 52. Remote control installation option

When using this wizard you need to determine if you want to enable the remote
control function or not. Remember that when you install the server code you also
get the console and the agent installed at the same time. We selected to enable
this function so that we could manage this server from another server. Click Yes if
you want to enable Remote Control.

After that, the next prompt is for the Tivoli Management Agent support.

Figure 53. TMA support installation option

After clicking the Yes button, the installation process starts and shows the
following:
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Figure 54. Initialization to clear system for installation of Netfinity Director

This procedure looks at the system to see if there is an older version of the
product already installed. If there is, it removes it. Netfinity Director starts to
install the files and the following directories are added to the disk:

Figure 55. Directories added after installation of Netfinity Director Server

During our installation, Netfinity Director used 72 MB.

Figure 56. User ID and password

The installation will prompt you for a valid user ID and password. When you log
on to the Netfinity Director server through the management console the user ID
and password are validated against the Windows NT security subsystem where
the Netfinity Director is installed.

Enter a valid domain and user name for the Windows NT account. Enter a
password and click Next to proceed.
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Figure 57. Database selection

In this step you install the database support. You have to choose which database
to use on the server (MS SQL or IBM DB2) or the default Microsoft Jet database
that can be installed during this procedure.

If you do not have a separate database you have to select Default; otherwise,
you will have to repeat the complete installation. For more information about
databases see Chapter 5, “Database support” on page 197.

Figure 58. Driver selection for different protocols

Netfinity Director allows you to use any available network interface that is listed in
the window.

To configure the network driver:

• Enter the name for your system in the System Name field.

• Select your network driver by clicking the protocol and the Driver Enabled
box.

Note: If your system is not a part of a network, no network driver will be
displayed.
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• Check the Require User Authorization for Screen Access box.

This feature is a security feature. When this option is not enabled, Netfinity
Director Console users can take control of your system without the permission
of the local user.

With this option enabled users cannot get unauthorized access to your
system. They need your confirmation that you will allow them to get access to
your system. The confirmation is done through a pop-up window. This pop-up
window has a GUI that lets you confirm or reject access.

If you click No the specified user cannot get access to your system. If you click
Yes the specified user can take full control of the server’s keyboard and
mouse.

Note: If you do not respond to the pop-up window within 15 seconds, Netfinity
Director will not grant access to your system.

For further information on configuring and using Remote Control service, see
1.1, “Netfinity Director base functions” on page 1.

• Enable Wake-on-LAN

This option lets Netfinity Director manage your system independent of its
power-on status. You should enable this feature only if this function is
supported by your network card. It is not only a software feature, your LAN
card must support Wake-on-LAN.

• Set Network Time-Out value - (this is optional)

The Network Time-Out field shows the number of seconds that the Netfinity
Director Server will attempt to communicate with a remote system before it
gives up. The default setting is 15 seconds.

Figure 59. Reboot the server after installing Netfinity Director

Click Finish so that the system will reboot.
Installation and customization 47



Figure 60. Start the Management Console

After the system reboots, the following items are added to the start menu:

• View readme

Click this and it will open a text file with important hints and tips. If you use
Windows 9x or Windows NT this file will be opened with Notepad.

• Uninstall Netfinity Director

If you click this folder you will start the deinstallation procedure for the Netfinity
Director Server code.

• Network Driver Configuration

To make additional changes to the configuration you can select Network
Driver Configuration and you get the same driver installation window that
you saw during the installation process.

You can make additional changes if required. For example, you can disable or
enable your protocols, change a user’s authorization for screen access or
enable or disable the Wake-on-LAN function.

• Management Console

The Netfinity Director Console is startable from the start menu.

When the Server starts, a logon window will appear prompting you for a server
name, user ID and password. The server name is the TCP/IP hostname or
address of the Netfinity Director Server.

Figure 61. Netfinity Director logon
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Enter the user ID and password to log on to the Netfinity Director Server. If the
user ID and password are valid the Netfinity Director server will start.

Note: You should also notice an icon on the task bar in the lower right-hand
corner of the window. If Netfinity Director is up and running it looks like a green
ball. If it is not correctly running it looks lik ea red triangle.

After the installation has completed the Netfinity Director has two additional NT
groups created. Figure 62 shows both groups, TWGAdmin and
TWGSuperAdmins. Both of them have the administrator ID.

Figure 62. Netfinity Director Server NT group

2.2.3 Uninstall Netfinity Director
To uninstall Netfinity Director Server code click Start -> Settings -> Control ->
Add/Remove Programs. Select IBM Netfinity Director and click Add/Remove.
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Figure 63. Removing Netfinity Director Server

A window appears that asks you to make sure that you have closed the server
console and for confirmation to uninstall the code:

Figure 64. Remove the code

Click Yes to confirm the uninstall procedure.

Figure 65. Confirmation to uninstall Netfinity Director Server configuration and database

Click Yes to delete the Netfinity Director configuration files.
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Figure 66. Reboot the system after uninstall the code

Click Yes to restart the system.

Note: After rebooting, all of the folders on the Start Menu bar for Netfinity Director
and UM Services are removed.

2.2.4 Install Netfinity Director Console
The Netfinity Director Console is your interface to the Netfinity Director Server
environment. From the console you can:

• Define how network resources are grouped and displayed.

• Create, schedule and initiate task to manage your network resources.

• Configure operation parameters for Netfinity Director tasks.

• Select preferences for the presentation of Netfinity Director windows.

• Define user IDs and user access to Netfinity Director resources.

2.2.4.1 Prerequisites for Netfinity Director Console
The Netfinity Director Console requires the following hardware and software:

• Pentium Processor

• 32 MB RAM

• 40 MB of free disk space

• Windows NT 4.0 Workstation or Windows NT 4.0 Server, Windows 95 or
Windows 98

• Service Pack 3 or higher

• TCP/IP networking protocol

• A network adapter that supports the TCP/IP networking protocol

2.2.4.2 Installation procedure for Netfinity Director Console
The Netfinity Director Console installation begins the same way as the Netfinity
Server installation:

• For Windows NT: (X:\win32\install\ibmsetup.exe)

This will start a wizard that guides you through the installation process. There are
fewer windows and options to follow if you just need the console installed. After
the product introduction windows, click Console:
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Figure 67. Console installation

It will begin to install the console code:

Figure 68. Install Windows 95/98 and Windows NT

Click Next to proceed.

Figure 69. Destination directory of Netfinity Director Console

This wizard will ask for the installation path where the Netfinity Director should be
installed. If you want to make any changes (a different disk or directory) click
Browse; otherwise, click Next if you accept the default path.
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After selecting the disk and directories you will be asked to commit the path for
the installation program. Click Yes to continue with the installation.

In our installation, the Netfinity Director Console used 32 MB space on the disk.

Figure 70. Reboot the server after installing Netfinity Manager Console

Click Finish and the system will reboot.

Figure 71. Start Netfinity Director Console

After the system reboots the following options are added into the Start menu.

• View readme

Click this folder and it will open a text file with important hints and tips. If
you use Windows 9x or Windows NT. This file can be opened with the
simple editor program Notepad.

• Uninstall

If you click that folder you will start the deinstallation procedure of Netfinity
Director.

• Management Console

The Netfinity Director Console is now startable from the Start menu.

While the console starts up, a logon window will appear prompting you for a
server name, user ID and password. The server name is the TCP/IP hostname or
address of the Netfinity Director server.
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Figure 72. Netfinity Director Console logon

Enter the user ID and password to log on to the Netfinity Director server. If the
user ID and password are valid the Netfinity Director Console will start.

Note: No icon is added to the task menu bar by the Netfinity Director Server,
Console or Client installation.

2.2.5 Uninstall Netfinity Director Console
To uninstall the Netfinity Director Console code click Start -> Programs -> IBM
Netfinity Director -> Uninstall:

Figure 73. Deinstallation of the Netfinity Director Console

A window appears that asks you for confirmation to uninstall the code:
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Figure 74. Confirmation to uninstall Netfinity Director Console code

Make sure you have closed the Netfinity Director Console and then click Yes to
confirm the uninstall procedure.

Figure 75. Uninstall Netfinity Director Console files

Click OK and the system will close the de-installation window but not perform the
reboot automatically. Therefore, you have to restart the system manually.

Note: All folders on the Start menu bar and the corresponding files are removed.

2.2.6 Install Netfinity Director Client
The Netfinity Client code resides in each managed system and provides
information to the Netfinity Director Server. The Netfinity Director Client does not
have a GUI, but it can be managed through a Web browser.

2.2.6.1 Prerequisites for Netfinity Director Client
The Netfinity Director Client requires the following hardware and software:

• 486 Processor or Pentium class processor
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• 16 MB RAM (for Windows 3.11 and OS/2)

• 32 MB RAM (for Windows 95 OSR2, Windows NT Service Pack 4 or higher

• 6 MB of free disk space

• TCP/IP, NetBIOS, IPX, SNA or SLIP

• A network adapter that supports one of the networking protocols above.

2.2.6.2 Installation procedure for Netfinity Director Client
The Netfinity Director Client installation begins the same way as the server and
the console installation began. Execute x:\win32\install\ibmsetup.exe:

Figure 76. Installing the client

Click Client to start your installation. The installation options for UM Services are
presented:

Figure 77. Welcome screen for installing Netfinity Director Client
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We added support for Tivoli Management Agent. If you chose Web Based
Access you should not choose Web Based Remote Control.

Note: If you have a beta level of Netfinity Director installed you must completely
uninstall the beta code before you install this product. Click Next to proceed.
Click Yes if you accept the license agreement.

The window will prompt you to install the Netfinity Director Client software:

Figure 78. Choose directory to install the code

This wizard will ask for the installation path where Netfinity Director should be
installed. If you want to change the default installation directory click Browse.
Otherwise, click Next. After selecting the disk and directories you will be asked to
commit the path for the installation program. Click Yes. You then need to enter
the user ID that has administrator rights:

Figure 79. Administrator rights
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Note: If you change the default port from 411 to anything else you should make
note of it. You might also need to change some MMC coding later on so we
advise against doing that.

You can have the UM Services application added to the Start menu:

Figure 80. Start menu updates

You need to click Yes in the following figure if you want to support remote control
of this client:

Figure 81. Enable Remote Control for Netfinity Director Client

Depending upon your environment you can alert the user before you take control
of their screen:

Figure 82. Authorization to take control

In our installation, the Netfinity Director Client used 6.1 MB of disk space.
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Figure 83. Reboot the system

Click Finish and the system will reboot. The following options are added to the
Start menu:

Figure 84. Start Netfinity Director Client

2.2.7 Uninstall Netfinity Director Client
To uninstall the Netfinity Director Client click Start -> Settings -> Control ->
Add/Remote Programs:
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Figure 85. Remove Netfinity Director Client

Click Add/Remove:

Figure 86. Remove UM Services

Click Yes.

Figure 87. Uninstall Netfinity Director Client files
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Click Yes and the system will close the de-installation window but not perform the
reboot automatically. Perform the restart from the Start menu.

Note: The uninstall log file will be placed in your system’s directory on Windows
9x and Windows NT systems. In our case it was a Windows 95 operating system
and the log file was called Tivoli.log and placed in C:\Windows\temp.

2.3 Supporting Netfinity Director clients

The Netfinity Director’s distributed architecture is designed to work across a wide
variety of LANs, WANS and other network topologies. Netfinity Director supports
a comprehensive set of tasks for Netfinity Director Client nodes.

In Figure 88 you see a basic configuration example that shows how Netfinity
Director Server, the Netfinity Director Console and the Netfinity Director Clients
can communicate together.

Figure 88. Netfinity Director environment

2.3.1 How to use the Netfinity Director Client
This section shows how the Netfinity Director Server manages the Netfinity
Director Client and how to use the server’s functions.

In our environment we had one Netfinity Director Server with the Netfinity Director
Console installed on the same machine and an additional system with the
Netfinity Director Client installed.

The following example shows how the Netfinity Director Console is subdivided
and where you can find the agents that are supported.

Figure 89 shows you three columns:

1. The left column

This column shows you a list of different groups. It is divided into different
operating systems, such as Microsoft Windows 95, Windows 98, Windows NT,

TCP/IP
IPX
NetBIOS

Management
Console

TCP/IP

Management
Server

Windows NT
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IBM OS/2, and cluster systems or systems with Netfinity Director software
installed.

You can preselect your existing environment in these groups or in additional
groups that are created by the operator at the Netfinity Director Console.

2. The middle column

This column shows you the contents of the selected groups. It shows you all
the systems with the appropriate software installed.

3. The right column

This column shows the list of tasks that you can select to support and manage
your systems. You can start these tasks by dragging them onto groups or
systems.

.

Figure 89. Netfinity Director environment and tasks

2.4 NetWare V5.0 agents

The Netfinity Director Client supports the Netfinity Director Server functions that
are necessary to perform management operations such as software distribution,
inventory, user administration and distributed monitoring. Instead of software
applications sitting on top of the desktop, the Netfinity Director Client
automatically determines what is needed to perform a given management
operation.
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2.4.1 Prerequisites for Netfinity Director Client on NetWare V5.0
This installation procedure describes how to install the Netfinity Director Client on
a NetWare V.5.0 server. The minimum requirements that you need for this
installation are:

• A NetWare V.5.0 server
• A network connection
• A workstation or server acting as a client

For our installation we had a token-ring connection and we used Windows NT
Server V4.0 as the client.

There are three steps that you need to follow to prepare the Windows NT server:

1. Check the communication on both servers.

Before you start the installation you should verify that both systems can
communicate with each other. An easy way to make sure that they can
communicate is to start a ping request with TCP/IP. Therefore, we recommend
that you load the TCP/IP stack on the Novell server, and issue a load ping

command on the server’s console to verify that the two systems can
communicate.

2. Install and configure the Gateway Service for NetWare on the NT Server.

This is a service provided with the Windows NT installation CD-ROM that enables
you to log on from your NT system to a Novell server. To install it, access the
Network properties applet by clicking Start -> Settings -> Control Panel. Once
done, double-click the Network icon, and the Network applet will be launched.

Then, click the Services tab. Click Add..., and in the list, select Gateway (and
client) Services for NetWare, and click OK. If Windows NT asks you for a
location to find some files, specify the D:\i386 folder, where D: is the letter of the
CD-ROM image.

Figure 90. Install the Gateway Services for NetWare

After the files are copied the Services tab of the Network properties will
reappear. Click Close. Windows NT will perform some protocol bindings and
will ask you to reboot. Click Yes to restart the computer.
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After you reboot and log on again, a dialog box similar to Figure 91 will
appear:

Figure 91. The NetWare logon dialog box

In the Preferred Server field, enter the server that you want to connect to, or if
you are going to use NDS to log in, specify a Tree and a Context.

This dialog box won’t appear again after you fill it in, but you can access it to
make changes from the icon GSNW, which is located in the control panel for
Windows NT. Once that is done you will be ready to access the NetWare
servers from your system.

Note: Installing the Gateway Service for NetWare will install a new network
transport protocol, IPX/SPX.

3. Map the NetWare servers disk to the Windows NT server.

Now you need to map a drive to a volume on the NetWare server where you
want to install the Netfinity Director Client. In order to this, double-click the
Network Neighborhood icon, then in the window that appears, double-click
the Entire Network icon.

Figure 92. Select NetWare network

As you can see in Figure 92, you now have access to another kind of network,
the NetWare or Compatible Network.

Double-click NetWare or Compatible Network. The next windows that
appear show you the connections for all NetWare or compatible networks.
Select the connection that you will map to get access to the disks.
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Figure 93. Connections to the NetWare server

Double-click the connection that you want to access. You should see a security
prompt:

Figure 94. ID and password request

Type in your user ID and password. The NetWare system volume is displayed
and you can see the data on the NetWare disk.

Figure 95. NetWare server volume

You need to map that volume to your Windows NT server.

Figure 96. Map network drive
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Right-click the volume to start the process. Select Map Network Drive.

In Figure 97 you provide a fixed drive letter for the network drive that you have
already accessed.

Figure 97. Map Network Drive

Use the pull-down to select a drive letter for the NetWare drive. Enter your user
ID in the Connect As field and click the box Reconnect at Logon. Click OK to
finish. The Windows NT Explorer will show this disk with the name that you
chose.

2.4.2 Installation procedure for Netfinity Director Client on NetWare V5.0
This section shows the installation procedure for the agent on a NetWare V5.0
server. The Netfinity Director Client installation can be started either by inserting
the CD into the CD-ROM drive or by starting the setup.exe
(X:\agent\novw32\en\setup). After starting setup.exe a welcome window comes up
and introduces you to the installation of the Netfinity Server Management Agent
program.

Click Next to proceed. Click Yes to accept the license agreement and to
continue. Then select the drive where you want to install the Netfinity Director
Client.

Figure 98. Drive selection during NetWare installation

Select the drive that you mapped in 2.4.1, “Prerequisites for Netfinity Director
Client on NetWare V5.0” on page 63. Click Next to continue. The files are copied
to the disk.
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After the files have been copied you have to configure the Netfinity Director Client
at the NetWare server console. Read the contents of this next screen very
carefully. You have to perform three steps at the NetWare console so that the
network server can load the Netfinity Director Client and use it:

.

Figure 99. Configure the NetWare console

Perform three steps at the NetWare console:

1. Enter the following: Search add sys:tivoliwg

The server will add the path tivoliwg to the system.

2. Configure the Netfinity Director Client by loading twgipccf

Type in twgipccf. This will prompt you with a menu that shows you the
Director network driver configuration. Enter 6 to save it and 8 to exit this
menu.

3. Start the agent by loading twgipc

Type in twgipc. This will start the program at the NetWare server. Reboot the
NetWare server. The agent will now automatically run on every Novell server
boot.

Click Finish on the Windows NT server to complete this part of the installation.

Make sure that you have configured Netfinity Director for the IPX protocol. To
verify this, start the configuration menu by Start -> Programs -> Netfinity
Director -> Network Driver Configuration.
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Figure 100. Netfinity Director configuration for IPX

Click Driver Enabled for Novell IPX and then OK. After you have finished these
steps you can manage the NetWare server from the Netfinity Director Server.

Figure 101 shows you that the NetWare system is now available and ready to be
managed from your Netfinity Director Server.

Figure 101. Netfinity Director Console with NetWare agent

2.4.3 Uninstall Netfinity Director Client on NetWare V5.0
There is no deinstallation procedure for the Netfinity Director Client on NetWare
V5.0. You have to perform the deinstallation manually on the NetWare Server.
Perform the following steps at the NetWare server:

• Select the system console on the NetWare Server.

• Type in load nwconfig and press Enter.

• Select the file NCF files Options and press Enter.

• Select Edit AUTOEXEC.NCF and press Enter.
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• Find the entry load twgipc and mark it with a # or delete the entry. The #
makes it a comment card so that it won’t execute.

• Press the Esc button and save the changes.

• Use the Esc button to go back to the basic prompt on the console.

The following steps are performed on the Windows NT server:

• Use the Windows NT Explorer and delete the directory tivoliwg on the mapped
disk.

• Restart the NetWare server.

The uninstall of the Netfinity Director Client on the NetWare Server is complete.
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Chapter 3. Core functions

This chapter describes the main functions and processes for the Netfinity Director
management environment. We cover the fundamental functions that are part of
Netfinity Director. Our goal is to introduce the core Netfinity Director features as
well as group management.

3.1 Netfinity Director environment

In this section, we present the Netfinity Director interface and the main options
you can use to personalize and customize Netfinity Director according to your
needs.

3.1.1 Logging on for the first time
Since Netfinity Director comes with three components (Server, Console and
Agent), we must first use the console to log on to the Netfinity Director Server,
which can be installed locally or on a remote computer. A TCP/IP link must be
established between the console and the server.

Click Start -> Programs -> IBM Netfinity Director -> Management Console.

You have to provide the name of the server on which the product has been
installed and the user ID and the password that you set up during the Netfinity
Director installation.

Figure 102. Authentication to access Netfinity Director Console

If the Netfinity Director Server service is not started, you won’t be able to connect
to the server. The first time you start the server it will take some time to initialize.
In addition, if you have a large database it might take a little bit of time to start up.
As with most things, that will depend upon your system’s resources.

You can specify a TCP/IP address instead of a hostname when you log in. The
dialog box will have the server name of the last user that logged in. For the first
login, it will be your machine name, so check this parameter if you can’t connect.
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3.1.2 The console
The first time the management console is displayed, you have to discover the
systems in order to manage them (Netfinity Director can automatically discover
systems that have a supported management agent installed on them). To launch
the discovery process select Tasks -> Discover Systems -> All Systems and
Devices.

After a few seconds, the computers that have a supported Netfinity Director
Agent installed will begin to appear on the console. Your management console
will look similar to Figure 103. See 3.1.4, “Configuration and preferences” on
page 74, for details on how to configure discovery parameters.

Figure 103. The Netfinity Director Console

You have five main parts in the console Graphical User Interface (GUI). The first
is the menu bar. It is used to set up the configuration and preferences settings.
The second is the tool bar, which contains several icons. They are shortcuts to
some useful tools for the task and option menus.

Figure 104. The tool bar

Third, you have a set a three panes. The Groups pane represents the groups of
computers that come with Netfinity Director as well as the groups you define for
your environment. By clicking a group (All Systems and Devices is selected by
default), you see in the Group Contents pane the computers that belong to the
selected group. The tasks pane represents the main functions you can perform
upon the groups with Netfinity Director.
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Figure 105. The three panes

Under the three panes, you can have a console ticker tape. When configured, it is
used to scroll some informational messages related to events or to the resource
monitors you can configure as shown in Figure 106.

Figure 106. CPU utilization related to a managed computer appears on the console ticker tape

Finally, there is the status bar. It acknowledges the actions you perform, displays
the name of the server where you are logged on, the login ID you are using, and
the date and time on the server.

Figure 107. The status bar

3.1.3 The menus
The menus allow you to perform several base administration tasks on the
Netfinity Director Server and to set several configuration and preference options.

The Director menu allows you to exit the console.

The Tasks menu lets you:

• Launch and automate discovery of the managed clients. When one is
discovered its name will appear in the Group Contents Pane.

• Access the message browser, a tool that contains all the pop-up messages
you can receive. To learn how to configure pop-up messages, see “Build an
action plan” on page 125.

• Build a custom query, a function that lets you create your own request on the
inventoried items of the managed systems. See 3.3.2.2, “Customizing
inventory” on page 140 for more information.

• View the inventory, which displays inventory information for all the systems
and devices known by Netfinity Director. Refer to 3.3.2.2, “Customizing
inventory” on page 140.

• Access the Event Action Plan Builder, a configuration tool that lets you specify
which events will be monitored on your systems. This tool is used to define
how you want to be warned of the events. See 3.3.2.1, “Event action plans” on
page 118 for examples of how to use it.

• Launch the scheduler, a tool covered in 3.2.7, “Task scheduling” on page 88.
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• Access the Active Console Viewer, a window where you can see all the users
currently connected to the Netfinity Director Server and send them pop-up
messages.

The Associations menu is used to modify the display for the Group Contents
pane. You can choose to view the managed items categorized by type of system
(for example, Netfinity Director Agent or MPM agent), or without any category.

The Options menu is discussed in 3.1.4, “Configuration and preferences” on page
74.

3.1.4 Configuration and preferences
Settings related to Netfinity Director Server or to console settings are accessible
from the Options pull-down menu.

Click Options -> Consoles Preferences to configure Netfinity Director’s Console
background image and appearance settings. You can either enable or disable the
confirmation messages you get while using the product.

Click Options -> Server Preferences to set parameters, such as the frequency
of the automatic inventory and the maximum event log and history entries.

You can set the default system discovery parameters by clicking Options ->
Discovery Preferences on the Netfinity Director Console. You can configure
MPM parameters (names of the MPM providers and auto-discovery interval), and
settings related to the other branches of the network on which you wish to
perform some automatic discovery.

Note: By default, automatic discovery is not turned on.

The Console Security menu manages users for the Netfinity Director Server. You
can add console users with this tool and configure the actions they can perform
on the console that is connected to the Netfinity Director Server.

3.2 Base functions

This section will cover Netfinity Director Base functions. They are presented in
the Tasks pane of the main console, and most of them can be launched by
dragging a task over a computer, or over a group.

• Inventory management

• CIM compliant

• DMI compliant

• Resource Monitoring

• File transfer

• Remote Control

• Task Scheduling

• Process Management

• Event Management and logging

• Cluster Browser for MicroSoft Cluster Server (MSCS) systems
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3.2.1 Inventory management
Netfinity Director allows you to collect hardware and software inventory on a
group of systems or on an individual system. This can be done in different
ways. To show you the product mechanics, we provide a step-by-step example
of how to gather your inventory. It is assumed that you already have installed
Netfinity Director, as described in 2.2.2, “Installation procedure for Netfinity
Director Server” on page 38.

Note: On an initial discovery, Netfinity Director runs an inventory scan that is
important for such things as remote control.

Figure 108. Discovery of systems is one of the first things to do

If no managed computers appear in the Group Contents pane, you can launch
an automatic discovery by selecting Tasks -> Discover Systems -> All
Systems and Devices from the menu bar, or you can manually add some
systems to the console by performing the following actions: right-click in a free
space of the pane titled Group Contents and choose New -> Netfinity
Director Systems in the contextual menu. The following window appears:

Figure 109. Adding a system manually
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Enter the name under which you want the remote system to be recognized in
Netfinity Director, choose the type of protocol to use to communicate with that
system and enter its protocol-related address. Although Netfinity Director
provides some functions to perform discovery through gateways, this is a
quick and efficient way to add one system that you have connectivity to.

Once some systems have been added to the Group Contents pane, choose
one and right-click it. In the contextual menu, choose Perform Inventory
Collection.

Figure 110. Gather inventory from the system Jabbath

Note that you can launch the inventory function on several systems at once by
selecting them in the Group Contents pane, or by selecting the group to which
they belong.

An information window like the following one appears:
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Figure 111. Inventory collection in progress on several systems

Once the inventory function is complete, select the system (or systems) and
right-click it. Select View Inventory in the contextual menu, as shown in Figure
112 and a window similar to Figure 113 will appear.

Figure 112. The inventory has completed

Figure 113 shows you on the left pane the items for which some information was
gathered by Netfinity Director. The right pane shows you the details associated
with the selected item (for example, Disk). Since three systems were queried, we
can compare the information related to the selected item for the three systems,
CLARK, JKL-SRV, and JABBATH.

Figure 113. The result of an inventory query on three systems
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For example, the system CLARK owns three disk type elements: a hard-disk, a
floppy drive, and a CD-ROM. The column Media Loaded tells us if there are any
media inserted in the drive (the value TRUE informs us that a hard drive is
present in the system CLARK).

By default, the inventory will query for hardware, software, system (for example,
BIOS information) and user information. You can customize the inventory by
defining your own query to choose what you want displayed. The queries we
have defined appear in the left pane, under the Custom folder.

Figure 114 shows an example where the customized query (called My_query)
displays some network information.

Figure 114. Display example of a customized query

Note: The inventory is saved locally on the Netfinity Director Server after the
completion of the information gathering. Therefore, even if a system is
unreachable, you might be able to see its components. On the other hand, you
have to launch a new inventory task to get the most up-to-date information.

We did a manual inventory, but this can be automated with the Netfinity Director
Scheduler. See 3.2.7, “Task scheduling” on page 88 to automate the inventory
collection.

3.2.2 CIM compliant
CIM instrumentation is imbedded in UM Services and you can access the CIM
browser from the console. 1.4.2, “What is CIM and why is it important?” on page
12 provides more details about CIM and how it works.

The CIM scheme is supported with Netfinity Director on the following platforms:

• Windows 98 with the addition of the Windows Management Instrumentation
(WMI)

• Windows 95 with the addition of the WMI

• Windows NT 4.0 (workstation and server) with the addition of WMI

The appropriate CIM instrumentation is installed with UM Services.
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3.2.3 DMI compliant
UM Services comes with a DMI service provider, and a DMI browser is available
with the console. The DMI browser is accessible only if the DMI service provider
is active on the target machine.

Figure 115 shows the DMI browser. Using the DMI browser you can check the
level of the DMI service provider that is installed on the target computer.

Figure 115. The Netfinity Director DMI Browser

More details on DMI can be found in 1.4.5, “How is DMI used?” on page 33. DMI
support is available only on the following platforms:

• Windows 98 with the addition of the Intel DMI Version 2.0 and 2.0s

• Windows 95 with the addition of the Intel DMI Version 2.0 and 2.0s

• Windows NT 4.0 (Workstation and Server) with the addition of the Intel
DMI Version 2.0 and 2.0s

If you install UM Services, no upgrade is necessary to manage these systems,
since UM Services provides the appropriate DMI layer.

Note: If you have trouble accessing the DMI layer of a computer from the
Netfinity Director Console, check that DMI services has been started. On
Windows NT, you can check it in the Services applet of the control panel. It has a
service called win32sl that must be started.
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Figure 116. The DMI Service on a NT system must be started when NT boot is complete

On a Windows 9x system, press Ctrl-Alt-Del to make the Tasks list appear and
check to see if Dmistart is running. You can check the status of the DMI layer by
looking at the file c:\Dmistart.log.

Figure 117. The DMI layer is active on a Windows 9x system

3.2.4 Resource monitoring
With Netfinity Director you can monitor your system’s resources. To access the
data that you want to look at a on a given system, you just have to right click on
the name of the computer, and choose Resource Monitors from the contextual
menu:
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Figure 118. Access resource monitors

The system’s resources can vary from one system to another. For example, if you
compare the available resource lists in Figure 119 you can see that the Windows
NT-based system NF5500 has some monitors (DMI and TCP/IP) not available on
the Windows 95 system.

Figure 119. Resource Monitors

Resource Monitors may in fact depend on the software agents installed and the
operating system’s abilities and settings.

Windows NT

Windows 9x
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Note: Netfinity Director does not allow you to set monitors on Groups of systems.

You can configure Netfinity Director so that you will be warned of any change in
the monitors. For example, we are going to configure it to generate a warning
message when the space remaining on the C: drive of a remote computer is less
than 50 MB.

First, right-click a system and choose Resource Monitors in the contextual menu
(in our case, the system called CLARK). This will bring up the Resource Monitors
window. In the left pane, expand the Director Agent tree, to make the resource
Drive C: Space Remaining visible.

Figure 120. The resources to monitor

Right-click Drive C: Space Remaining and in the menu appearing choose Add
to Selected Resources Table (Figure 121).

Figure 121. Select it
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Once you do that you should see the caption Drive C: Space Remaining in a new
row of the table, with the words Collecting Initial Data next to it, as shown in the
following figure:

Figure 122. Free space remaining on the C: drive of the system CLARK is being collected

You should then see the free space available on the computer:

Figure 123. 541.1 MB are available on the drive C: of CLARK

Now, you can right-click the value collected and select Individual Threshold in
the contextual menu.
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Figure 124. This is the value we want monitor

The System Threshold window appears:

Figure 125. The Threshold window

We fill in values in this window in order to get a message in the event log when
the free space available on the drive C: of the system CLARK goes below 50 MB.
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First, indicate the name of your threshold. You can also add a description of what
this threshold is supposed to do. Check the box Enabled to generate events.
This means the threshold that is defined is active. Checking the Generate events
on value change box generates an event whenever there is a change to the
monitored resource.

In the Minimum Duration field, enter 10. If the free space on drive C: goes below
50 MB in a 10-minute interval then an event will be generated (nothing will
happen if the free space was under 50 MB for 9 minutes, then grew to 55 MB
before the 10th minute). Finally, in the box Below or Equal, put the value 50 and
click OK.

Note that you can set the status of an alert by filling in the corresponding field. In
our example, the alert will have a Low Warning status, since we put the value 50
on the left of the caption Low Warning.

Figure 126. The system threshold for CLARK

The system threshold window disappears.

Note: Once you have placed a monitor on a resource, this resource will then
appear in the Resource Monitors window with a small icon to the left of its value,
as shown in Figure 127.
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Figure 127. The icon indicates the resource is monitored

In order to see what happens when the threshold is met, you can test by copying
some files to the target system, in a temporary directory until you reach the space
threshold.

After the specified amount of time is spent (here, 10 minutes), right-click the
system’s name in the Netfinity Director Console, and select Event Log. An entry
similar to the following one should appear (Figure 128):

Figure 128. A warning related to the remaining drive space of CLARK has been issued

3.2.5 File transfer
This is a graphical tool that performs file transfers between your local system and
a remote computer. It also performs additional functions, such as directory
creation, deletion of files or selected folders, renaming objects, or accessing their
properties.
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Note: The file transfer is done using Administrator privileges. That means that a
user of the Netfinity Director Console who has the right to make some file
transfers on a system will override the permissions defined on this remote
system.

Figure 129. The File Transfer GUI

You can’t modify the attributes (archive, system, read-only) of a file, nor its
access permissions.

3.2.6 Remote control
Remote control is performed by selecting a system with the right mouse button
and dragging the Remote Control task onto it. You can launch the graphical
remote control on several systems at once. That opens several remote control
windows on your system. When you are going to control several systems, it is
suggested that you use the maximum colors available on your system to avoid
color confusion. In addition, it’s suggested, for performance considerations, to not
use the maximum resolution and color depth available when you configure a
remote system. That saves some bandwidth and the remote control will be
quicker and smoother.

For security reasons a computer can be configured so that the user has to agree
before the system can be taken over.

Figure 130. The user has to agree to remote control
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In order to configure this security feature, you must launch the Network Driver
Configuration from the Netfinity Director program group of the computer you want
to protect:

Figure 131. Accessing the screen access configuration tool

Then, you must check the box Require User Authorization for Screen Access.

Figure 132. The Network Driver Configuration program

Click OK to leave the Network Driver Configuration utility. The change will take
effect when the computer is rebooted.

Note: If you have installed Co-Session or the UM Services Remote Control
service on a system, it can’t be controlled by Netfinity Director. You must install
the Netfinity Director Agent to access it.

3.2.7 Task scheduling
Netfinity Director lets you schedule some tasks to execute on a single computer
or a group of systems. The tasks can execute whenever you need them to and
you can also schedule them to run multiple times. You can be informed about the
result of the tasks from a generated event.
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Figure 133. Scheduling a task

For demonstration purpose, we scheduled the inventory to be taken on several
target systems. First, from the Netfinity Director main console, select Tasks ->
Scheduler.

Figure 134. Accessing the scheduler
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Figure 135. The Scheduler window

In Figure 135, the main Scheduler window looks like a calendar. Past, present
and future scheduled jobs appear in the corresponding days where they will be
launched.

Click File -> New Job... and the New Scheduled Job window will appear, as
shown in Figure 136.
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Figure 136. The New Scheduled Job window

Fill in the date and time fields for when you want the inventory to occur. Then,
select the Task tab.

Figure 137. The Task tab

Select the Inventory field in the Available pane and click Select. The Inventory
icon will then appear in the Selected Task pane as shown in the following figure:
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Figure 138. The Inventory task has been selected

Now that you have chosen what to do, you must select the target system on
which the inventory will take place. Select the Targets tab and check the option
Specify a list of systems as targets.

Figure 139. We could have chosen some groups of computer by selecting use a group as the target

In the left pane, select the system(s) that will be the target of the inventory
collection. You can select one and click Add in order to make its name appear in
the right pane, or select multiple systems at once by holding down the Ctrl key.
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Drag and drop is also supported. Once all the systems have been selected and
added to the selected tab, you will see a display similar to Figure 140.

Figure 140. We have chosen our targets

Select the Options tab to set several useful options (Figure 141).

The options to be set are the four options in the Events pane, which let you know
if the scheduled task executes OK.
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Figure 141. Some options related to the scheduled job execution are available

Click File -> Close. You will be prompted to confirm the job. Click Yes. The
program then asks you to enter a name for the job you have scheduled.

Figure 142. Enter a title for the job

Then click OK. You will see a dialog box confirming that the job has been created.

Figure 143. It’s done
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The New Scheduled Job window will then disappear. You can check in the
Scheduler window, at the date and time you chosen, that there is an entry
corresponding to the job you just created.

Figure 144. The Inventory task we created appears in the calendar

Close the Scheduler window.

A few minutes after the date and time where the job was scheduled, you should
find a status report in the event log of the group the target systems belong to. You
could also right-click one of the target system and select Event Log.

Figure 145. The Inventory task for system Jabbath completed successfully

3.2.8 Process management
Each time a program is launched on a computer by either the user or an
application it creates a process in memory. These processes can be managed. To
launch Netfinity Director’s process manager, right-click the name of a computer in
the Group Contents pane of the main console and choose the item Process
Management from the contextual menu.
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Figure 146. Access to the Process Management function

The resulting window will vary, depending on the operating system on the target
client.
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3.2.8.1 Process management on Windows 9x systems

Figure 147. Process Management on a Windows 9x system

Each process generated by a running application appears in a row in the process
management window, followed by some information, such as its Process ID
(PID), the Parent Process ID (a process can launch other processes, called
children processes), and the number of threads related to it and its priority.

The last column indicates whether or not the process is being monitored by
Netfinity Director.

You can add a monitor to a process. That is discussed in 3.2.8.2, “Process
management on a Windows NT machine” on page 97.

3.2.8.2 Process management on a Windows NT machine
Process Management is slightly different when you access a Windows NT
system. The window displays three tabs, according to the type of program that is
running on the remote computer: an Applications tab, a Win32 Services tab, and
a Device Services tab.

The Applications tab
The Applications tab (Figure 5) lists the process with which you can interact
(usually some program applications), and displays for each of the processes a set
of information about the environment in which these processes were launched.
This information is summarized in Table 4.
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Table 4. Informations given about the processes in the Applications tab

Table 5. The Applications tab of the Process Management window

You can either show the available actions in Figure 5 or close the application by
using the right mouse button on the row of the process.

Row Meaning

Name The name of the process running. Usually, it
is the name of the executable that generated
this process.

PID A number that identifies the process.

User The name of the user who launched the
process.

Thread count The number of tasks generated by the
process.

Priority The priority can determine the amount of
time the CPU will execute the process
before executing another one.

Monitored Indicates if this process is watched by
Netfinity Director.

Memory usage The amount of virtual memory the process
uses.
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1. Close Application

This function will end the remote process.

2. Add to Monitors

This will make Netfinity Director watch the process and warn you if it starts,
ends, or fails to start (you can define a time out).

For example, we are going to add an alert when the Clock process stops.
First, we show how to remotely launch a program and then we monitor it.
Once you are in the Process Management window, as shown in Figure 5, click
Actions -> Execute Command.

Figure 148. We are going to launch a program on the remote computer

This will bring up a dialog box similar to Figure 149. In the Command field, type
Clock, since this is the program you will execute remotely.

Figure 149. The Execute Command dialog box

Then click Execute. Note the dialog box will not disappear, but the Execute
button will remain grey for a short period of time before being accessible. Click
Close.

Wait a few seconds, and once the Process Management window has been
refreshed, the Clock program will appear in the list of the processes (Figure 150).

Figure 150. The Clock program is now added to the list of the processes

Now, right-click the Clock row, and choose Add to Monitors.
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Figure 151. This action will create a monitor for the Clock process

Note that once you choose Add to Monitors, nothing in particular is displayed in
the window. However, in the background, this process gets added to the list of the
processes that Netfinity Director will monitor.

We now have to specify the conditions of the monitoring. Click Monitors ->
Process Monitors (Figure 152).

Figure 152. The Monitors menu

This displays a window called Process Monitors as shown in Figure 153.

Figure 153. The behaviors we can control on the Clock process

You can monitor three behaviors of the Clock process:

1. Start - An event will be generated each time the Clock program starts on the
given computer.

2. Stop - An event will be generated each time the Clock program ends on the
given computer.

3. Fail - An event will be generated each time the Clock program fails to start
within the period of time specified in the Timeout column.

Then, check the box under the Stop column, as shown below:
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Figure 154. Adding a monitor for when the Clock program stops

Save the monitor again by selecting File -> Save.

Figure 155. The monitor must now be saved

A dialog box appears as shown in Figure 156, asking you to confirm the action.

Figure 156. The confirmation dialog box, before saving the monitor

Click Yes, then close the Process Monitors window.

At this point you have configured Netfinity Director to warn you when the Clock
program will stop running on the target computer. To check it, stop the Clock
program on the managed system (you just have to exit the program, or if this is a
remote system use the Close Application function as shown in Figure 5 on page
98).

In a short period of time (no need to close the Process Management window), if
you right-click on the console the system where you created a monitor and
choose Event Log in the contextual menu, you will see the event viewer related
to this system with an entry similar to the one in Figure 157.
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Figure 157. An entry in the Event Log informs us that a process has ended on a system

The Win32 Services tab
This tab is the equivalent of the Control Panel -> Services applet in Windows
NT. Each service installed in the computer is listed along with its status. The
contextual menu of the Actions menu gives you the opportunity to change the
state of a service by pausing, starting, stopping, or continuing the service
(continue a service means resuming it after having paused it). Not all of the
services can be paused (refer to the Windows NT command net help pause).

Figure 158. The Win32 Services tab and the available actions

Note that you can’t monitor if a service stops or starts. This must be done from
the Applications tab, since some of the listed applications correspond to some
services. You can’t determine whether a service starts automatically, manually, or
never.
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The Device Services tab
This tab is similar to the Control Panel -> Devices applet of Windows NT. These
are the device drivers or low-level drivers that are listed here. You can start or
stop one of these drivers, but you can’t configure the startup environment as you
can with the Windows NT applet.

Figure 159. You can interact on the Device Services

3.2.8.3 Process management on an OS/2 computer
The process management window on an OS/2 system is similar to what you get
on a Windows 95 system, except you have three ways to end a remote process:
send a Ctrl-C, a Ctrl-Break, or a Kill signal.

Figure 160. Process Management with an OS/2 client
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If you want to end a process you should first try the Ctrl-C signal (if the developer
of the program that the process is related to has implemented Ctrl-C or Ctrl-Break
signals in the code), then the Ctrl-Break, and if all else fails, send a Kill signal.

3.2.9 Event management and logging
An event indicates a change in the status of a computer or a component on a
computer (this could be hardware components, for example a failing drive, or it
could also mean software components). Any event that happens on a system can
be intercepted by the agent and forwarded to the Netfinity Director Server. If the
server is not reachable, the event will be queued and will wait in the memory of
the managed system until the server becomes available. Therefore, if this system
has to be rebooted, the queued event will be lost. To determine what events need
to be forwarded, you must configure an event filter for each system or group of
systems.

Events can be classified in terms of severity and there are different severity
levels. Depending upon the severity appropriate actions can be configured.

Figure 161. Netfinity Director Event Log for all the managed systems

We discuss event management in more detail in 3.3.2.1, “Event action plans” on
page 118.
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3.3 Group management

In 3.2, “Base functions” on page 74, we covered Netfinity Directors core functions
with some individual systems. We are now going to explain the different groups of
systems available in Netfinity Director, and the management tasks we can
perform on them.

3.3.1 The different groups
There are many default groups in Netfinity Director and the ones that show up on
your Netfinity Director Console are related to the types of the systems that are
being managed.

3.3.1.1 Defaults groups
The defaults groups are the one provided with Netfinity Director. These are:

• All Systems and Devices

This group contains a list of all the systems recognized by Netfinity Director
(systems managed with a Netfinity Director Agent, or an MPM layer).

• Clusters and cluster members

This group contains the systems that are nodes of a cluster, and clusters
themselves.

• Netfinity Director systems

This group contains the systems that have a Netfinity Director agent layer.

• Systems with NetWare, OS/2, Windows 3.11, Windows 95/98, and Windows
NT

These systems are classified according to the operating system loaded

Note: Windows NT 3.51 systems are not supported.

• IBM Netfinity Systems

These are the computers managed through the Netfinity Manager MPM. This
item appears only when MPM support is enabled.

• MPM Systems

This is the list of all the computers that are managed through MPM. This item
appears only when MPM support is enabled.

Other default groups that are standards-related are:

• Systems with Asset ID
• Systems with Alert on LAN
• Systems with CIM
• Systems with SNMP Agents

3.3.1.2 Static groups
The static groups are groups whose members are determined and set by the
Netfinity Director console administrator. These groups are created with any name
you choose and you choose which systems are to be part of these groups.

For example, let’s say you want to create a group that contains the computers in
the human resources department. From the Netfinity Director main console,
right-click in the Groups pane as shown in the following figure:
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Figure 162. Creating a static group

It doesn’t matter if any existing group is selected, just right-click in any blank area
within the Groups pane. Then, choose the New Static option from the contextual
menu.

You should see a new pane appear in the bottom left part of the Groups pane. Its
title is Static Group Editor: New, as shown in Figure 163.
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Figure 163. Static group editor

Now, select any computer you want in the Group Contents pane, and using drag
and drop, copy it into the Static Group Editor pane. You will see a display similar
to Figure 164, where computer icons appear in the pane.

Note: You can browse the different existing groups, and build the new group by
dropping the computers you want into the new group you are creating. You are
not limited to any filter since you are manually creating the group.

Figure 164. We have designated which computers will belong to the new group

Now, click the Done button. A dialog box will ask you to save the new group.
Click Yes to confirm.
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Figure 165. Save the group

You can give a name to this new group as shown in Figure 166.

Figure 166. A name for the new group

Once you have clicked OK in the Save as dialog box, the console’s display will
refresh, and you will see your new group in the Groups pane. If you select it, the
computers you selected should be included in it (Figure 167).

Figure 167. The new group Human Resources Dp with the three systems we added

Statics groups are a powerful and convenient way to map the system
management functions to your organizational structure.

You can edit a static group if you want to add or remove some systems. From the
main console, just right-click the group, and choose Edit... from the contextual
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menu. The Static Group Editor pane will appear (as in Figure 164), and by
right-clicking a computer, you will be able to remove it, or add some other ones
with drag and drop.

3.3.1.3 Dynamics groups
Dynamics groups contain systems that were selected based on some rules
(determined by inventory items), and whose list is maintained by Netfinity
Director.

For example, if you want you can create a group that contains only the systems
having at least 140 MB of free space and ones that don’t have Lotus Notes
installed. The reason for that choice might be if you were looking for systems that
didn’t have Lotus Notes installed yet and you wanted to prepare the installation.

From the Netfinity Director main console, right-click in the Groups pane.

Figure 168. About to create a Dynamic group

It doesn’t matter if any other existing group is selected, just right click in a blank
area of the Groups pane. Then, choose the New Dynamic option in the context
menu.

The Dynamic Group Editor window will open as shown in Figure 169. It shows
you the criteria you can use to determine which systems will be part of your new
group. Note that the values for each are related to the ones that had been
detected during the inventories processes. For example, we can see, in Figure
169, that the existing values for IP Address correspond to the IP addresses
implemented in the managed systems known by Netfinity Director. You can also
choose some physical criteria (for example, number of IDE devices), related to
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the system’s information (for example, BIOS manufacturer or user information),
or some software criteria.

Figure 169. The Dynamic Group Editor

Expand the software branch and expand the Program Title branch to the Lotus
Notes item. Then click Add in the bottom of the pane. The Lotus Notes criteria
will be added in the right tab (under Selected criteria). By default, this query will
look for all the systems that have Lotus Notes installed, but in this instance, we
want the opposite: those that don’t have Lotus Notes installed. So, in the selected
criteria pane, right-click Inventory / Software / Program Title = Lotus Notes. A
contextual menu as shown in Figure 170 will appear:
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Figure 170. We changed a parameter of the selection criteria

As you can see, there are several logical expressions to choose from to express
how Netfinity Director will use the criteria we selected. Click Not equal to, in
order to make our query mean "seek all computers that don’t have Lotus Notes
installed on it". Once you do that, you should see the query get modified slightly.
It changes to "Inventory / Software / Program Title ^= Lotus Notes" (Figure 171).

Figure 171. We changed the query according to our goals

We must now fine-tune the query with a second criteria: computers that have at
least 140 MB of free space available. In the Available Criteria pane, expand the
Partition branch, then the Free Space branch, and you should see listed there
the different values about free space remaining in the partitions of the systems
that are known by Netfinity Director.

According to Figure 172, within our managed clients some computers have 95
MB, 211 MB, or 635 MB of free space, but we don’t see appear the value of 140
MB. Therefore, we have to perform some customization, by selecting a value and
modifying it.
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Figure 172. As we are going to customize it, we can choose any value

For example, we clicked 95016 -> Add in order to put it into the Selected Criteria
pane. That brings up the following figure:

Figure 173. This window appears when we choose to make a query with more than one criteria

The purpose of this window is to ask how you want to implement the second
criteria that was chosen. Since we wanted a query that looks for any computer
without Lotus Notes installed and having at least 140 MB of free space on a hard
drive, we checked All true (AND), and clicked OK.

If we had chosen Any true (OR) the query would have selected all the computers
having at least 140 MB of free space and all the computers that didn’t have Lotus
Notes installed. Queries can become quite complex, so it is always a good idea to
think about what you want before creating it. Make sure you test it after creating
the query by picking up some selected systems and manually checking if their
configuration is in accordance with the query and with what you know about the
configuration of the sample systems.
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Once OK has been clicked, the display will look like Figure 174:

Figure 174. A query with multiple criteria

In the Selected Criteria pane, we then customized the information related to the
free space on the drive. Using the current settings, Netfinity Director selects
systems that have 95016 KB of free space. We are going to tell it we want the
systems with 140 MB or more of free space as well. Right-click the line Inventory
/ Partition / Free Space (KB), and choose Greater than or equal to in the
contextual menu as shown in the following figure:

Figure 175. Customizing the criteria related to drive space
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Note the sign equal (=) is replaced with the >= sign (greater than or equal to). The
we changed the value 95016, and typed 140000 instead. While still keeping
Inventory / Partition / Free Space (KB) selected in the Selected Criteria pane, go
to the Edit menu, and click Change Criteria Value.

Figure 176. The Change Criteria Value option

This will bring up a dialog box where you can modify the operator and the value it
is related to as shown in the following figure:

Figure 177. The last step to customization

Enter the value 140000 instead of 95016, and click OK to confirm the change. That
completes the query as shown in Figure 178 and you can now save and test it.

Figure 178. We finished the query

From the File pull-down menu choose Close Group Editor.
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Figure 179. About to quit the group editor

The system will ask you if you want to save the query you created. Click Yes.

Figure 180. A reminder

The last step is to enter the name of your dynamic group. Since you want to give
it a name that relates to its function, enter Candidates for Lotus Notes install.

Figure 181. The name of the newly created group

Now it’s time to check the computers that appear in this group. From the main
console, select the new group you just created. Netfinity Director will perform a
query in its database, and it selects all the systems to which the query applies.
This means that the server agent will not launch any query on the network. So, if
you want the most recent information, you first have to perform an Inventory
Collection on the group All Systems and Devices, or on the group that contains
the computers you want to investigate.

In our case, only one system meets the criteria of the query: the system
JABBATH. Based on that, we will only have to buy one license, instead of making
a purchase of 10 licenses. Another implication of this is that you might need to
upgrade your hardware to add additional hard drives, if you need to have the
code installed on other systems.
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Figure 182. One system meets the criteria of our query

For more details on inventory collection see 3.2.1, “Inventory management” on
page 75.

3.3.1.4 Task-based groups
The tasks-based groups contain computers that can have one or several tasks in
common. For example, you can create a task-based group in which you find the
computers that are CIM and DMI-enabled.

3.3.2 Planning management tasks with groups
We showed the main Netfinity Director functions in 3.2, “Base functions” on page
74. Most of them also apply to managing groups. Note that, depending upon the
type of group (default, static, dynamic or task based), all the tasks may not be
available.

Table 6 summarizes these tasks. They are accessible in the contextual menu
when you right-click a group.

Table 6. Management tasks for groups

Task Definition

Edit To add or remove some systems in a static
group. To modify the conditions of the query
in a dynamic group.
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We are now going to focus on three elements that are essential for group
management: event action plans, resource monitors, and customization of the
inventory.

Copy Not available on default groups (see Copy as
static task). It allows you to create a group
based on the content of a static group, or on
the query of a dynamic group. You must
provide a new name for the group you create
this way.

Delete Remove a group from the Groups pane. This
does not delete the systems related to this
group from the Netfinity Director database.

Rename Change the name of the group. Not available
on default groups.

Copy as static Take a snapshot of the content of a group,
and insert it into a static group. Therefore,
this new group will not get updated
automatically.

Perform Inventory Collection Will update the Netfinity Director database
by requesting all the computers of the group
to send their settings.

Event Log An event viewer common to all the
computers of the group.

View Inventory Display the result of an inventory, in a
multi-column and multi-row view.

CIM Browser Allows you to browse the CIM properties of
several systems at once (in a tree-style
view).

Event Action Plans To create some event action plans for the
group, or for some computers in a group.

Set presence check intervals Determine the common presence check
interval value for each computer in the
group.

All available recordings Summarize in a table the recordings that
have been programmed for the systems in a
group.

All available Thresholds Summarize in a table the thresholds that
have been programmed for the systems in a
group.

Resources Monitors Access to the attributes of the computers in
the group.

Distribution Preferences Allows you to manage several settings
related to software distribution for the
computers in a group.

Task Definition
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3.3.2.1 Event action plans
Event action plans are one of the most important functions of Netfinity Director.
These plans describe what type of event the server must listen to regarding the
computers or group concerned and what kind of action must be taken regarding
the nature of the events.

There are three steps to build an event action plan:

1. Build an event filter
2. Build an action plan
3. Run the action plan for a group or some systems

Note: CIM events sent by UM Services appear under the CIM event filter
category.

Build an event filter
From Netfinity Directors main console, select Tasks -> Event Action Plan
Builder.

Figure 183. Launching the Event Action Plan Builder

From the Event Action Plan Builder window, select File -> New -> Event Filter.

Figure 184. Accessing the Event Filter window

You should see a window similar to Figure 185.
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Figure 185. About to build a new event filter

By default, Netfinity Director defines seven types of event filters:

• All events
• Critical events
• Fatal events
• Harmless events
• Minor events
• Unknown events
• Warning events

The distinction among them is the critical event filter cares only about events that
have the Critical status flagged, the Fatal Events filter cares only about events
that have the Fatal status flagged, and so on. The All events filter will forward any
event that can occur on the managed system.

Note: It is not a good idea to activate the All events filter for a group. You should
use it only for specific systems (those you want to monitor), because you can get
a lot of events that are not always pertinent to management.

The severity of an alert is defined by the application that generates it.

When you want to build an event filter, you first have to choose what type of event
you want to be warned of. You select them in the Event Type tab. You might
choose for example, to be warned about any change to the Software Tree of the
remote computers registry, or any change in the Windows NT Event Log of a
managed NT system. Of course you will not get any alerts if you apply that event
filter to a non-Windows system.

If you want to be warned of any change occurring in the Event Viewer of a
Windows NT System, in the Event Type tab of the Event Filter Builder window,
uncheck the Any box, and highlight the field Windows NT Event Log.
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Figure 186. Select the Windows NT Event Log

Now select the Severity tab, and check the Any box in order to get all events that
will be written in the NT Event Log, regardless of their severity.

Figure 187. We want to get any event regardless of the severity

Select the Day/Time tab. This tab is related to the period of time when you want
the filter to be active. For example, if you want to filter only the logon failures that
occur on the weekend, choose Saturday & Sunday in the Day of the week
pop-up menu and use the Starting Time and Ending Time fields to define the
range of activity for the filter each day. Click Add to set these parameters, as
shown in the following figure:
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Figure 188. We can set the period of activity for the filter

If you are using this section as a step-by-step guide, check the Any box for
demonstration purposes, as in the following figure:

Figure 189. Most administrators will use the any box

Select the Category tab. There are two types of events: Alert and Resolution
alerts. The first type is related to a change in the state of a remote system, and
the second tells us the change has been resolved (in a perfect world the Netfinity
Director event log should contain one resolution entry for each alert).
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Figure 190. The Category tab

Select the Sender Name tab. It is used to define the source (usually, a Netfinity
Director server) that forwards to your console the event you want to filter. You can
choose to get events generated from a particular node only (a server, an SNMP
device, or an MPM device).

Figure 191. The Sender Name tab

In the current example, leave the Any box checked.

The last tab to work with is the Extended Attributes tab. This tab is used in
conjunction with the Event type tab, allowing a greater level of control on this kind
of event to filter. Since we already selected to get alerts related to the Event Log,
we have several options.

In Figure 186, we had selected only the Windows NT Event Log. If we now select
the Extended Attributes tab and uncheck the Any box, we have several
keywords available to filter the messages related to the Windows NT Event Log
of the remote Windows NT systems (see Figure 192).
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Figure 192. The Extended Attributes related to the Windows NT Event Log

For example, if you only want to get from the managed systems the messages
coming from the Net Logon service, you have to choose Source in the keywords
menu, enter NETLOGON in the Values menu, and click Add in order to activate the
filter criteria. After doing that you should see a window similar to the following:

Figure 193. We chose to get only messages related to the NET LOGON service

For this example we left the Any box checked.
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Now that we have gone through the different tabs available to select what kind of
message we would like to get, we can quit the Event Filter Builder. In the File
menu, choose Save As.

Figure 194. About to save our new event filter

A dialog box appears so that you can enter the name of the newly created event
filter.

Figure 195. We have to enter a name for this event filter

We called it Win NT Event Log and clicked OK. The Event Filter Builder window
closes and you can check in the Event Filters tab that it was saved by the system
(see Figure 196).
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Figure 196. Our filter has been saved

Now that we have defined the type of events that should be monitored by the
remote agent, we have to build the action plan.

Build an action plan
An action plan is made up of one or more event filters, with one or more actions
associated with each event filter. To create one, select File -> New -> Event
Action Plan.

Figure 197. About to create an action plan
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A dialog box appears (Figure 198), asking for a name for the action plan. As it is
related to the Windows NT Event Log filter, we called it NT Event Log.

Figure 198. Enter the name of the action plan

The NT Event Log action plan should appear in the Event Action Plan in the
left-hand pane:

Figure 199. A new action plan has been created

To associate an event filter to this action plan, select it and right-click the Win NT
Event Log filter in the Event Filters tab as shown in Figure 200. Then select Add
to Event Action Plan in the contextual menu.

Note that you could have done this association by dragging the Win NT Event
Log filter on top of the NT Event Log action plan.
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Figure 200. Associating an event filter with an action plan

The filter should appear under the selected action plan as shown in the following
figure:

Figure 201. The NT Event Log action plan will use the Windows NT Event Log filter

You can have several event filters associated with one action plan. The remote
agent will be configured to look for any of the events you have filtered.
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We now have an action plan with an event filter, but we have to decide what the
server should do when it gets the alert. Several actions are available with
Netfinity Director. They are described in Table 7.

Table 7. The available actions

Action Description Parameters Comments

Add a Message to
the console ticker
tape

When the event occurs, an
informational message will
appear and scroll from right to left
in the bottom of the Netfinity
Director’s main console.

Message: the body of the
message that will be displayed.

User: the ID of the users who will
be able to see the message.
Multiple IDs should be separated
by a comma or a space; an
asterisk means anybody.

None

Add an Event to
the Event Log

A description of an event will be
added to the Netfinity Director
event log.

N/A Should always be
used to keep track of
what happened on
managed systems.

Post to a News
Group (NNTP)

An information message will be
sent to a news groups, using the
NNTP protocol.

News Group: fully qualified name
of the destination news group.

Reply-to-address: e-mail address
of the administrator who has set
this action.

News host: news server name (for
example new.server.com).

Port: port number to be used for
NNTP protocol (default is 119).

Subject: subject of the message.

Body of News posting: some text
you want to be added with the
description of the event.

Messages should be
forwarded to intranet
news groups only.

Send an
Alphanumeric
Page (via TAP)

Send a message on a pager. This
one must comply with the
Telocator Alphanumeric Protocol
(TAP).

Serial Port Device Name: the
COM port on which the modem is
connected.

Paging Network’s Access
Number: the number to dial with
the modem (35 digits maximum).

Pager ID or PIN: a number
(usually 7 digits) identifying the
person we want to page.

Message to send: the message
itself we want the person to be
informed of.

Modem Initialization string: we
can enter here some AT
commands to configure the
modem.

None
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Send an Event
Message to a
Console User

A pop-up message will appear on
the console of a specified user.

Message: the body of the
information message we want to
send.

User: the name of one or several
Netfinity Director users we want to
be informed of the message.

Delivery criteria: we can warn the
users while they are logged in, or
as soon as they get connected.

Use commas or space
to separate several
entries in the user
field. Use an asterisk
(*) to warn anyone
who is connected.

Send an Internet
(SMTP) E-mail

The description of the event will
be sent via e-mail.

Internet e-mail address: the
address where we send the mail.

Reply-to: the name of the
administrator who has set this
action.

SMTP e-mail server: name of the
SMTP server (for example,
mail.fr.ibm.com).

SMTP Port: usually 25 (port
number where the SMTP daemon
runs on the e-mail server).

Subject of e-mail message: as it
says.

Body: the message that will be
added to the description of the
event.

Send an SNMP
Trap to an IP Host

An SNMP trap will be generated. Destination IP address or
hostname: name or IP address of
the SNMP manager or gateway.

Community: name of the SNMP
community.

Send a Numeric
Page

A numeric-only message will be
sent to the specified pager.

Serial Port Device Name: the
COM port where the modem is
connected.

Pager Number: the number to dial
with the modem.

Numerical Message: the numbers
that represent the message.

Modem Initialization String: a set
of AT commands that will override
the default string.

Action Description Parameters Comments
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All these actions, except Add an Event to the Event Log, must be customized
before they can be used with an action plan.

These actions all have a History Mode, which means that each time an action is
issued, the result of the action is logged in an event log. You can view the event
log for each action by right-clicking the action you customized, and selecting
Action History -> Show, or you can view all the actions related to an action-type
by right-clicking the type of action, and selecting Action History-> Show.

You can suspend, then resume if necessary, the recording of an action’s log.

Start a Program on
Any IT Director
System

As a response to an event, a
program will be launched on any
system having the Netfinity
Director agent installed.

Netfinity Director System
Address: network address of the
system on which the program will
be launched. Rule for addressing
is:
transport_protocol::address

Program Specification:name of
the program to launch.

Working Directory: if necessary,
specify the directory the
application will use.

Valid transport
protocols are:
TCP/IP
IPX
NetBIOS

Examples:
TCPIP::9.24.106.130
TCPIP::jkl-srv.raleigh.i
bm.com

IPX::A1:1234567890
AB
NETBIOS::CLARK

Start a Program on
the "event" System

A program will be launched on the
system where the event has
occurred.

Program Specification: name of
the program to launch.

Working Directory: if necessary,
specify the directory the
application will use.

None

Start a Program on
the IT Director
Server

A program will be launched on the
Netfinity Director server (the one
that gets the event).

Program Specification: name of
the program to launch.

Working Directory: if necessary,
specify the directory the
application will use.

None

Start a Task on the
"event" System

A Netfinity Director
non-interactive task will be
performed on the system that has
generated the event.

Task: designation of the task to
launch. Default tasks are
Inventory, Remove Process
Monitors, Shutdown Power Down,
Restart, Wake-on-LAN.

Every task that had
been created with the
Process Tasks
function will appear
here.

Action Description Parameters Comments
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Figure 202. You can test each action your set

In order to personalize the messages, you can use some variables. These
variables are described in Table 8. Note that once you have customized an
action, you can test it by right-clicking it and selecting Test in its contextual menu,
as shown in Figure 202.

Table 8. Variables to use for event data substitution

Since we are going to create an action related to our example (catching all events
related to the Windows NT Event log of managed computers), we use some of
these variables.

We created the action plan NT Event Log. Now we are going to insert in this
action plan the actions that will be generated in case of an event. We chose to
write the event into the event log and we want a pop-up message to appear on
the console of the Administrator user.

In the Actions pane of the Event Action Plan builder, drag the action Add an
Event to the Event Log onto the left pane (Event Action Plans), and drop it on
the filter Win NT Event Log that appears below the NT Event Log action plan.

Variable Meaning

&date Date when the event occurred

&time Time when the event occurred

&text The content of the event

&type The type of event generated (usually, the
service or program that generated it)

&severity Severity level (critical, fatal, etc.)

&system Computer that generated event

&sender Computer that sent the alert

&group Group of the target system

&category Alert or Resolution
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Figure 203. We added an action to the Event Action Plan "NT Event Log"

As shown in Figure 203, the action "Add an Event to the Event Log" has been
added under our NT Event Log action plan. Therefore, any relevant event will be
written to the Netfinity Director’s event log.

We are going to add a second action to our event plan: a pop-up message that
will appear on the administrator console. Go to the Actions plan and right-click
the Send an Event Message to a Console User action, and select Customize
in the contextual menu as shown in the following figure:

Figure 204. The way to define a pop-up message

A Customize Action window will appear (we could have accessed it by
double-clicking the Send a Message to a Console User action too).
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Figure 205. The Customize Action window

There are three parameters associated with the delivery of a pop-up message:

1. Message

This is a short message that appears on the console of the destination. Since
we used variables, we entered the following text:

An &severity event has occurred on system &system.

The &severity variable refers to the status of the event (critical, harmful,
unknown, etc.).

The &system variable refers to the name of the system on which the event
occurred.

2. User(s)

This contains the names of the Netfinity Director server users you want to be
notified when the event occurs. You can enter an asterisk (*) if you want any
user connected to be notified.

For demonstration purposes, enter the name that you used for logging (we
chose administrator).

3. Delivery criteria

This field can accept two values: Active Users Only means that only the
specified users who are logged onto the Netfinity Director server through the
console will get the pop-up message. The At Next Logon value means that the
specified users that are connected will get a pop-up message. Those that are
not logged on will be informed of the event at their next connection.
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Figure 206. Parameters for customizing a console message

We have now defined the settings for a pop-up window to be displayed on the
console of one user (administrator) as soon as an event occurs on a system (you
can refer to Figure 206 to check the parameters).

Choose File -> Close to close the Customize Action window.

Figure 207. About to close the Customize Action window

A dialog box will ask you if you want the new parameters to be recorded. Click
Yes.

Figure 208. Confirmation dialog box

Enter a description and click OK.
134 Netfinity Director - Integration and Tools



Figure 209. Enter the name of the defined Event Action

Back in the Event Action Plan Builder window we can see a new action appear as
a subclass of the "Send an Event Message to a Console User" event type:

Figure 210. Our customized console message

In order for the event action plan to be complete, we have to assign this Warning
Message action to the NT Event Log action plan.

Select the Warning Message action, and drag it over the Win NT Event Log filter
that appears in the Event Action Plans pane, under the NT Event Log action plan.

You should see a window similar to Figure 211, with four new elements in the
Event Action Plans pane: an action plan called NT Event Log under which we find
an event filter called Win NT Event Log. That event filter has two actions
associated with it: Add an Event to the Event Log and Warning Message.
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Figure 211. We finished creating the NT Event Log action plan

We can now close the Event Action Plan Builder.

Run the action plan on a group or some systems
Now that we have an action plan that writes some information in the Netfinity
Director event log and displays a message on the console for any new entry in
the NT Event log of a computer running Windows NT, we must run it against a
group or some systems.

Since this action plan is related to a feature of Windows NT, it seems quite logical
to run it against a group of systems that run that operating system.

From the main Netfinity Director Console select the Systems with Windows NT
group (Figure 212).
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Figure 212. Four Windows NT Systems are licensed by Netfinity Director

Currently, two Windows NT systems are online: 23-M2271 and JKL-SRV.

Right-click, in the Groups pane, the Systems with Windows NT group, and
choose Event Action Plans in the contextual menu. A window similar to Figure
213 will open.

Figure 213. The Event Action Plans related to Windows NT systems window

We can see the computers belonging to the Systems with Windows NT group
appear in the middle pane. Two action plans appear in the right pane: Log All
Events (created during Netfinity Director installation), and ours, NT Event Log.
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Drag and drop the NT Event Log action plan over the Windows NT systems that
we want to use this plan. Once that is completed these systems will be displayed
with the name of the action plan they are using:

Figure 214. The NT Event Log has been applied to two systems

Now, any event occurring on either of these two systems will be reported in the
Netfinity Director events log and a message related to this event will appear on
the administrator console.

For example, if someone tries to log in to the JKL-SRV desktop, the following
message will appear on the administrator console:

Figure 215. The pop-up message

If we click Event Details, we get the following information:
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Figure 216. The content of the event message

Right after getting this error message we received another one from the system
23-M2271:

Figure 217. Another pop-up message

The details of the event were:

Figure 218. A DLL file couldn’t be loaded
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In parallel to these displays, the event messages were written to the Netfinity
Director event log. We can check this from the main console, by right-clicking on
the Systems with Windows NT group, and selecting Event Log.

Figure 219. System 23-M2271 seems to be in trouble

In Netfinity Director you cannot perform all of the action plans that you set up for
some groups, except the "All Systems and Devices" group.

3.3.2.2 Customizing inventory
Inventory is a core function in Netfinity Director, because many tasks use the
result of the inventory to work on managed systems (for example, resource
monitors or thresholds). Inventory allows you to collect hardware and software
information. You can create your own queries, according to your management
goals.

Inventory information is stored in Netfinity Director’s database (which can be an
SQL or DB2 server according to the installation choices you made). Each time a
system is discovered by Netfinity Director, it gathers inventory items from the
system and stores it in this database. This mean you can see what is installed on
a computer, even if it is not currently reachable on the network. This is because
the Netfinity Director server will first look for inventory in the database. If you
want the most current information you will have to perform an inventory
collection, as described in 3.2.1, “Inventory management” on page 75.

Accessing and browsing the inventory
There are three ways to access the inventory:
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1. If you right-click a computer in Netfinity Director’s main console (in the Group
Contents pane), and choose View Inventory in its contextual menu, you will
have access only to the information related to this computer. However, any
customized query you create will be able to be used with other systems.

Figure 220. Accessing the inventory of a stand-alone system

2. If you right-click a group in Netfinity Director’s main console (in the Groups
pane), and choose View Inventory in its contextual menu, you will have
access only to the information related to this computer. However, any
customized query you create will be able to be used with other systems.

Figure 221. Accessing the inventory of a group

3. If from the menu bar you select Tasks -> View Inventory, you access the
inventory collection of all the systems known by Netfinity Director. Any query
you create here will also be available for groups or systems inventory.
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Figure 222. Accessing the inventory of all systems

Any way you access the inventory, the interface will remain the same. Just the
number of systems related to the queries will change.

If we launch the inventory for all systems and devices, the Inventory Query
Browser window will be displayed, as shown in the following figure:

Figure 223. The Inventory window

In the left pane, Available Queries, we have two main folders: The Custom
folder contains customized queries (currently, none are defined in Figure 223),
and the Standard folder contains a default query provided with Netfinity
Director.

The menu bar contains some actions, some of which are available through
contextual menus. We will use these actions later in this section.
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In the right pane is the name of the system and its attributes.

For example, if we select the item Basic System Information in the left pane,
we can now see on the right pane some rows with the names of the All
Systems and Devices group computers, and each one contains information
about the processor, the memory installed, and the operating systems
running, as shown in the following figure:

Figure 224. Basic Information for the computers in the All Systems and Devices group

If we want more information about the operating system installed we can
highlight the Operating System item in the Available Queries pane (Figure
225), and check the build level.
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Figure 225. More information on the operating system

Create a query
To build our own query, click Options -> Build Custom Query.

Figure 226. To build our own query

A window similar to Figure 227 will then appear:
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Figure 227. The Inventory Query Builder window

The left pane, Available criteria, lists all the items you can use to build the query.
The items you select will appear in the right pane. To add any item, just expand
the branches in the Available Criteria pane, select the item you want to use, and
click the Add button.

For example, if we want a summary related to the TCP/IP configuration for a
system, from the Available Criteria list highlight the IP Address item. Then, click
the Add button at the bottom of the Inventory Query Builder window. The items
related to the IP configuration will appear in the Selected Criteria pane, as shown
in the following figure:

Figure 228. We selected some TCP/IP parameters for our customized query
Core functions 145



If there is an item you don’t want to use in the Selected Criteria pane, you can just
select it, and click Remove.

Figure 229. We don’t need the IP address of the secondary name server

When you are done select File -> Close and a dialog box will ask you if you want
to save the query you just built. Answer Yes, and you can enter a name for this
new query:

Figure 230. We give our customized query a name

Then click OK. The query will then appear in the Custom folder of the Available
Queries pane, as shown in Figure 231. If you select it, you will see the main
TCP/IP parameters for each computer in the group.
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Figure 231. The results display of our custom query

We could have mixed any query criteria; we just had to select the item or set of
items and add it in the Selected Criteria pane of the Inventory Query Builder
window.

Netfinity Director allows you to perform a software inventory, in addition to the
hardware inventory.

Accessing and modifying the software dictionary
The software inventory is available from the Inventory Query window, provided
with the Standard query. You have to select the Software item in the Available
Queries pane, and you will be able to see the programs installed on each system
in the group in the Query Results pane. Figure 232 shows us an example of a
software inventory on several computers.
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Figure 232. Result of the Software query

To perform this application inventory, Netfinity Director comes with a built-in
dictionary. During the Inventory Collection process, it sends the contents of this
dictionary to the scanned computer, which compares it with each recorded
program.

Each program is identified by a set of information regarding the files that come
with it. For example, the presence of the Microsoft Internet Information Server is
detected if three files are found on the scanned system (setup.exe, inetmgr.exe,
and w3svc.dll). Windows 98 is identified by two files, control.exe and a win.com
file whose size must be 24791 bytes.

You can modify the default entries of the software dictionary, and customize it by
defining the signature of the applications you want to be able to detect.

For this purpose, you can select from the Inventory Query Browser window, the
menu Options -> Edit Software Dictionary.

Figure 233. Editing the software dictionary from the inventory query browser window

Or, from the main Netfinity Director’s console, select Tasks -> Edit Software
Dictionary.
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Figure 234. Accessing the software dictionary from the main console

You can then access the Inventory Software Dictionary Editor window, as shown
in Figure 235:

Figure 235. The Inventory Software Dictionary Editor window

The entries defined in the dictionary appear in the left pane (called Available
Entries), in a tree view, because they are classified according to the type of
software they refer to (for example, Database or Games). In the right pane is the
characteristics of each entry, and the criteria used as a signature for the software.

For example, Figure 235 shows how Network Watcher is defined. Network
Watcher is a tool that is shipped with the Microsoft Windows 9x operating
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systems. If the netwatch.exe file is found on a system, then it means the Network
Watcher is installed. If multiple files are defined for software, they must reside in
the same directory.

We can modify this entry, by highlighting Microsoft Net Watcher in the Available
Entries pane, and choosing Selected -> Modify. You will notice that the Add, Edit
and Remove buttons, which were greyed out, turn black and are now usable.

Then, we click the bottom Edit button.

Figure 236. The Edit button allows us to modify a dictionary entry

This will bring up a window that will let you modify the characteristics associated
with the netwatch.exe file. If you had an application associated with several files,
you would have had to select one of its associated files in order to edit it.

Figure 237. The netwatch.exe file characteristics

You can now specify several parameters related to the netwatch.exe file. There
are two types of parameters: those related to the size of the file, and those
related to the date.

Note: If you change the name of the file, replacing netwatch.exe with file.exe,
and you close the Associated File Attributes window, a new entry will be created,
indicating that the Network Watcher program needs two files to be detected
(netwatch.exe and file.exe).
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For the parameters related to the size, you can specify a minimum or exact size
value and another field lets you specify a maximum size. For example, enter the
value 62000 in the Exact or Minimum Size field, and the value 65000 in the
Maximum Size field. If you just fill in the Minimum or Exact Size field, it must
contain the exact size of the file you are looking for. Otherwise, you should fill in
the Maximum Size field.

For the parameters related to the date, uncheck the Disable Date Attributes box
(which means we didn’t care about the date of the netwatch.exe file). Then click
the calendar icon on the right of the Exact or Earliest Date field. Use the calendar
displayed to choose 24/8/96. The Latest Date field is used in conjunction with the
Exact or Earliest date field to specify a range of dates that determine if our
network.exe file is part of the Microsoft Network Watcher utility.

Check the Date Is Exact box (which means you won’t specify a range of dates,
just a specific one).

Now, the Associated File Attributes window should look like the following window:

Figure 238. We modified the Netwatch.exe attributes

Note that if the Use Win32 Version Info for Product Version box is checked,
Netfinity Director will be able to extract version information from the files you
specify as signatures for a product. Usually, some version information is stored in
these files if the developer has set this option. So, you will not always be able to
get something even if this option is checked. Sometimes this can be confusing.
When you are looking for a product whose marketing name is Product 2.2, and
the associated DLL reports a 4.50.10 Version, you need to be able to match the
different fields for the right version number.

Click the OK button to close the window. You will return to the Inventory Software
Dictionary Editor window.
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Now, modify the Title field and complete it for example, with the words for Win9x

systems. The entry for Microsoft Network Watcher should look like the following
window:

Figure 239. The entry for the Network Watcher program, once modified

Now choose File -> Close. A dialog box asks you if you want to save the
changes; click Yes. The Software Dictionary has now been updated with these
changes.

If you perform an inventory collection on a system that has a netwatch.exe file
dated after 8/24/1996 and a size from 62000 to 65000 bytes, you will see the
following information when clicking Inventory -> Software:
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Figure 240. Now, the Microsoft Network Watcher program appears as Microsoft Net Watcher for Windows 9x systems

The addition of the software dictionary entries allows you to have a dictionary that
is a close match to your software environment.

Adding entries to the software dictionary
Another way to customize the default dictionary is to add your own entries,
related to some software too specific to be published, or to some applications you
need to be able to detect.

From the main Netfinity Director console, choose Tasks -> Edit Software
Dictionary. The default behavior of the Inventory Software Dictionary Editor is to
display a new entry that you can customize (if this is not the case, choose File ->
New, in order to get a display similar to Figure 241).
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Figure 241. Ready to enter a new entry in the software dictionary

You must first fill in several fields before indicating to Netfinity Director the
specific files that indicate the presence of the application. These fields are used
for administration convenience. They are not used to detect if an application is
installed or not.

For example, maybe you want Netfinity Directory to be able to detect Adobe
Acrobat Reader 4.0. We know this software isn’t recorded in the dictionary since
it wasn’t detected on some systems where this application was installed. It is OK
to perform a check by using the File -> Find function of the Dictionary Editor.

The Find function will browse all the entries in the dictionary, looking in the Title
field of each entry. If a title is found and this is not the one you are looking for,
click Find Next to find another entry. Once the end of the dictionary is reached,
the search will automatically go to the first entry to keep on looking for matching
entries.
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Figure 242. The Software Dictionary Editor find function

There are several entries for Acrobat Reader, related to Version 1.0 and 3.0, but
none for Version 4.0. Version 3.0 is detected when a file AcroRd32.exe exists,
with a size of 2,263,552 bytes. Version 1.0 is detected when a file Acroread.exe
with a size of 730,832 bytes exists.

As criteria for Acrobat Reader 4.0, we used the name of the main executable file,
AcroRd32.exe, and its size, 2,315,264 bytes.

Fill in the New Entry window, in order to make it look like Figure 243:

Figure 243. Defining an entry for Adobe Acrobat Reader 4.0

The Entry Type field is a pull-down menu where you choose which category of
software the program you are defining belongs to. If nothing is entered, the string
"Default" will be inserted by the Dictionary Editor. All fields in the Entry
Description pane are used only for display purposes.
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Then click the Add button to specify which files determine the presence of
Acrobat Reader 4.0. You are given two choices: Enter File Information Manually,
and Select File From List:

Figure 244. Two ways to specify associated files

The first choice will bring you to a window similar to Figure 238, but with blank
fields. This gives you the opportunity to specify a range for the size and date
attributes. The second choice lets you choose using a file browser window which
files are to be associated with the program. Each time you choose a file with this
option, the program automatically picks up the exact date and size attributes so
you don’t have to enter them manually.

Since we wanted to enter some exact attributes, check Select File From List,
and click OK. The file browser window should appear:

Figure 245. The file browser window

In this case, the AcroRd32.exe file was located in the Acrobat Reader 4.0 default
installation directory:
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Figure 246. We located the .exe file to associate with Acrobat Reader 4.0

Click the OK button on the right. Then you will see in the Associated pane of the
New Entry window with the AcroRd32.exe file with its size and date attributes:

Figure 247. The information related to the AcroRd32.exe files

You can add, for each new software entry, as many associated files as you want,
but they must reside in the same directory.

In order to update the dictionary with this new entry, click the floppy drive icon in
the tool bar, then choose File -> Close.
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Now, you can perform an inventory collection (the process is described in 3.2.1,
“Inventory management” on page 75) to update the Netfinity Director database
with the names of the systems that have Acrobat Reader 4.0 installed.

Exporting some query results
The base Netfinity Director program allows you to export the results of a query.
This export function is accessible from the File -> Export menu:

Figure 248. Data exporting

Two formats are available: the Comma Separated Values (CSV) format and
HTML. Either one will prompt you to enter a filename:

Figure 249. Saving data in .CSV file format

You get a message if the export has completed successfully.
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Figure 250. The confirmation message

Exporting data can be very useful, because you can then manipulate the
information in a spreadsheet or a database program.

Reading a .CSV file in Lotus 1-2-3 (Release 9)
In Lotus 1-2-3, select the File -> Open pull-down menu.The Open dialog box will
appear. In the Files of type field, select Text (TXT,PRN,CSV,DAT,OUT,ASC).
Select the file you wish to import (Figure 251), and click Open.

Figure 251. Select the file type

A new window will appear, with several import options. Check Parse as CSV file
(Figure 252), then click OK.

Figure 252. Select the CSV import option

The spreadsheet program will then read the selected .CSV file, and import it in a
new sheet in a display similar to Figure 253.
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Figure 253. The result of the import in Lotus 1-2-3

Reading a CSV file with Lotus Approach
In Lotus Approach, choose File -> Open.... The Open dialog box will appear. In
the Files of type field, choose Text - Delimited (*.TXT). In the File Name field,
enter *.csv, then click the Open button in order to enable a filter for CSV files.
Browse through your folders to find the .CSV file you wish to import (Figure 254).
Once you find it click Open.

Figure 254. Select a file type and a file name

Then, a Text File Options window will pop up. Check the Commas option in the
Separate fields with list, check the First row contains field names option at the
bottom, and check the Windows field in the Character set pane. Then click OK
(Figure 255).
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Figure 255. Options in order to import the CSV file

Finally, you have to specify another filename, which will be the destination file.
Lotus Approach will read the data in the .CSV file and after converting it, it will
save it in the file you specify. The default file type is dBase IV file format, but you
can specify other file types.

Select a file name and a file type as the destination, then click Create (Figure
256).

Figure 256. A destination file name and type is needed

Lotus Approach will import and display the first entry of the .CSV file. An example
is shown in Figure 257.
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Figure 257. A .CSV file has been imported into Lotus Approach

For each Name (System) field that was found in the .CSV file, Lotus Approach will
display the information about it. Figure 257 shows, for the system NF5500, some
operating system information. If you look at the bottom of the window, you can
see that Approach has correctly found the seven entries for the .CSV file, and
converted them into records.

From this, you can see that you can use the features of a powerful database or
spreadsheet software to manage your inventory.
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Chapter 4. Netfinity Director tools

Netfinity Directors Universal Manageability Services (UM Services) makes the
manageability of PCs (desktop, mobiles, and servers) possible and reduces your
total cost of ownership (TCO).

UM Desktop Extensions is an addition to the UM Services package to further
reduce your TCO on desktops and mobiles and make management even easier.
To use these tools, you have to connect to UM Services systems that have the
UM Desktop Extensions. This connection can be done with a Web browser. The
tools that you can access are:

• CMOS Configurator

• ConfigSafe

• CoSession Remote Control/CoSession Remote 32

• EZ Admin

• PC-Doctor

Also, IBM delivers some tools that make the management of IBM Netfinity
Servers easier. The tools in these packages can be divided into two groups: Life
Cycle Tools (LCTs) and other tools.

In this chapter we describe and show the tools that are accessible from within
Netfinity Director. Also, other Life Cycle Tools will be mentioned, to give an
overview of the entire collection of tools that IBM provides. To get more
information on UM Services see Universal Manageability: Enterprise
Management Integration, SG24-5388.

A sample of the Netfinity Director Tasks pane with the Life Cycle Tools added is
shown in Figure 258:
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Figure 258. Netfinity Director with LCTs installed

4.1 Installation of Life Cycle Tools

The following installation flow assumes that you have already installed the base
Netfinity Director product. We ran setup.exe to begin the installation:

Figure 259. The initial Server Extensions

Click Next and click Next again on the window that follows it. You then get a list of
all of the tools that will be installed on your system. In our case we had:
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Figure 260. Server tools to be installed

If you had the Netfinity Director task running you will be prompted to shut it down.
This does not refer just to the console interface, but the Netfinity Director Server.

Figure 261. Shut down Netfinity Director before integrating Life Cycle Tools

The installation process informs you of its progress as it installs the various tools:

Figure 262. Tool installations

Once the UM Server Extensions are all integrated and installed, click OK.
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Figure 263. Installation complete

Your start menu gets updated with the new tools:

Figure 264. Start menu updates

If you only installed a subset the first time or if additional tools become available,
you can click Install IBM UM Server Extensions to add new tools:

Figure 265. Reinstall or add new tools

The process is very similar to the base installation.

One slight difference is that you are prompted for the source directory where the
code is located. We modified it from the default location to the location we had
placed our copy of the tools:
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Figure 266. Tools source

Select one, or all of the tools to be installed and then click Next.

Figure 267. Select tools

We selected all of the tools. In this case it actually reinstalled some of the tools
that we had installed on the first installation. This did not appear to cause any
problems.
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Figure 268. Select all

The installation process informs you what it is going to do. The rest of the
installation process is the same as it was before.

The first time you restart the console you should notice on the bottom of the
console the words, Updating tasks. Those are the extensions being added to the
console.

Figure 269. Extensions added
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4.1.1 Extensions
The Tasks list now includes Life Cycle Tools. You can use the same drag and drop
process to access these functions as you do for the base Netfinity Director
functions.

Figure 270. New task list

If you drop and drag the Advanced System Management onto a server you should
see the following pop-up window. This shows you the functions that you can now
perform using Netfinity Director:

Figure 271. Advanced System Management

You can also drag and drop the AssetID task onto your server and you should see
the Asset ID information in a pop-up window:
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Figure 272. Asset information - many tabs of information

Dropping Capacity Manager onto a system that supports this agent provides the
capacity management function. You can track performance and produce some
graphical data to see how a system is doing:
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Figure 273. Capacity management
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Figure 274. Sample daily report

Following is a list of the reports you can run:

Figure 275. Capacity management reports

If you expand the list of tasks in the Netfinity Director Console you should see the
following UM Services Extensions as well as the base functions:
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Figure 276. All the tasks

4.2 Life Cycle Tools

All of the LCTs installed with the UM Server Extensions are made up of three
parts, just like Netfinity Director:

• Server

• Console

• Agent

You must have installed the LCT on all three subsystems, to use an LCT.

IBM LCTs consist of the following:

• CrossBrand LCTs

• Alert on LAN / Alert on LAN 2

• IBM System Migration Assistant (SMA)

• LANClient Control Manager (LCCM)

• SMART Reaction

• Server LCTs

• Advanced System Manager

• Capacity Manager
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• Cluster Manager

• ServeRAID Manager

• Update Connector Manager

You might not be able to use all of the LCTs on all of your systems, as some of
the tools depend on the technology that is built into the particular client.

Note: None of the UM Desktop Extensions currently install into Netfinity Director.

4.2.1 Advanced System Manager
With the Advanced System Management LCT you can connect to the advanced
system management processors or adapters, which are installed on your Netfinity
server. These adapters/processors are known as Advanced Systems
Management (ASM) devices.

The ASM device makes it possible to manage, monitor, and diagnose a Netfinity
server, even if it is powered down. With the Advanced System Management LCT
you can configure the ASM device either by LAN or a dial-out connection.

Advanced system management adapters or processors are capable of generating
events for operating system and operating system-loader time-outs, POST,
voltage and temperature, and so on. These events can be sent over the LAN or a
dial-out connection.

For more detailed information about the setup of the ASM devices, see Netfinity
Server Management, SG24-5208, available from
http://www.redbooks.ibm.com/abstracts/sg245208.html.

If you are connected to the system with the ASM device via the LAN, you can
drag and drop the task on the server to be managed. If you want to connect to
your system using the serial connection or a system that does not show up in
Netfinity Director, you can right-click the task and select Open or you can launch
the GUI from the command prompt - asmgui.exe. This GUI is installed in
<installation-drive>:\IBM\Director\bin.

Figure 277. The Advanced System Manager Life Cycle Tool
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The software requirements for this LCT are:

• Console: Windows NT 4.0, Windows 95, or Windows 98

• Server: Windows NT 4.0

• Agent: Windows NT 4.0

Also, the following event types are added to the Event Filter:

Figure 278. Event filters for ASM device

4.2.1.1 The options
You can perform different tasks from within the menus of the Advanced System
Management window. The following figure gives you an overview of the different
menus and their submenus:

Figure 279. The menus within the Advanced System Management LCT

• Change Connection

With these submenus, you can set up predefined connections including user
ID and password (this is the replacement for Netfinity Manager’s Dynamic
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Connection Manager or Serial Connection Manager). You can always see
which ASM device you are connected to by looking at the name at the bottom
of the window.

Connections to other ASM devices can be done in one of the following ways,
depending on your setup:

• Serial connection

You dial out from your managing machine into the ASM device.

• Interconnect

When you have made your first connection to an ASM device, you can
connect to other ASM devices. This is true if they are connected via the
RS-485 ASM interconnect bus port.

• TCP/IP

If you have a connection to the ASM device either via Ethernet or the
optional Netfinity Advanced System Management token-ring option.

• Update Microcode

This menu enables you to update the system’s BIOS and the ASM device
firmware.

• Select Event Sources

This menu item is for receiving alerts. An ASM device can send alerts through
the device driver, Netfinity TCP/IP, or serial.

Both Netfinity Manager and Netfinity Director can receive TCP/IP alerts. If you
have both Netfinity Manager and Netfinity Director installed on your system,
only one of them is able to receive the alerts. This means that if you want
TCP/IP alerts to be received in Netfinity Manager, you would disable the
TCP/IP event source in Netfinity Director. But if you want the TCP/IP alerts to
be received in Netfinity Director, you would have to disable Netfinity Manager’s
TCP/IP protocol.

If you select g, TCP/IP alerts can be received in Netfinity Manager and
forwarded by the MPM to Netfinity Director.

4.2.1.2 Operational parameters
To get information about the condition of the server, you can look into Operational
Parameters. This consists of three parts:

1. Temperatures

2. Voltages

3. System Status

None of the information in these windows can be changed; the amount of
information you get depends on the server model.

The temperature window gives you detailed information on the current
temperature of basic components in the system. Also, you can see the predefined
thresholds that are set for each component

• Value: This is the current temperature of the component.

• Warning Reset: If there has been a temperature warning, the warning will
be reset when the temperature goes under this value again.
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• Warning: If the temperature exceeds this value, a warning will be sent.

• Soft Shutdown: If the temperature reaches this value, the system will
attempt to shut down the system by shutting down the operating system
first.

• Hard Shutdown: If the temperature is equal to this value, the system will
power off, without any further warning. This is done to protect the system
components.

Figure 280. Operational parameters - Temperatures

The Voltages window gives information about voltages from the power supply. As
in the Temperatures window, you can see current values and predefined
thresholds. In this window you can see both the upper and lower thresholds.

Figure 281. Operational parameters - Voltages

The System Status window gives detailed information about the current status of
the system:

• System Power: Can be either on or off.

• Power-on Hours: Total number of hours the machine has been switched on.

• System State: Gives the system state, for example POST started, No
operating system activity detected, operating system activity detected, and
system powered off.

• Fan: Shows the status of the fans as a percentage of the maximum.
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Figure 282. Operational parameters - System Status

4.2.1.3 Configuration information
Configuration information gives you Vital Product Data (VPD) for the components
in the system.

4.2.1.4 Configuration settings
Here you can configure the settings of the ASM device, such as watchdog timers,
modem and network.

• General settings

This window is used to configure the name of the ASM device, set time and
date information, watchdog timers, and set up how you can dial in to the ASM
device.

Figure 283. Configuration of the ASM device

• Remote event settings

This is used to set up how a remote system is warned if an event occurs.
Events can be sent in the following ways:

• Numeric pager

• Alphanumeric pager

• Netfinity serial

• Netfinity TCP/IP
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• SNMP trap

Figure 284. ASM device - Remote Event Settings

• Modem settings

The upper frame of this window, Port Configuration, is for configuring the
modem, which is used to forward a dial-out event.

The lower frame, Dialing Settings, is used to configure if users are enabled to
dial into the ASM device. If the wrong user ID and password are entered it
determines how long in minutes the user must wait to be able to connect
again.

Figure 285. ASM device - Modem Settings

4.2.1.5 Event log
This is the event log for the ASM device.
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Figure 286. ADM device event log

4.2.1.6 System power control
System Power Control enables you to power the system up or down.

Note: You will only be able to power up your system from a remote location if you
have a serial link to the ASM device (modem or null modem).

Figure 287. System Power Control

4.2.1.7 Remote POST console
On supported systems, you can remotely follow the POST and go into the BIOS.

4.2.2 Capacity Manager
Collecting and analyzing resources in the enterprise can be a very difficult task.
Capacity Manager helps you by collecting and analyzing all kinds of information
in your network and displaying this information graphically. Based on data that is
already collected, Capacity Manager helps you to determine future requirements,
and helps you by preventing bottlenecks in your systems (for example, disk
space, overloaded network cards, and memory or CPU thresholds).
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Figure 288. The Capacity Manager Life Cycle Tool

The software requirements for this LCT are:

• Console: Windows NT 4.0, Windows 95, or Windows 98

• Server: Windows NT 4.0

• Agent: Windows NT 4.0, Windows 95, Windows 98, OS/2 Warp 4.0, OS/2
Warp 5.0, NetWare 4.x, or NetWare 5.0

4.2.3 Cluster Manager
The cluster tools are intended for Microsoft Clusters, and they are divided into
two separate tools:

1. Cluster Systems Management

This is the actual management tool.

2. Software Rejuvenation

With this tool, you can set scheduled reboots of your nodes in the cluster.

To activate one of the tools, you have to drop the task onto a cluster (not a node
in the cluster).
Netfinity Director tools 181



Figure 289. The Cluster Manager Life Cycle Tool

The software requirements for the subparts of this LCT are:

• Console: Windows NT 4.0, Windows 95, or Windows 98

• Server: Windows NT 4.0

• Agent: Windows NT 4.0

The following event types are added to the event filter (to get details of the Event
Filter Builder, look in 6.2.3, “Event Action plans” on page 247 and 3.3.2.1, “Event
action plans” on page 118):

Figure 290. Event filters for clusters

4.2.3.1 Cluster Systems Manager
With the Cluster Systems Manager tool you can manage all of the resources in a
Microsoft MSCS cluster. We will not discuss the management of clusters in this
redbook, but only the difference in functions between this LCT and the one that
came with Netfinity Manager.

The GUI and the functions that you can perform have not changed. What you will
see is that the Cluster Systems Manager has been integrated into Netfinity
Director and because of that, certain tasks will be done in a different way. You can
still drag and drop your resources, and you can still find a wizard to help you
create certain resources. You can find the wizard in the Tools menu.
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Events have now been moved to the Event Filter task. As you can see in Figure
290 on page 182, you can select among all sorts of events upon which to base
your actions.

Figure 291. Cluster Manager GUI

4.2.3.2 Software Rejuvenation
Not all applications clean up the memory they use. This causes the memory to
get fragmented, which results in a decline in performance of your system. With
Software Rejuvenation, you can schedule reboots of your servers, which of
course, will clean up your memory. Our advice is to boot your server once every
two weeks.

What actually happens when a Software Rejuvenation occurs? First, all cluster
resources are moved to the other server. If the server is not up, the Software
Rejuvenation is not going to happen. When the resources are moved, the server
is booted. When it comes back up, the resources are moved back.

So you need to schedule this for each server in your cluster.

When you drag the Software Rejuvenation task onto a cluster node, you will see
the following figure:
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Figure 292. Software Rejuvenation

In the top left corner you see a frame called Cluster is Enabled. This can be set to
either True or False, indicating if the cluster rejuvenation logic should be running
or not. To schedule a Software Rejuvenation, you simply drag a node from the
Nodes in Cluster frame onto a date in the calendar.

If you right-click a node that has been scheduled, you get the following menu:

Figure 293. Context menu in Software Rejuvenation

From here you can schedule repeated boots, you can remove the node from the
schedule, and you can highlight all entries for the same clusternode.

If you schedule a Software Rejuvenation, you will be presented a window where
you can specify the details about the reboot, such as date, time, and setting the
event as a repeatable one. If you select Repeat, you will be able to select among
different periods such as daily, weekly, and monthly, and you can select the
frequency such as every day, every second week, every first Monday in a month,
etc.
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Figure 294. Setting repeating clusternode boot

Clicking the Options button from the Software Rejuvenation window gives you
this menu:

Figure 295. Options menu in Software Rejuvenation

• Cluster Failover Check - Defines the failover rules for the node.

• Rejuvenation Logic - If checked, the rejuvenation will stop if any errors occur.
For example, if you have two nodes, and you schedule a boot, then this will not
happen if the other node is not up and running.

• Min. Reboot Frequency - Ensures that the node can’t be rebooted more often
than this value.

4.2.4 IBM Netfinity SP Switch Manager
The software requirements for the subparts of this LCT are:

• Console: Windows NT 4.0

By clicking IBM Netfinity SP Switch Software, you launch the GUI that is also
accessible from the Start menu:
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Figure 296. The IBM Netfinity SP Switch LCT in the start menu

For information on how to use the Switch Administrator, click IBM SP Switch
Software1.5 -> Documentation (.pdf) to obtain the SP Switch, Installation and
User’s Guide.

4.2.5 ServeRAID Manager
With ServeRAID Manager you are able to view and configure RAID subsystems.

The software requirements for the subparts of this LCT are:

• Console: Windows NT 4.0, Windows 95, or Windows 98

• Server: Windows NT 4.0

• Agent: Windows NT 4.0, Windows 95, Windows 98, OS/2 Warp 4.0, OS/2
Warp 5.0, NetWare 4.x, or NetWare 5.0

Figure 297. The ServeRAID LCT
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The following event types are added to the event filter:

Figure 298. Event filters for ServeRAID

When dragged onto a server that has ServeRAID, you get the following window:

Figure 299. The ServeRAID LCT GUI

If you select the Actions menu, you can access the Notification and Security
Manager.

The Notification Manager is a tool that is used to alert other systems running the
ServeRAID Manager of the events that happen on the system (the system on
which you started the ServeRAID Manager task). This can be used if you want
alerts to be sent to your local workstation in addition to the event actions you
select in Netfinity Director.
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Figure 300. The ServeRAID LCT - Notification Manager

Security Manager is used to give users access to configuring and viewing
information from remote systems. It is possible to disable Security Manager from
the menu, but it is not recommended to have unsecured access to the RAID
subsystem.

Figure 301. The ServeRAID LCT - Security Manager

In addition, Security Manager also tracks events into a log file, RAIDSEC.LOG.

In total there are four log files:

1. RAIDEVT.LOG - Information reported from ServeRAID Manager’s event
viewer

2. RAIDNOT.LOG - Information reported from Notification Manager’s event
viewer

3. RAIDSEC.LOG - Information reported from Security Manager’s event viewer

4. RAIDMANERR.LOG - Java messages from ServeRAID Manager

All of these files are installed in c:\program files\netfinity\raidman by default. Any
log file gets renamed to *.OLD if it exceeds 200 KB. Old *.OLD files will be
overwritten.
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If you select File -> User Preferences you will be able to configure Initialization
Settings.

The check box Automatically initialize new logical drives lets ServeRAID
Manager automatically initialize each new logical drive and also prevents the user
from getting access to the manual initialization function. When a drive is
initialized, the first 1024 sectors of the logical drive are written over with zeros.

Figure 302. The ServeRAID LCT - Initialization Settings

Remote Access Settings - The Local Only check box disables the ability to
monitor this machine’s RAID subsystem from a remote system, and you can’t
monitor remote systems either. The default port for the TCP/IP networking is
34571. This port number is stored in the properties file. The settings are not
activated until you start up the ServeRAID Manager next time.

Figure 303. The ServeRAID LCT - Remote Access Settings

Here is an example of the properties file RAIDMANGUI.PROPS:
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Alarm Settings - The check box enables or disables repeating alarms. If you
disable the alarm, you will not get an audible alarm if an event happens in the
RAID subsystem. If the alarm is enabled, you can select the time interval
between each alarm and the length of the alarm (number of beeps).

Figure 304. The ServeRAID LCT - Alarm Settings

4.2.6 Configure Alert on LAN
Alert on LAN is a technology that enables alerts to be sent to a network
administrator if a system problem occurs. It does not matter if the system is
powered on or off. Alerts will be sent if there is a cover intrusion, processor
removal or a power or network plug removal. If the system is running, or if the
system detects voltage, temperature, and fan speed problems, alerts will also be
sent. It can detect if the operating system hangs. Alert on LAN comes with the
base Netfinity Director installation.

Maintenance capabilities have also been expanded with Alert on LAN 2 helping
network administrators to perform common system support functions, such as
remote operating system repairs or BIOS image updates, in response to system
failures. In addition, a higher level of flexibility has been added to enable network
managers to selectively respond to alerts according to priority, enabling them to
address the most critical alerts first.

Alert on LAN 2 allows a management console to work directly with a PC. For
example, when a PC with Alert on LAN 2 generates an alert, the console sends

#IBM Netfinity RAID Manager GUI Properties
#Thu Aug 12 14:01:55 EDT 1999
gui.frame.location.y=60
gui.frame.location.x=80
minimumalarminterval=10
gui.frame.width=567
autoInitNewDrives=true
gui.shouldbeep=true
startupPortNum=34571
gui.frame.height=280
localOnly=false
gui.show.statusbar=true
alarmduration=3
repeatingalarm=true
repeatingalarminterval=300
gui.frame.iconfied=false
mainPanelHeight=90
gui.show.toolbar=true
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an acknowledgment. This "handshake" ensures that alerts have been received
and prevents multiple alerts for the same failure. Additionally, the management
console now has the ability to poll a PC to determine whether it has Alert on LAN
2 capability, or to ascertain whether a mobile PC is connected and available for
servicing.

In our environment, the Alert on LAN proxy tool was installed in the network by
using the Netfinity Director Workgroup/Enterprise integration option and we
configured the clients' AOL Agent to point to that proxy when sending their alert
packets. The installation was done in Chapter 2, “Installation and customization”
on page 37:

Figure 305. Workgroup/Enterprise Integration

4.2.7 Asset ID
Asset ID comes with the base Netfinity Director installation. An EEPROM on the
system board contains information about the system. In addition, you can enter
your own information about warranty, leasing, purchase date and other
information. Some of these systems also allow you to scan this information with a
special radio frequency scanner. If there is a change in the configuration, Asset
ID can send a DMI-compliant alert. UMS Asset ID can store information into the
DMI database if no EEPROM is present on a system.

Asset ID information is divided into the following topics:

• Serialization information

This reports the serial numbers by components, which have their serial
number stored in the EEPROM or DMI database.
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Figure 306. Asset ID - Serialization

• System information

The LCCM Profile field will normally be filled out when a profile is put on the
system by LCCM, or you will fill it out with a radio frequency unit before the
system is installed. LCCM uses this name to determine with which profile the
system is going to be loaded.

Figure 307. Asset ID - System

• User information

The Name field is obtained from the registry or the operating system.
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Figure 308. Asset ID - User

• Lease information

Lease information can be manually entered.

Figure 309. Asset ID - Lease

• Asset information
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Figure 310. Asset ID - Asset

• Personalization information

Figure 311. Asset ID - Personalization

• Warranty information
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Figure 312. Asset ID - Warranty

4.2.8 LANClient Control Manager
With LCCM you can automate the installation of your clients, for example, BIOS
updates, system installations, and system updates. See Using LCCM Functions
with Servers and Workstations, SG24-5292.
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Chapter 5. Database support

Netfinity Director uses a database to store the information gathered by the
inventory task. Netfinity Director can use different kinds of Database
Management Systems (DBMS) depending on your needs.

At the end of the installation process shown in Figure 57 on page 46, you are
asked to choose which database system Netfinity Director should use.

Figure 313. Choose database configuration

You have four choices:

1. Default

This is the preferred selection for most customers. Netfinity Director will install
its own database. The default path and name for this database is
<installation-drive>:\Program Files\IBM\Director\Database\Director.mdb

Note: The following is from the Readme file:
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2. Advanced SQL

Netfinity Director provides you with the capability to export your data into a
Microsoft SQL V6.5 or V7.0 database.

3. Advanced DB2

If you have IBM DB2 V5.2 you can export your data to it.

4. Custom

If you already have an existing Netfinity Director database in your enterprise
that you want to continue to use, select this option.

Note: At Microsoft’s Web page
http://www.microsoft.com/SQL/70/whpprs/jetmsde.htm , you can find a white paper
describing the differences between JET and Microsoft SQL. There are guidelines
to help you decide if you should use the JET or Microsoft SQL database.

...
*****************
Database Defaults
*****************
Default Database is Now a Jet 4.0 Database (MDAC 2.11)
-----------------------------------------------------
In this release of Netfinity Director 2.11 the ODBC drivers were
updated to MDAC level 2.11, which is available through Microsoft.
This package also updates the Jet Database drivers to version 4.0.
When the default database is requested on a new installation of
Netfinity Director server 2.11 a Jet 4.0 database is created.
This version of the database cannot be viewed using Microsoft
Access 97. A Jet 4.0 level database can only be viewed using
Microsoft Access 2000. If Microsoft Access 97 is the only version
of Access available, and it is desirable to view the Netfinity
Director database through Access, then a Jet 3.5 level database
can be used. This level of the database can be created through
Microsoft Access 97. The database can then be used by Netfinity
Director by setting up a ODBC data source for the new database
and modifying the file TWGServer.prop to use the new data source.
The User's Guide has more information about setting up Netfinity
Director to use an existing database.

If needed, Microsoft Data Access (MDAC) is used by Netfinity Director
V2.11 Server install to install and/or upgrade ODBC and its drivers.
The MDAC install consists of two steps, with the second step being
performed after the system is rebooted and the user logs on. The
Netfinity Director Server will attempt to start as soon as the
system is rebooted. Since the second step of the MDAC install does
not start until the user logs on, the Netfinity Director Server
database initialization will fail. You must reboot and log on
and then reboot a second time to resolve this situation.

Netfinity Director server on Windows NT offers several database
options. The default option uses the Microsoft Jet database. The Jet
database allows storing the year portion of a date in either a 2-digit
or 4-digit format. The ability to store the year in the 2-digit format
will cause certain applications that check for Y2K problems to issue a
warning about the database. This warning is not applicable to
Netfinity Director's database, because the year stored by Netfinity
Director is in the 4-digit format.
...
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5.1 Working with the default queries

The functions for storing and accessing data from within Netfinity Director are the
same whether you installed the default database, Microsoft SQL, or DB/2.

Right-click Inventory and select Open. This brings you to the Inventory Query
Browser. You could also drag and drop the inventory task onto a group or a group
member.

Figure 314. Netfinity Director Console

Netfinity Director already has a set of predefined queries defined. You can select
these queries from the standard folder or add your own.

Figure 315. A predefined query
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You can build your own queries by right-clicking the Custom folder or by clicking
Options -> Build Custom Query. You can also right-click a predefined query and
select copy.

Figure 316. Building your own query

In order to easily build your own queries, double-click any folder and select the
criteria you want in your query. You can add or remove criteria by double-clicking
them. Use the add and remove tabs at the bottom of the window or simply drag
and drop them.

When you have added the items you want to your list, save it by selecting File ->
Save from the pull-down menu. All the queries that you create appear in the
custom folder. You can sort all queries by right-clicking the column where you
want the sort order.

Figure 317. Sorting a query
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5.2 Working with DBMS

During installation, you are asked which kind of DBMS you are going to use for
storing Netfinity Director inventory data. The choice of DBMS doesn’t have any
influence on the GUI from Netfinity Director.

5.2.1 IBM DB2 V5.2 installation
To install IBM DB2 Universal Database on Windows NT, follow these steps:

1. Start the IBM DB2 UDB installation program by running setup.exe.

This will bring you to the welcome dialog box:

Figure 318. DB2 server setup

2. Click Next to begin the installation.

3. The DB2 installation Select Products dialog box appears. Select the
product(s) for which you have a license. We selected DB2 Universal
Database Workgroup Edition. Click Next.

The Workgroup Edition is the core Universal Database Server.

Enterprise Edition is like the Workgroup Edition, but it enables connectivity to
host systems, such as AS/400 and OS/390. Also, the Enterprise and
Workgroup Editions have different licenses.

DB2 Client Application Enabler enables clients to access the database server.
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Figure 319. Select product

4. After choosing the product you are prompted to select the type of installation
you want. We selected Typical.

Figure 320. Select installation type

5. Enter the installation path and drive. Unless you have specific needs, just click
Next.
202 Netfinity Director - Integration and Tools



Figure 321. DB2 installation path

6. The DB2 installation program will ask you for an Administration Server user
name and password. We changed the default user ID.

Note: The default user ID and password are db2admin. Be sure to change the
password, so that other people do not have full access to your database.

Figure 322. Administration server user name and password

7. You are then presented with an overview of your selections. If you have no
changes, select the Next button to start copying the files.
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Figure 323. DB2 installation settings confirmation

8. After copying the files to your hard disk, the DB2 installation program
responds with the following window:

Figure 324. DB2 installation complete

9. Click Finish to reboot your Windows NT system.

You are now ready to install Netfinity Director on this machine.

When you come to the part where you have to select which kind of DBMS you
click Advanced -> Create DB2 database.
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Figure 325. Select IBM DB2 as Netfinity Director DBMS

Netfinity Director will ask you for a name and node name for your database. If you
want the database to reside on the local system, don’t put anything in the DB2
Node Name field.

Type in the user ID and password. Depending on the setup of DB2, you can
choose not to have to enter the user ID and password to connect to the database.
Under normal circumstances, you set up DB2 so that every user needs a user ID
and password in order to select or change data. Click Next to continue. The rest
of the installation is the same as the default installation.

Figure 326. IBM DB2 ODBC configuration

When you restart your machine you should see the following database has been
created:

Select this for
DB2 DBMS
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Figure 327. Netfinity Director Database in IBM DB2

If you don’t have the Control Center on your desktop you can start it by selecting:
Start -> Programs -> DB2 for Windows NT -> Administration Tools -> Control
Center.

For a list of tables and columns in this database, see Appendix A, “Netfinity
Director tables” on page 289.

5.2.2 Microsoft SQL V7.0 installation
These are the steps required to install Microsoft SQL Server 7.0 on Windows NT:

1. Start the installation program.

The following window will appear:
206 Netfinity Director - Integration and Tools



Figure 328. Microsoft SQL startup

In order to install Microsoft SQL Server, you need to take care of some
prerequisites. For Windows NT 4.0 you need Windows NT 4.0 SP4 and Internet
Explorer 4.01 SP1, depending on the installation type you are going to install.
After installing the prerequisites select Install SQL Server 7.0 Components. The
following four choices are offered:

1. Database Server - Standard Edition

Used to install the full enterprise version of SQL Server on Windows NT
Enterprise Edition.

2. Database Server - Desktop Edition

Used to install the desktop version of SQL Server on Windows 95, Windows
98, or Windows NT.

3. SQL Server 7.0 OLAP Services

Used if online analytical processing (OLAP) applications need to have access
to your database through a Windows NT service.

4. English Query

This is a tool that enables users to post queries without having to learn
standard SQL statements.

We selected Database Server - Standard Edition.
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Figure 329. Microsoft SQL installation

When offered the choice of installing SQL server locally or remotely, we selected
the local installation.

Figure 330. Microsoft SQL installation method

After making sure that you don’t have any other applications running, click Next.
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Figure 331. Microsoft SQL Welcome

Click Next to accept the software license agreement. Fill in the fields Name and
Company and click Next to continue.

Figure 332. User Information

Select the type of setup you prefer and change destination folders. We selected
Typical setup and the default Destination Folder and clicked Next.
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Figure 333. Select Microsoft SQL installation type

You can indicate how the SQL services should start and which user ID and
password should be used when starting the services. We only changed the user
ID and password.

Figure 334. Set up Microsoft SQL services

Now that the installation program has gathered enough information, click Next to
begin installing the files to your hard disk.

Choose the licensing mode that you have for this product and select Continue.
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Figure 335. Select licensing mode

You have now completed the installation of Microsoft SQL Server 7.0. Click
Finish.

Figure 336. Complete setup

It is now OK to install Netfinity Director on this machine.

When you are asked which kind of DBMS you want, select Advanced -> Create
MS SQL Server database.
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Figure 337. Select Microsoft SQL as Netfinity Director DBMS

You also have to set up an ODBC connection to this database. Fill out the Server
Name field and follow the default installation procedure.

Figure 338. Microsoft SQL ODBC configuration

After you reboot you should see the Director database in Microsoft SQL Server
7.0.

Select this
for Microsoft
SQL
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Figure 339. Netfinity Director database in Microsoft SQL Server 7.0

5.3 Working with DBMS tables

To get to the information that is stored in the DBMS that you have selected, you
can use any query tool that can connect to the DBMS.

For each of the DB tables that are created in the DBMS a standard query is
provided in the Inventory Query Browser in Netfinity Director.

A relational database contains one or more objects called tables. Your data
is stored in these tables. Tables are identified by their names and are built
with columns and rows. Columns contain the column name and data type.
Rows contain the actual records or data for the columns. (Tables are
hereafter referred to as DB tables.)

Here is a sample DB table called weather:

Structured Query Language (SQL) is a standard used for accessing data in
relational DBMSs such as IBM DB2, MS SQL, Sybase, Oracle, Informix, MS
Access, and others. SQL is also used for defining databases and putting in
and manipulating the information in the databases, but that is not described
in this book.

City State Temperature

Raleigh North Carolina 101

San Diego California 88

Miami Florida 99

Database definitions

Column

Row
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Here is a list of the DB tables and the corresponding standard queries in Netfinity
Director. If you need to know what kind of data is in a table, just click the
corresponding query in the Inventory Query Browser.

Table 9. Comparing DB table names and Netfinity Director standard queries

IBM DB2 table name Microsoft SQL table name Query name in inventory query browser

N/A N/A Basic System Information

MSCS_CLUS_INFO MSCS_CLUS_INFO Windows NT Cluster Information

MSCS_GROUP_RES MSCS_GROUP_RES Windows NT Cluster Group Resource Map

MSCS_GROUPS MSCS_GROUPS Windows NT Cluster Groups

MSCS_NET_INT MSCS_NET_INT Windows NT Cluster Network Interfaces

MSCS_RESOURCES MSCS_RESOURCES Windows NT Cluster Resources

TWG_CLUS_MEMBERSH TWG_CLUS_MEMBERSHIP Cluster Membership

TWG_CLUSTER_MEMBE TWG_CLUSTER_MEMBERS Cluster Members

TWG_COMPONENT_ID TWG_COMPONENT_ID Component ID

TWG_DISK TWG_DISK Disk

TWG_IDE_ADAPTER TWG_IDE_ADAPTER IDE Adapter

TWG_IDE_DEVICE TWG_IDE_DEVICE IDE Device

TWG_INSTALLED_MEM TWG_INSTALLED_MEMORY Installed Memory

TWG_IP_ADDRESS TWG_IP_ADDRESS IP Address

TWG_IPX_ADDRESS TWG_IPX_ADDRESS IPX Address

TWG_KEYBOARD TWG_KEYBOARD Keyboard

TWG_LOGICAL_DRIVE TWG_LOGICAL_DRIVE Logical Drive

TWG_LOGICAL_MEMOR TWG_LOGICAL_MEMOR Logical Memory

TWG_MANAGED_OBJEC TWG_MANAGED_OBJECT System

TWG_MEM_MODULE TWG_MEM_MODULE Memory Modules

TWG_MOTHERBRD_ID TWG_MOTHERBOARD_ID Motherboard

TWG_NETWORK_ADAPT TWG_NETWORK_ADAPTER Network Adapter

TWG_ONBOARD_DEV TWG_ONBOARD_DEV On Board Device

TWG_OPERATING_SYS TWG_OPERATING_SYSTEM Operating System

TWG_PARALLEL_PORT TWG_PARALLEL_PORT Parallel Port

TWG_PARTITION TWG_PARTITION Partition

TWG_PCI_DEVICE TWG_PCI_DEVICE PCI Device

TWG_PHYS_CONT_GBL TWG_PHYS_CONTAINER_GLOBAL Physical Enclosure

TWG_POINT_DEVICE TWG_POINTING_DEVICE Pointing Device

TWG_PRINTER TWG_PRINTER Printer

TWG_PROCESSOR TWG_PROCESSOR Processor
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The Basic System Information Query is a combination of several DB tables. You
can see how to make your own query that matches this default query in 5.3.1,
“Making your own database queries” on page 218.

Note: UM Services adds several new database tables as well:

• UMS_AOL
• UMS_ASSETID
• UMS_CACHE
• UMS_CIM
• UMS_CONFIG
• UMS_LEASE
• UMS_LOCALE
• UMS_PERSONALIZATION
• UMS_PORTS
• UMS_SERIALIZATION
• UMS_SLOT
• UMS_SNMP
• UMS_UMS
• UMS_USER
• UMS_WARRANTY

The table definitions and query names corresponding to the tables are in
\Director\Data\UserTables\*.twgbdt. The status of the tables processing is in
\Director\Data\UserTables\*.status, and the
\Director\Data\InvExtension\*.ciminvext files specify which CIM information is
collected and how it should be mapped to the database tables.

Depending on the method you use to connect to the Netfinity Director database,
you first have to specify which database you are going to use. Each DBMS has a
different method of logging in to the database and entering SQL commands. For
IBM DB2 and Microsoft SQL this can be done with the following commands:

For IBM DB2: CONNECT TO dbname

For Microsoft SQL: USE dbname

TWG_SCSI_ADAPTER TWG_SCSI_ADAPTER SCSI Adapter

TWG_SCSI_DEVICE TWG_SCSI_DEVICE SCSI Device

TWG_SERIAL_PORT TWG_SERIAL_PORT Serial Port

TWG_SOFTWARE TWG_SOFTWARE Software

TWG_SYS_LOCATION TWG_SYSTEM_LOCATION System Location

TWG_SYS_RESOURCE TWG_SYS_RESOURCE System Resource

TWG_SYSTEM_BIOS TWG_SYSTEM_BIOS System BIOS

TWG_SYSTEM_USER TWG_SYSTEM_USER System User

TWG_VIDEO TWG_VIDEO Video

TWG_WINDOW_NET_ID TWG_WINDOWS_NETWORK_ID LAN Network ID

IBM DB2 table name Microsoft SQL table name Query name in inventory query browser
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The SQL query for a Netfinity Director standard query would look like the
following:

SELECT * FROM db-tablename

In this example we show you how a script would look in DB2 if you want to make
your own script. It does the same thing as the System BIOS Netfinity Director
default script. The query would look exactly the same no matter what program
you use to connect to your tables.

Figure 340. Example of a script in IBM DB2

The query gave us the following result:

Figure 341. Result of DB2 script 1 of 3
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Figure 342. Result of DB2 script 2 of 3

Figure 343. Result of DB2 script 3 of 3

Following is how it looked in Microsoft SQL:

Figure 344. Example of a script and result in Microsoft SQL

The corresponding default query from Netfinity Director gave the same result:
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Figure 345. Result of Netfinity Director default script 1 of 2

Figure 346. Result of Netfinity Director default script 2 of 2

5.3.1 Making your own database queries
The Basic System Information Query in the Inventory Query Browser is an
example of a query that spans several DB table. (You can see the comparison of
the queries in the Inventory Query Browser and the DB tables in Table 9 on page
214.)

Note: All the examples in this chapter are screen dumps based on queries made
in IBM DB2. To make the corresponding queries in another DBMS, refer to
Appendix A, “Netfinity Director tables” on page 289 to see the table names and
column names.

Before we get into how that query is made, let’s look at some SQL basics.

5.3.1.1 Basics of the SELECT statement
In 5.3, “Working with DBMS tables” on page 213 we saw that a simple query from
a single DB table looks like:
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SELECT *
FROM db-tablename

This query will select all rows (data) from the specified DB table. If you only want
specific columns from a table, or if you want the columns in another order, you
need to specify which columns, and separate them by commas:

SELECT columnname, columnname...
FROM db-tablename

Let’s see what the result is if we select all video subsystem information:

The statement selected all entries in the selected table, because we didn’t set
any conditions.

As you can see in the result of your query, you cannot tell which computer name
your video adapter information belongs to. This is because every DB table has a
column (MANAGED_OBJ_ID) that represents just a unique numeric value for
each computer, and not the actual system name. This numeric value is called a
key.

A key is a column or a set of columns that uniquely identifies a given row. This
means two things: no two rows can have the same key, and even if two rows are
alike (as in our example above, it is possible for us to have two computers with
the same type of video adapter, the key ensures that the data doesn’t get mixed.
Keys are made up of primary and foreign keys, but that is beyond the scope of
this chapter.

5.3.1.2 DISTINCT and eliminating duplicates
If you want a list of all the different video adapters that you have in all your
systems, you could use this query:

SELECT video_adapter
FROM twg_video

db2 => SELECT * FROM twg_video

MANAGED_OBJ_ID VIDEO_INDEX VIDEO_TYPE VIDEO_ADAPTER ...
-------------- ----------- ---------- ---------------------------------------...

203 1 SVGA Super VGA (VESA) ...
207 1 SVGA S3 Incorporated Trio3D Display Driver V...
205 1 VGA Video Graphics Array (VGA) ...
209 1 SVGA Super VGA (VESA) ...
208 1 SVGA S3 Incorporated Trio3D Display Driver V...
210 1 SVGA S3 Incorporated Trio3D Display Driver V...

6 record(s) selected.
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As you see, it gives you a list that contains a row for each system, and the same
type of adapters are displayed more than once. If you wanted a list of all the
different types of adapters, this is done with the DISTINCT keyword:

SELECT DISTINCT video_adapter
FROM twg_video

As you can see, now you only get every adapter type once. Always remember to
use the DISTINCT keyword on the column, where the repetition may occur.

5.3.1.3 Conditional selection
You may not always want to select all of the data in a table. This section describes
some of the methods for reducing the output of a query to include only rows that
satisfy your criteria.

There are six relational operators in SQL:

Table 10. Operators in SQL

The where clause is used if you want to select rows, depending on specific
conditions:

SELECT *
FROM db-tablename

= Equal

<> or != Not equal

< Less than

> Greater than

<= Less than or equal to

>= Greater than or equal to

db2 => SELECT video_adapter FROM twg_video

VIDEO_ADAPTER
----------------------------------------
Super VGA (VESA)
S3 Incorporated Trio3D Display Driver Ve
Video Graphics Array (VGA)
Super VGA (VESA)
S3 Incorporated Trio3D Display Driver Ve
S3 Incorporated Trio3D Display Driver Ve

6 record(s) selected.

db2 => SELECT DISTINCT video_adapter FROM twg_video

VIDEO_ADAPTER
----------------------------------------
S3 Incorporated Trio3D Display Driver Ve
Super VGA (VESA)
Video Graphics Array (VGA)

3 record(s) selected.
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WHERE search-condition(s)

Below is an example of a query that can be done in the Netfinity Director
database, where we select all systems with Windows NT as the operating system:

SELECT *
FROM twg_operating_sys
WHERE op_sys_name = ’WINNT’

Note: Generally, with text columns, stick to equal and not equal and make sure to
surround the value with single quotes (’ ’).

5.3.1.4 Logical operators
You can always join more search conditions with the logical operators AND and
OR. AND and OR operators can be combined (note that the AND operation is
done first).

• AND operators join two or more conditions, and display a row only if that row’s
data satisfies all conditions listed.

• OR operators join two or more conditions, and display a row if any of the
conditions are true.

For example, select computers with Pentium II processors, that are also running
at least 400 MHz:

SELECT *
FROM twg_processor
WHERE family = ’PENTIUMII’ AND max_speed >= 400

Be careful when using AND and OR operators at the same time. The result of
your query can easily be something other than what you expected. For example,
you are a used-car dealer, and all your cars are in a table. If you want all Fords
that cost less than 10,000 or have more millage greater than a set value, use this
query:

SELECT carid
FROM cartable
WHERE brand="FORD" AND cost<10000 OR xxx<yyy

The result of the above query would include all brands other than Ford, if you had
any cars that satisfied the condition xxx<yyy.

To get the result that we were looking for, you need to change the default way that
SQL handles these two operators. This can be accomplished by using
parentheses:

SELECT carid
FROM cartable
WHERE brand="FORD" AND (cost<10000 OR xxx<yyy)

5.3.1.5 IN and BETWEEN
An easier way of using compound conditions is by using the operators IN or
BETWEEN. For example, if you want a list of all of the desktops in your company
with their type and serial number, instead of specifying the conditions:

SELECT machine_model, machine_serial
FROM twg_phys_container_global
WHERE machinetype = ’xxx’ AND machinetype = ’yyy’ AND machinetype = ’zzz’
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You can use the IN... operator:

SELECT machine_model, machine_serial
FROM twg_phys_container_global
WHERE machinetype IN (’xxx’, ’yyy’, ’zzz’)

An example of the BETWEEN condition would be if you wanted a list of systems
that had a hard disk between 1 GB and 2 GB:

SELECT
FROM
WHERE xxx BETWEEN

To list all the systems that are not in this range, try:

SELECT
FROM
WHERE xxx NOT BETWEEN

Also, you can use NOT IN to exclude systems from the result.

Additionally, NOT can be used with AND and OR. Always make test queries to be
sure of the result you are getting and always refer to the SQL reference book for
your DBMS.

The SQL order of logical operations (each operation operates from left to right) is:

1. NOT

2. AND

3. OR

5.3.1.6 LIKE
Let’s say you want a list of machine types and serial numbers for all your Netfinity
3000 servers. Instead of making a query with the IN statement containing all of
the machine types that a Netfinity server can have, you can use a LIKE
statement:

SELECT product, serial_number
FROM twg_component_id
WHERE product LIKE ’8476%’

5.3.1.7 Joins
Until now, we have only been able to get a numeric value (the key) instead of the
system name as a description for the computer from our query. To get the
computer name into the query instead of a numeric value, you have to tie the
numeric values (the keys) in managed_obj_id together with the DB tables that you

db2 => select product, serial_number from twg_component_id where product like
'8476%'

PRODUCT SERIAL_NUMBER
------- ------------------------------
847621U 23M2271
847631U 23FF406
847631U 23FF426

3 record(s) selected.
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select your data from. After that, you can include the computer_name column in
the twg_window_net_id DB table. This is called joining tables.

There are different ways of joining tables together. We’ll only discuss inner joins
in this section.

First, let’s look at some basics. If you want to select all the data from more than
one DB table, the way to do that is shown with the following query:

SELECT *
FROM db-tablename, db-tablename
WHERE db-tablename1.key=db-tablename2.key

Since you don’t want all the information from twg_window_net_id, but just the
computer name tied together with all the information from twg_video, you’ll have
to modify the query. Instead of selecting all columns from all DB tables, you can
select which columns you want by typing them just like in an ordinary query,
instead of using ’*’. If you want all columns from a DB table, you just type the
table name followed by ’.*’.

This will make the query look like:

SELECT twg_window_net_id.computer_name, twg_video.*
FROM twg_window_net_id, twg_video
WHERE twg_window_net_id.managed_obj_id=twg_video.managed_obj_id

Note: If a column name is only represented in one of the selected DB tables, you
don’t have to write the DB table name in front of this column name. In the next
screen you can see, that computer_name doesn’t have twg_window_net_id. in
front of it.

Of course you can also combine the joining of tables and search conditions. The
following screen shows a way to make a list of systems with an S3 video adapter:

db2 => SELECT computer_name, twg_video.* FROM twg_window_net_id, twg_video
WHERE twg_window_net_id.managed_obj_id = twg_video.managed_obj_id

COMPUTER_NAME MANAGED_OBJ_ID VIDEO_INDEX VIDEO_TYPE VIDEO_ADAPTER ...
------------- -------------- ----------- ---------- -------------------------...
SF5CEINX 203 1 SVGA Super VGA (VESA) ...

205 1 VGA Video Graphics Array (VGA...
23-M2271 207 1 SVGA S3 Incorporated Trio3D Di...
JKL-SRV 208 1 SVGA S3 Incorporated Trio3D Di...
clark 209 1 SVGA Super VGA (VESA) ...
23-FF426 210 1 SVGA S3 Incorporated Trio3D Di...

6 record(s) selected.
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5.3.1.8 Aliases
As you learned in the preceding chapter, you have to use the format DB
tablename.columnname if you want a column in the output that is represented in
more than one of the selected tables. This can make your queries very long and
very hard to read. Aliases can be used both as a description for columns and as
aliases for DB table names. We show an example in which we want information
about the system name, system serial number, and motherboard’s serial number.
From what we have shown so far, you would set up the query as:

SELECT computer_name, twg_component_id.serial_number,
twg_motherbrd_id.serial_number
FROM twg_window_net_id, twg_component_id, twg_motherbrd_id
WHERE twg_window_net_id.managed_obj_id = twg_component_id.managed_obj_id
AND
twg_window_net_id.managed_obj_id = twg_motherbrd_id.managed_obj_id

The result would be:

But with aliases you can write:

SELECT computer_name computer, component.serial_number system_serial,
motherbrd.serial_number motherboard_serial
FROM twg_window_net_id network, twg_component_id component,
twg_motherbrd_id motherbrd
WHERE network.managed_obj_id = component.managed_obj_id AND
network.managed_obj_id = motherbrd.managed_obj_id

db2 => SELECT computer_name, video_adapter FROM twg_window_net_id, twg_video
WHERE twg_window_net_id.managed_obj_id = twg_video.managed_obj_id AND
video_adapter LIKE 'S3%'

COMPUTER_NAME VIDEO_ADAPTER
---------------- ----------------------------------------
23-M2271 S3 Incorporated Trio3D Display Driver Ve
JKL-SRV S3 Incorporated Trio3D Display Driver Ve
23-FF426 S3 Incorporated Trio3D Display Driver Ve

3 record(s) selected.

db2 => SELECT computer_name, twg_component_id.serial_number,
twg_motherbrd_id.serial_number FROM twg_window_net_id, twg_component_id,
twg_motherbrd_id WHERE twg_window_net_id.managed_obj_id =
twg_component_id.managed_obj_id AND twg_window_net_id.managed_obj_id =
twg_motherbrd_id.managed_obj_id

COMPUTER_NAME SERIAL_NUMBER SERIAL_NUMBER
------------- ------------- ------------------------------
SF5CEINX 238P4TZ F87P44DTUZ7

238P4XL F87P242X7LL
23-M2271 23M2271 AMP2V2Z7Q1B
JKL-SRV 23FF406 CF0F5400L64
clark 238P4XL F87P242X7LL
23-FF426 23FF426 CF0F5462G60

6 record(s) selected.
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Here is the result:

In this later query you can see that you were able to change the headers
(computer, system_serial, and motherboard_serial) in your output. Also, you used
your own names (network, component, and motherbrd) as names for the DB
tables.

5.3.1.9 In subqueries
Lets assume that your output is dependent on data from another query, also
known as a subquery; for example, a list of all computers (just the system name)
that have an S3 videoadapter:

SELECT computername
FROM twg_window_net_id
WHERE managed_obj_id IN
(SELECT managed_obj_id
FROM twg_video
WHERE video_adapter LIKE ’S3%’)

Here is the result:

5.3.1.10 Sorting your output
The output of an SQL query is not sorted in any particular way. To get a better
overview of your output, always sort your output. This is done by adding an order
by clause in your query:

db2 => SELECT computer_name computer, component.serial_number system_serial,
motherbrd.serial_number motherboard_serial FROM twg_window_net_id network,
twg_component_id component, twg_motherbrd_id motherbrd WHERE
network.managed_obj_id = component.managed_obj_id AND network.managed_obj_id =
motherbrd.managed_obj_id

COMPUTER SYSTEM_SERIAL MOTHERBOARD_SERIAL
-------- ------------- -----------------------------------
SF5CEINX 238P4TZ F87P44DTUZ7

238P4XL F87P242X7LL
23-M2271 23M2271 AMP2V2Z7Q1B
JKL-SRV 23FF406 CF0F5400L64
clark 238P4XL F87P242X7LL
23-FF426 23FF426 CF0F5462G60

6 record(s) selected.

db2 => SELECT computer_name FROM twg_window_net_id WHERE managed_obj_id IN
(SELECT managed_obj_id from twg_video WHERE video_adapter LIKE 'S3%')

COMPUTER_NAME
----------------
23-M2271
JKL-SRV
23-FF426

3 record(s) selected.
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SELECT *
FROM db-tablename
(WHERE search-condition if necessary)
ORDER BY columnname(s)

More columns can be used for sorting. Just separate the column names with
commas. Your output will then be sorted by your first column, then your second
column, until you run out of columns.

5.3.1.11 The basic system information query
You have learned how to combine, tie together, and select data from multiple DB
tables. Let’s look at how the basic system information standard query can be
done:

SELECT computer_name, family, current_speed, physical_memory_kb,
op_sys_type,
op_sys_version
FROM twg_window_net_id netid, twg_processor proc, twg_installed_mem memory,
twg_operating_sys opersys
WHERE netid.managed_obj_id = proc.managed_obj_id AND
netid.managed_obj_id = memory.managed_obj_id AND
netid.managed_obj_id = opersys.managed_obj_id

5.3.1.12 Aggregate functions
Having long lists of all your equipment is nice but not easy to understand at a
glance. If you want to know how many computers from each manufacturer and
how many machine types you have, it is not good to have a 150-page list with all
your equipment. You need to get your data out of the database in another way.

Let’s continue looking at how to get a manufacturer/machine type list out of the
database. First you have to find out what DB table and columns you need for your
output. The db-table twg_component_id contains the columns manufacturer and
product.

Here is a basic SQL statement:

SELECT manufacturer, product
FROM twg_component_id

You obtained the right data from your database. But the problem is you have one
row for every single machine in the table in the output and you will get redundant
data. You haven’t specified that you only want every system type once in the
result. You can eliminate the redundant output by putting the syntax, GROUP BY
in the statement, and sorting the output:

db2 => select manufacturer, product from twg_component_id

MANUFACTURER PRODUCT
------------ ---------------------------------------
IBM 6862R1U
IBM 847621U
IBM 6862R1U
IBM 6862R1U
IBM 847631U
IBM 847631U

6 record(s) selected.
226 Netfinity Director - Integration and Tools



SELECT manufacturer, product
FROM twg_component_id
GROUP BY manufacturer, product
SORT BY manufacturer, product

This result shows us that there are three different kinds of systems in the
organization. This is nice to know, but we still need to know how many there are
of each type.

With the COUNT(*) variable, you can count the number of entries the DBMS finds
in the selected DB table. The syntax to do that follows:

Now you know the total number of systems you have in your organization.

Note: If you perform this query on a DB table that has more than one entry per
managed_obj_id, you will not get the number of systems in your enterprise, just
the number of rows in that particular DB table.

To combine the last two queries to get the result, you wanted to begin with:

SELECT manufacturer, product, COUNT(*)
FROM twg_component_id
GROUP BY manufacturer, product
SORT BY manufacturer, product

db2 => select manufacturer, product from twg_component_id group by manufacturer,
product sort by manufacturer, product

MANUFACTURER PRODUCT
------------ ---------------------------------------
IBM 6862R1U
IBM 847621U
IBM 847631U

3 record(s) selected.

db2 => select count(*) from twg_component_id

1
-----------

6

1 record(s) selected.

db2 => select manufacturer, product, count(*) amount from twg_component_id
group by manufacturer, product order by manufacturer, product

MANUFACTURER PRODUCT AMOUNT
------------ ------- ------------
IBM 6862R1U 3
IBM 847621U 1
IBM 847631U 2

3 record(s) selected.
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Now you have exactly what you wanted. From this query you can see that you
have three different machine types in the database, and how many of each you
have. You can also use an ORDER BY COUNT(*) at the end of the last query.
Your result will then be sorted so that you can easily see how many of each
machine types you have. If you had planned to cut down the number of different
machine types in the organization, you can see how many you might discard.

5.3.1.13 Union
How do you make a query that will tell you how many servers, mobiles, and
desktops you have in you organization? With union you can combine several
queries.

Note: They need to have the same columns in the output.

Since there isn’t a table where you can see what type the system is, you have to
split it up yourself. First you need to know all of the different kinds of machine
types you have:

SELECT distinct machine_type
FROM twg_phys_cont_gbl

Then you have to split your result into which machine type belongs to which
category. That information can be used in the next query:

SELECT 'Servers' type, COUNT(*) amount
FROM twg_phys_cont_gbl
WHERE machine_type IN ('8473')
UNION
SELECT 'Desktops' type, COUNT(*) amount
FROM twg_phys_cont_gbl
WHERE machine_type IN ('6862')

If you have more machine types, just put them in the parentheses after the IN
keyword (remember quotes and commas between each type). If you want more
categories, just put in another union and select.

db2 => SELECT DISTINCT machine_type FROM twg_phys_cont_gbl

MACHINE_TYPE
--------------------
6862
8476

2 record(s) selected.

db2 => SELECT 'Servers' type, COUNT(*) amount FROM twg_phys_cont_gbl WHERE
machine_type IN ('8473') UNION SELECT 'Desktops' type, COUNT(*) amount FROM
twg_phys_cont_gbl WHERE machine_type IN ('6862')

TYPE AMOUNT
-------- -----------
Servers 3
Desktops 3

2 record(s) selected.
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5.4 Working with ODBC

Open Database Connectivity (ODBC) is a standard for accessing data externally.
With ODBC an application can use the same programming interface to access
different DBMS. The DBMS has to have SQL as a data access standard. ODBC
has four components:

1. ODBC-enabled application

This is the actual application to which you need to import data from the DBMS.

2. ODBC drivers

The ODBC drivers are the link between the data source and your application.
The ODBC drivers come standard with Windows NT or are included with the
program you use as a data source. The drivers eliminate the need to know all
the proprietary interfaces to the different DBMSs.

3. ODBC Driver Manager

This is the tool that you see from the operating system (in Windows NT,
Windows 95, or Windows 98 it is located in the control panel).

4. The Data Sources

The data source is the place where you have your actual data. Examples of
data sources are MS SQL, IBM DB2, and Oracle.

If you choose to work with the custom DB, you can have an ODBC connection to
that database as well. The default database can be connected to the Microsoft
Access driver.

We will now show an ODBC connection to the default database. If you want to do
this to either MS SQL or IBM DB2, all you have to change is the ODBC-driver.

Open the Control Panel and select ODBC Data Sources.
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Figure 347. Control panel in Windows NT for ODBC

Go to the System DSN tab and select Add to configure a new connection.
Depending on where your database is located and who should have access to it,
you might want to configure the connection in some of the other tabs, but in this
example we just show how to make a local connection.

Note: Make sure that the level of ODBC you have is compatible with the database
you wish to access. Windows NT Service Pack 4 changed the level of ODBC on
our system.

Table 11. Types of ODBC data sources

Configure the Driver Select

Visible to only the person who creates the
data source.

User DSN tab

Visible to anyone who logs on to the system. System DSN tab

Stored in a file and can be shared on a
network.

File DSN tab
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Figure 348. ODBC connection overview

First, you will have to select a driver for your connection depending on which kind
of database you want to connect to.

Figure 349. Selecting a driver for ODBC connection

Then you type in a name and description for the connection as well as selecting
the database file to use. To create the connection complete the action by
selecting OK.
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Figure 350. ODBC connection setup

Now that you have set up the connection your new link will show up in the ODBC
connection overview.

Figure 351. Your connection is added to the ODBC connection overview

Now that we have made a valid ODBC connection setup, the next time you install
Netfinity Director you can select Custom from the Director Database
Configuration window.
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Figure 352. Select database type

Now select the connection that you just created.

Figure 353. Selecting your own ODBC connection
Database support 233



234 Netfinity Director - Integration and Tools



Chapter 6. Netfinity Director and Netfinity Manager

This chapter compares the functions that are provided by Netfinity Director with
the functions in Netfinity Manager V5.20.4. This is done by taking a high-level
overview of both systems’ management tools and comparing their different
functions and services. Netfinity Director provides many functions to help
manage the environment. The focus of this chapter is to show the advantages of
Netfinity Director over Netfinity Manager. The steps that are needed to go through
the menus to show the differences between the system management tools are
shown in this chapter. If you need more detailed information for handling the
functions and services refer to 1.1, “Netfinity Director base functions” on page 1
and 3.2, “Base functions” on page 74.

6.1 Running Netfinity Director and Netfinity Manager together

If you want to integrate Netfinity Director into your existing Netfinity Manager
environment you have to do it with a separate installation. You can’t install both
products with one command. The installation process for Netfinity Director is
shown in 2.2.2, “Installation procedure for Netfinity Director Server” on page 38.
Netfinity Manager does not support any access to the Netfinity Director systems
and cannot use any data in Netfinity Director’s database.

Netfinity Director does support the management of Netfinity Manager systems
and can manage it with several different tasks. One of the ways that Netfinity
Director is aware of Netfinity Manager is through the MPM API, which is provided
during the Netfinity Director installation procedure. This is only possible when the
Netfinity Director is installed on the same system where the Netfinity Manager is
already installed. Figure 354 on page 236 and Figure 355 on page 237 show both
windows that appear when you have first installed Netfinity Manager and then
Netfinity Director. This is the only situation in which you will see these windows.

6.1.1 MPM support
MPM stands for Multi-Platform Manager and it is the result of a cooperative effort
between Tivoli and Intel in September 1996 to allow different management
software products to work together. MPM is an application programming interface
(API) that each management software vendor can implement in its product to
allow it to fit with other management products.

When you install the Netfinity Director Server, Win32 client, or OS/2 client on a
system running Netfinity Manager 5.x, you have the option of installing Netfinity
Director’s MPM provider for Netfinity Manager 5.x. Then, when you run the
Discover task from the Netfinity Director console, the system with the MPM
Provider installed will be added as an MPM Site in the Available MPM Providers
tab of the Discovery Preferences dialog box. MPM agents are the systems being
managed by the Netfinity Manager system on which the MPM Provider was
installed. To discover these MPM agents, you must manually move the Netfinity
Manager system from the Available MPM Site list to the Active MPM Providers
list. Clicking OK in the Discovery Preferences dialog box will initiate the discovery
of its MPM agents.

When you install the Netfinity Director Server, you can also install the MPM-API
related to Netfinity Manager. You must have Netfinity Manager already installed
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and running when you install Netfinity Director. Once the installation completes
and the system is rebooted, your system will be registered as an MPM provider.
This means that other Netfinity Director servers on the network that don’t have
the MPM installed can still connect to your system and get a list of the Netfinity
client systems you manage from your Netfinity Manager.

The MPM allows you to use Netfinity Manager (the minimum requirement is
Manager V5.2) as a gateway to reach systems that only use the Netfinity
Services management agent. The following management tasks are restricted (in
compliance with the MPM specifications, which specify a minimum set of
management capabilities):

• Perform inventory collection
• Event log
• View inventory
• Event action plans
• Set presence check interval

6.1.1.1 Netfinity Provider
Figure 354 shows the configuration window that requires your input:

Figure 354. MPM API for Netfinity Manager

Enable the MPM API for access to Netfinity Manager by clicking the check box.
Click Next to proceed.

Figure 355 shows information and functions that require your input. The path is
shown for the Netfinity Manager database directory where the Dictionary File will
be installed and the option to collect software and hardware inventory will be
chosen. In addition, you can set the refresh period for how often it will be
collected. The rate that you can select is from every hour to every 16 weeks.
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Figure 355. Netfinity Manager database directory

Select Collect Software Inventory or Collect Hardware Inventory. Then set the
Refresh Period to address how often Netfinity Director should collect inventory
from the Netfinity Manager clients.

Click OK to proceed with the regular installation process as shown in 2.2.2,
“Installation procedure for Netfinity Director Server” on page 38.

Netfinity Manager is a comprehensive system management program that is used
to manage Intel-based server and client hardware environments. There are two
pieces to Netfinity Manager:

1. Netfinity Manager

The Netfinity Manager is the managing portion of the system. It is normally
installed on a server or administrator workstation. Netfinity Manager can
manage local or remote systems.

2. Client Services for Netfinity Manager (client service)

The client service is the managed portion of the system and it is normally
installed on the clients as a desktop or mobile system.

This software does not permit any extensions to its functions other than by using
the command-line interface. There is no software developer’s kit (SDK).

Figure 356 shows Netfinity Manager’s main interface. It consists of a set of icons
that provides the user interface for Netfinity Manager’s functions. The functions
and services are started from these icons. As a system administrator, this will
probably be the most usable window. It provides access to use the Remote
System Manager to access and manage any Netfinity Manager function on any
Netfinity Manager system in your network. The Remote System Manager
organizes the remote systems in groups:

• System group

A system group is a group of individual systems that can be accessed and
managed by the Remote System Manager.

• Rack group

A rack group is a group of systems that are installed in a rack cabinet.
Rack-mounted systems can be configured to include a rack configuration file.

select here for
Inventory

select here for
Refresh Period
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• Cluster group

A cluster group is special type of system group intended to let you manage the
nodes of a Microsoft Cluster Server installation as a group. You define the
group by entering the cluster name.

A prerequisite for you to be able to use these functions is that you must have at
least one of the transport protocols active as shown in Table 14 on page 241. For
more information on the core functions please refer to Netfinity Server
Management, SG24-5208.

.

Figure 356. Netfinity Manager layout

Figure 357 shows the System Group Management. This function allows you to
place systems into separate groups that can be created by each operator. Each
of the groups can use a filter to search for different protocols or different
operating systems.
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Figure 357. Netfinity Manager Remote System Manager

Searching for keywords is a function that is supported only by Netfinity Manager.
Netfinity Director doesn’t have this function. Figure 358 shows how to edit the
System Group. It is possible to use up to eight keywords. Netfinity Manager will
search for the systems that are set up with these keywords.

Figure 358. Netfinity Manager searching for keywords

Netfinity Manager supports a Web browser for local or remote management,
while Netfinity Director does not. Either Microsoft Internet Explorer or Netscape
Communicator can be used to manage the environment. The Web browsers
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provide the same function but in a slightly different layout. With the Web browser
you do not have access to the following functions:

• Advanced System Manager
• Capacity Manager
• Dynamic Connection Manager
• Remote Workstation Control

Figure 359. Netfinity Manager Web browser configuration

Table 12 shows a comparison of which operating systems Netfinity Manager and
Netfinity Director can run. This table shows that Netfinity Director will support
future operating systems and Netfinity Manager may not, but Netfinity Manager
does support all of the current operating systems. This is very important because
Netfinity Manager doesn’t go away with the announcement of Netfinity Director.
Netfinity Manager will still be supported until Netfinity Director has all the
important functions included in Netfinity Manager. You have time to migrate to the
new system management software.

Table 12. Operating Systems for Netfinity Manager and Netfinity Director

Operating systems Netfinity Manager Netfinity Director

Windows 95 yes yes

Windows 98 yes yes

Windows NT 4.0 yes yes

Windows NT 2000 not announced yes

NetWare 4.x yes yes

IntraNetware 5.0 not yet yes

OS/2 Warp 4.0 yes yes
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Table 13 shows the comparison of operating systems support for client services
for Netfinity Manager and Netfinity Director Agent.

Table 13. Operating systems client services and NF Director Agent/UM services

Table 14 shows a summary of functions and services that will be supported by
both system management tools. More information on the meaning of the
functions is explained throughout this book. Most of the details can be found in
Chapter 1, “Netfinity Director functions” on page 1 and Chapter 3, “Core
functions” on page 71. For an explanation about Life Cycle Tools see 4.2, “Life
Cycle Tools” on page 173.

Table 14. Functions/services summary

OS/2 - Aurora not yet yes

Operating systems Client services for
Netfinity Manager

NF Director agent

Windows 95 yes yes

Windows 98 yes yes

Windows NT 4.0 yes yes

Windows NT 2000 not announced yes

NetWare 4.x yes yes

IntraNetware 5.0 yes yes

OS/2 Warp 4.0 yes yes

OS/2 - Aurora not announced yes

Functions/services
summary

Netfinity Manager Netfinity Director

IPC (IPX, TCP/IP, NETBIOS) yes yes

Protocol SNA yes yes

Protocol Serial yes yes

LCCM Clients yes yes

Wake-on-LAN yes yes

Update Connector Manager yes yes

Hardware Inventory yes yes

Software Inventory yes yes

System Monitors yes yes

PFA Monitor yes yes

Remote Workstation Control yes yes

Process Manager yes yes

RAID Manager yes yes

Operating systems Netfinity Manager Netfinity Director
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Table 15 shows the supported Workgroup and Enterprise software. Netfinity
Manager doesn’t support all of the software that Netfinity Director does.
Therefore, you can see that Netfinity Director provides a seamless integration
into the Enterprise software.

Table 15. Workgroup/Enterprise software

6.2 Comparing Netfinity Director tasks to Netfinity Manager tasks

This section explains the advantages of Netfinity Director over Netfinity Manager
and which functions each provides. This comparison was made with Netfinity
Manager Version 5.20.4 and a beta copy of Netfinity Director.

Note: Details on how to use the functions and how to go through the menus is not
explained in detail in this chapter. This chapter shows the differences between

File Transfer yes yes

ECC Support yes yes

Alert Management yes yes

Alert on LAN yes yes

Cluster Manager yes yes

Capacity Manager yes yes

Life Cycle Tools (during UMS) yes yes

Asset Care yes yes

Event Log no yes

EZAdmin yes yes

Web Browser Access yes no

Y2K yes yes

Workgroup/Enterprise software Netfinity Manager UM Services
(Netfinity Director)

Tivoli NetView for NT 5.1 no yes

Tivoli IT Director 2.0 no yes

Tivoli Enterprise Software 3.6 yes yes

SMS 1.2 yes yes

SMS 2.0 no yes

HP OpenView no no

LANDesk Server Manager 2.52 yes yes (MPM)

LANDesk Client Manager 3.x yes no

Novell Managewise no no

Functions/services
summary

Netfinity Manager Netfinity Director
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Netfinity Manager and Netfinity Director. If you need more detailed descriptions of
the functions see Chapter 3, “Core functions” on page 71.

6.2.1 CIM Browser
The Common Information Model (CIM) browser is part of Netfinity Director and it
is installed during the normal installation of Netfinity Director. The CIM layer is
also part of Universal Manageability Services and is installed during the UM
Services installation. For more information about the standards and descriptions
of the management features and capabilities you can access the Web site
http:\\www.dmtf.org. You can start the CIM Browser with the drag and drop
function or with a right mouse click of the system as shown in the following figure:

Figure 360. Netfinity Director CIM Browser

Figure 361 shows the information from the CIM request from Netfinity Director. It
shows the schema root with several classes: CIMV2, Default, IBMPSG, and
Security. For further information about this window and explanations about the
different CMI layers see 1.4.2, “What is CIM and why is it important?” on page 12.
You can also find more information about CIM instrumentation on different
platforms in 3.2.2, “CIM compliant” on page 78.

right mouse
click or use
drag & drop
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Figure 361. Netfinity Director CIM request

Netfinity Manager doesn’t support the CIM technology and doesn’t provide any
CIM information.

Note: The instrumentation provided by UM Services is in the root\cimv2
namespace.

6.2.2 DMI browser
A DMI browser enables you to examine information about the Desktop
Management Interface (DMI)-compliant hardware and software products that are
installed on your system. DMI is an industry standard that simplifies the
management of hardware and software. Netfinity Manager and Netfinity Director
both have a DMI browser included. The browser gets installed during the normal
installation of Netfinity Manager and Netfinity Director. A DMI layer must also be
installed so that the browser can have access to that layer. The layer must be
active to deliver the information to the system. The DMI layer comes from
third-party software and you can get it from the Intel Web site at
http://www.intel.com (search for DMISL.exe). This software is free. A DMI layer is
also included with the UM Services and is installed during this UM Services
installation.

Figure 362 shows the Tasks icon for the DMI task in Netfinity Director and how to
start it.
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Figure 362. Netfinity Director DMI Browser

Figure 363 shows the output of a DMI query. This information can’t be saved in a
file or database. It is just browser information. For more information about the
DMI code and implementation see 1.4.5, “How is DMI used?” on page 33 and for
additional information on the base function see 3.2.3, “DMI compliant” on page
79.

Figure 363. Netfinity Director DMI request

Figure 364 shows the Netfinity Manager DMI Browser icon in the Netfinity
Manager main window.

right mouse
click or use
drag & drop
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Figure 364. Netfinity Manager task icon

Start the DMI browser by double-clicking it. After you have started the icon the
system will prompt you with a window similar to Figure 365. To get more detailed
information, expand the folders. The icons on the menu bar that are circled have
functions such as Register with a service provider, Unregister with a service
provider, Install a new component into the service layer, and uninstall an existing
component. These functions are not supported from a Web browser.

Figure 365. Netfinity Manager DMI browser
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Figure 366 shows you detailed DMI information. The system will not accept any
changes from this window. It is read-only.

Figure 366. Netfinity Manager DMI browser information

6.2.3 Event Action plans
Event management is the most comprehensive task and therefore the most
difficult task to understand. This section shows you the different ways that
Netfinity Director and Netfinity Manager handle alerts. Event management should
let you identify, categorize, and automatically start actions in response to network
events.

In Netfinity Manager, event and alert management consists of two main functions:

1. Maintaining a log of all events that are received and logged by the system
management software.

2. Execute predefined responses or user-specific responses to specified events.

In Netfinity Director, event and alert management consists of three main topics:

1. Event/alert manager configuration - This allows you to configure an action
plan to handle the specific types of events and alerts and respond with specific
actions.

2. Event/alert action plan - This allows you to associate events and alerts with
action plans and manage systems and devices.

3. Event/alert log browser - This allows you to view the events and alerts that are
saved in the log.

The Netfinity Director agent has built-in support for converting CIM events to
Director events from sources such as UM Services and Windows NT, and
forwarding them to the Netfinity Director server. CIM events can be filtered by
selecting the appropriate event from the CIM category in the Event Filter builder.
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Netfinity Director and Netfinity Manager have a different philosophy for event and
alert management. For more information about Netfinity Director’s core functions
see 3.2.9, “Event management and logging” on page 104.

An event in Netfinity Director is an indication that something has occurred. The
event manager of Netfinity Director allows you to build event action plans to try
and resolve them. An event action plan at minimum consists of an event filter and
an event action. An event filter describes a set of characteristics that will seek to
match the conditions of the event to see if some action needs to be taken. For
example, severity and event type are possible event filters and they are used to
select a single event or a group of events. When applied to manage a system or a
group in Netfinity Director, an event filter can be used to control which events can
be viewed in the event log and which events trigger some specific action. Netfinity
Director offers some predefined event filters. It is possible to create and define
new filters, and you can also delete the predefined filters.

Events can be generated by:

• The server itself
• The Netfinity Director tasks
• The native agents
• SNMP agents
• MPM agents
• Using genevent from the command line. Note that unlike genalert, events

generated with genevent must have already been registered with the Netfinity
Director Server using the Netfinity Director SDK before the server will listen for
them.

More details can be found in 6.2.3.1, “Event Action Plan Builder in Netfinity
Director” on page 249 and 6.2.3.3, “Create an Event Action Plan in Netfinity
Director” on page 255. To see more information about log browsers see 6.2.3.5,
“Netfinity Director - Event Log Browser and Alert Log Views” on page 261.

The base service that is at the core of the alerting function in Netfinity Manager is
the Alert Manager. All alerts that are generated by the Netfinity Manager base
service are sent to the Alert Manager. An alert function is an indication that
something has occurred. The Alert Manager matches incoming alerts against one
of its default or user-defined filters and if a match occurs, it carries out the
appropriate action. These filters are called profiles by Netfinity Manager.

Alerts can be generated by:

• The server itself
• The client service for Netfinity Manager
• From the command line using genalert

More details can be found in 6.2.3.1, “Event Action Plan Builder in Netfinity
Director” on page 249 and 6.2.3.3, “Create an Event Action Plan in Netfinity
Director” on page 255. To see more information about log browsers refer to
6.2.3.5, “Netfinity Director - Event Log Browser and Alert Log Views” on page
261.
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6.2.3.1 Event Action Plan Builder in Netfinity Director
The following section describes how to create an action plan and apply the plan
to the system management systems or groups of managed systems. Click the
Event Action Plan Builder pull-down menu as shown in Figure 367.

Figure 367. Netfinity Director Event Action Plans

If you are creating an event filter for the first time, the window that appears
consists of only the predefined event filter supplied with the event management
service as shown in the following figure:

Figure 368. Netfinity Director creates Action Plan Builder
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Right-click the Event Filters folder to see the context menu. Then click Create
New Event Filter.

Figure 369 appears and shows the details for the event type. To expand this
option deselect the Any box. The event type identifies sources of events within
the network. The categories are organized in a tree format and they can contain
several subcategories. You can select these categories to specify filtering criteria.

Figure 369. Netfinity Director Action Plan Builder event types

Figure 370 identifies the priority of the event. Severity is used in action plans that
require low or immediate attention. The different severity levels have the
following meanings as described below:

• Fatal

The application that issued the event has designated a severity level
indicating that the source of the event has already caused the program to fail
and should be resolved before the program is restarted.

• Critical

The application that issued the event has assigned a severity level indicating
that the source of the event may cause program failures and should be
resolved immediately.

• Minor

The application that issued the event has assigned a severity level indicating
that the source of the event should not cause program failure but should be
resolved.

• Warning

The application that issued the event has assigned a severity level indicating
that the source of the event is not necessarily problematic but may warrant
investigation.

• Harmless

The application that issued the event has assigned a severity level indicating
that the event is for information only.

• Unknown
250 Netfinity Director - Integration and Tools



The application that created that event did not assign a severity level.

Figure 370. Netfinity Director Action Plan Builder event severity

Select the severity level as needed by clicking the empty boxes. In Figure 371
you can select a specific day and time that the filter will be in effect.

Figure 371. Netfinity Director Action Plan Builder date and time

Select the time schedule or check Any to mark all the times. In Figure 372 you
can specify the resolution status of an event as one of the filter criteria. The
status can be:

• Alert -Indicates the problem.

• Resolution - Indicates that the problem has been resolved and is no longer an
outstanding problem.
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Figure 372. Netfinity Director Action Plan Builder category

Mark your input by checking Any. Figure 373 shows the Sender Name. It
identifies the source from which the event was forwarded.

Figure 373. Netfinity Director Action Plan Builder Event Sender Name

Select your input and click Add. Figure 374 shows the Extended Attributes. It
enables you to further qualify the filter criteria using additional keywords and
values that can be associated with some categories of events.
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Figure 374. Netfinity Director Action Plan Builder Event Sender extended attributes

Select the keywords and values on which you want to filter. If no keywords are
listed, that means that the Netfinity Director server has not been made aware of
the selected event category. Save your input. Select File -> Save as and insert a
unique name for the configuration.

Figure 375 shows the Event Log Task with the newly added folder you just
created.

Figure 375. Netfinity Director Action Plan Builder added event

6.2.3.2 Netfinity Manager alerts
The Alert Manager is an extendable facility that allows the receiving and
processing of application-generated alerts. These alerts can be a result of
informational warnings or error messages from hardware or software sources.

Figure 376 shows the Netfinity Manager Alert Log.

Select File ->
Save as to save
the input
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You can define a profile (filter) that specifies that when an alert is generated,
there is an action that will be performed only if some prerequisite condition is met.

Figure 376. Netfinity Manager alert

To define an action from an alert by using a profile, first click Profiles.

Figure 377 will pop up. This window shows all of the currently defined profiles.
Within this window you can change a current profile, or you can create or delete a
profile.

Figure 377. Netfinity Manager works with profiles

In this example we used the existing profile File Created Alerts. Select this by
clicking it and click Edit to change the profile.

Figure 378 appears and you can make you changes to the profile. The fields
within the profile are:
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• Alert Type

This is the type of alert that is generated by Netfinity Manager. All alerts that
Netfinity Manager handles will have a type.

• Severity

Severities have a range from 0 to 7 where 0 is the highest priority. The severity
is set by the administrator when he or she sets up the thresholds.

• Application ID

This is a case sensitive alphanumeric identifier that identifies the application
source for the alert. Each application should provide a unique ID.

• Application Alert Type

This is probably the most important value you need to consider. It is the type
of problem that the application has, and it is assigned by the application that
generated the alert.

• Sender ID

This is the network address of the system that generated the alert. It is
possible to add one or more Sender IDs in this field.

Figure 378. Netfinity Manager Profile Editor

Select your values and save the profile with your changes.

6.2.3.3 Create an Event Action Plan in Netfinity Director
To create an action plan in Netfinity Director you first have to customize the Event
Actions. This can be done from the Event Action Plan Builder window that is
shown in Figure 379.

Right-click into a free space in the Event Actions column to get a list of options.
Select Create New Event Action Plan and type in a name for it and press Enter.
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After you have done this, the name should appear in the Event Action Plan list.
For our example, we used the name Admin Action Plan.

After you have done this you also have to create the actions. Right-click to get a
list of the actions you want to customize. In our example we selected the action
Add message to the Console Ticker Tape. Save the configuration by clicking
File -> Save As and type in a name. After that is done, the newly created file
name appears in the Actions column. In our case we created a file called Admin
msg.

Figure 379. Netfinity Director Event Actions

Select an event filter and drag it into the Event Action Plans pane on top of the
action plan you want it to be associated with. The Event Filters folder will now
appear under this column. You can see the result in Figure 380.
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Figure 380. Netfinity Director Event Plan creation

If you want to add more than one event filter or action to Event Action Plans
repeat the above steps. After you have defined the Event Action Plans, click File
and Save to save the data.

Note: An Event Action Plan is inactive until you apply it to specific managed
systems or groups.

Use the following procedure to activate the event action plan for a system.
Double-click Event Action Plans in the Tasks pane of the Netfinity Director
console main window shown in Figure 367 on page 249. Figure 381 should
appear and show you that the plan’s icon was added under the group that you
had selected.

Figure 381. Netfinity Director Event Action Tasks applied

new entry
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Select the desired plan in the Event Action Plans and drag it onto a system or a
group. The desired event action plan will appear there also. After you have made
your selection you can close the window with File -> Close.

Note: An event action plan is inactive until you apply it to specific managed
systems.

If any of the specific events for the selected systems occur, they will be sent to
the Netfinity Director server.

Figure 382 shows two types of error messages that were created from our
example. One message shows up as a ticker tape display at the bottom of the
console and the other shows up in the Message Browser interface. You can start
the browser from the console by clicking Tasks -> Message Browser.

Figure 382. Netfinity Director alert messages

Alerts can also be generated by using the command line interface. Type in
genevent at the command prompt to access the Help menu.

6.2.3.4 Customizing Events in Netfinity Manager
Click the Action button from the Alert Log window as shown in Figure 383 to get
the Alert Actions window.
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Figure 383. Netfinity Manager alert actions

The Alert Actions window in Figure 384 shows you several different actions. You
can edit existing actions, create new ones,or delete existing actions.

The action Forward to MPM service is listed here since Netfinity Director was
installed on the same system as the Netfinity Manager. Netfinity Director installs
the MPM API service during its installation process. The reason for this is that
Netfinity Director can handle some of the Netfinity Manager alerts through the
MPM API service.

Figure 384. Netfinity Manager alert window

In this case we selected an existing Alert Action (Forward to MPM service) and
clicked Edit.

Figure 385 shows you all the options that were selected. You can edit the Alert
Type, Severity, Application ID, Application Alert Type, and Sender ID fields. The
descriptions for these profiles are shown in Figure 378 on page 255. You can also
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select the action to forward this alert to an MPM service through the network or
for it to cause a pop-up window on a user’s display.

Figure 385. Netfinity Manager alert configuration

Select your changes and save the configuration.

Alerts can also generated by using the command line interface. Type genalert at
the command prompt to access the Help menu as shown below:

GENALERT /T:"text" < /APP:id_name > < /PRI:<0..7> > </TYPE:sssttt> </ATYPE:hexnum >,

where:

/T:"text" Defines the text message describing the alert

/APP:id_name Defines the application ID for the alert (1-8 characters)

/SEV:<0..7> Defines the severity of the alert (0 = max, 7=min)

/TYPE:sssttt Defines the standard type of alert. The sss field describes the
ID of the alert:

UNK Unknown
SYS System
DSK Disk or DASD
NET Network
OS_ Operating System
APP Application
DEV Device
SEC Security

The ttt field describes the class of the alert:

UNK Unknown
FLT Fault or Failure
ERR Error
WRN Warning
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INF Information

/ATYPE:hexnum Defines the application-specific alert type as a hexadecimal
value between 0000 and FFFF.

6.2.3.5 Netfinity Director - Event Log Browser and Alert Log Views
The event log lets you view the events that have been received and processed by
the Netfinity Director server. You can start the event log from the console window
as you see in Figure 367 on page 249. Drag the Event Log icon onto the system
or system group to start the event error log as you see in Figure 386. The left
pane of the window shows all of the event filter information such as Event Type,
Severity, Date, Time, Category and Sender Name. In addition, the system
identification is also listed in the window. The right pane shows the Event Details.
This pane lists the events that have been received during the period shown in the
caption. The default is 24 hours.

Figure 386. Netfinity Director Event Log

Select any event to see its event details. For each event log entry you can create
separate definitions. Figure 387 shows the context menu that appears when you
right mouse click. As the event log grows in size, or if you want to track only
specific events, you can set it up so that the view only shows entries that match
your filter.
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Figure 387. Netfinity Director event detail information

Select the event with a right mouse click as shown in the above figure and
perform your changes.

Figure 388 shows the alert that came from the Netfinity Manager system. The
Netfinity Director can manage the MPM API service in the Netfinity Manager
systems. For more information refer to 6.1, “Running Netfinity Director and
Netfinity Manager together” on page 235.

Figure 388. Netfinity Director MPM API
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6.2.3.6 Netfinity Manager Alert Log
As the alert log grows in size, or you want to track specific alerts, you may choose
to view only the specific alerts that you want to see in the Alert Log Views
window. To do that, click the Alert Manager icon in the Netfinity Manager main
window and select Alert Log Views as shown in Figure 389:

Figure 389. Netfinity Manager Alert Log

To enable View By Time and Date click the Enable check box in Figure 390. You
can now define your changes for the time and date ranges.

To enable View By Profiles click the Enable check box in the View By Profiles
group. Select the profiles that interest you in the Active Profiles list box by
selecting the <- Activate or Deactivate -> button. Click Refresh to save your
input.
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Figure 390. Netfinity Manager Alert Log Views

6.2.4 File Transfer
This section describes the difference between the Netfinity Director and Netfinity
Manager file transfer task.

Figure 391 shows you how to start a file transfer operation to another system
within the network by using Netfinity Director’s file transfer function.

Figure 391. Netfinity Director file transfer task

You can use drag and drop to move the file transfer task to the desired system or
right mouse click the system folder.

After the drag and drop has completed, the file transfer function shown in Figure
392 will appear and show the disk accesses for both systems. By clicking the field
where the target server name is shown you can change the target system to
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another system. By clicking the folder Other, the system offers more target
systems. All systems within the environment are listed in this folder.

If you click the right mouse button on a directory folder you get a context menu
with some additional options.

Netfinity Director implements the file transfer function with a Java GUI.

.

Figure 392. Netfinity Director file transfer function

Figure 393 shows the way to start a file transfer when you use Netfinity Manager.
This function is not supported as a group function on Netfinity Manager, but it is
on Netfinity Director. The first step is to start the Remote System Manager and
then select System Group Management where your systems are listed. Within
this Group you can select only one of the systems at the same time. For access
to each system a security logon window appears and requires your input. If you
wanted to write a script you could use the Netfinity Manager command line
interface, but it would be a tedious task.

change target
system
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Figure 393. Netfinity Manager access to a remote system

After you log in the menu for the remote system appears and you can click the
File Transfer icon. The resulting window is shown in Figure 394. It shows the
source and the target system. The target system can’t be changed with Netfinity
Manager, but when you use the same function with Netfinity Director you can
make a change. You can perform the file transfer by using some function keys
that are shown below:

Figure 394. Netfinity Manager File Transfer
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Netfinity Manager doesn’t support the Java GUI and can’t use the drag and drop
function either. Therefore, you need many more steps to perform a file transfer
when you use Netfinity Manager.

6.2.5 Inventory
This section describes the advantage of the Netfinity Director Task Inventory
versus the Netfinity Manager Task System Information function. Descriptions for
the base functions of this task can be found in 3.2.1, “Inventory management” on
page 75.

We show you how to get inventory information from both system management
tools. By using Netfinity Director you get more functions than you get with
Netfinity Manager. These functions are listed below and will be shown in this
example:

• Group operations

• Create your own queries

• Store query as an HTML format

Figure 395 shows how to start the Inventory task:

Figure 395. Inventory task in Netfinity Director

Netfinity Director provides the ability to select queries by systems or by groups.
To start a query select a system from the column Group Contents or from the
column Groups in the Netfinity console main menu. To start the request for the
group of all Windows NT systems we selected Systems with Windows NT.

To show the advantage of the group operation we ran a simple inventory task.
This request gets hardware, software, and BIOS information. Figure 396 shows
the summary for all of the Windows NT systems. Now you can select the systems
by holding down the Shift button and clicking the left mouse button.

Select a
Group

Right mouse
click for context
menu
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Figure 396. Query group selection

Select the systems that you want to use. Right-click and select View Inventory to
start the query.

In Figure 397 all the detailed information for all of the selected systems is listed.
In our case the information is shown for two systems. In the left column the
systems are listed by system name. The other columns list the information that
we had selected in the query.

Figure 397. Query listed by groups

Figure 398 shows a picture of the Netfinity Manager GUI. We selected a group
with dedicated systems, which are shown below. We see the systems, but it is not
possible to summarize these systems to start a query. Each system has to be
selected separately for each query.

Figure 398. Netfinity Manager group

Select a system and start it by double-clicking the mouse.

select the
systems
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The system shows the task menu. You can select the icon System Information,
which has almost the same information as Netfinity Director. Netfinity Manager
can’t change any of the fields in the query. That means that if System Information
is started, it always provides the same types of information. For example, Adapter
Information, BIOS Information, and Disk Information. You can’t preselect specific
data fields if you only want to view a few of them. See Figure 399. Netfinity
Director allows you to customize your queries with the Build Customer Query.
Figure 400 shows a procedure that you can use to create your own query.

Figure 399. Netfinity Manager system information

Figure 400 is the Netfinity Director menu, which shows you how to build your own
query. It allows you to select each of the Available Criteria functions separately
and you can break it down further by selecting the functions on the submenus.
This means that you can define very specific queries to give you the information
you want and nothing more.

Figure 400. Build your own query on Netfinity Director

Select the Customer folder and right mouse click Select Build Customer Query.
Select the items to build your own query and click Add. You can repeat this step

right mouse
click

select
functions

shows the
added
functions
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until you have included all of the functions that you want. Select File -> Save as
and enter a title.

Figure 401 and Figure 402 show the formats and databases where you can store
the output from the queries. Netfinity Director lets you save the query output in
spreadsheet (CSV) format or in HTML format so that you can access the
information with a standard Web browser. That provides you with the opportunity
to access this data from anywhere with a Web browser without requiring any
special software.

Figure 401. Store query by Netfinity Director

Netfinity Manager stores the collected information in three file formats as shown
in Figure 402. HTML format is not an option, so you can’t view the data from a
Web browser.

.

Figure 402. Store query by Netfinity Manager

6.2.6 Microsoft Cluster Browser
Netfinity Manager supports the Cluster Management service and it is startable
from an icon as shown in Figure 403. That icon is available in the Netfinity
Manager main window only when the MSCS (Microsoft Cluster Server)
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Administrator is installed on your system. It includes the MSCS notes and any
remote cluster administrator consoles that are configured.

Figure 403. Netfinity Manager Cluster Manager

Double-click it to start the Netfinity Cluster service. In Netfinity Director the
Cluster Manager is divided into two tasks:

1. Cluster systems management

2. Software rejuvenation

These functions and services are included in the server Life Cycle Tools and are
explained in 4.2.3, “Cluster Manager” on page 181.

6.2.7 Process management
A key feature of Netfinity Director and Netfinity Manager is the ability to manage
individual processes on remote systems. The Process Management (Netfinity
Director) or Process Manager (Netfinity Manager) function allows the
administrator to view and manipulate all applications and processes. The system
administrator will be able to set monitors for a specific process or application so
that if an application or process terminates, an event (alert) will be generated.
That means if a process stops or starts, you can configure the process
management or process manager to send an alert. Based on the contents of the
alert you can run a script that can do anything from restarting the application to
notifying the help desk. This section shows the difference between process
management in Netfinity Director and process manager in Netfinity Manager. For
base information on this topic see 3.2.9, “Event management and logging” on
page 104.

6.2.7.1 Netfinity Director
Figure 404 shows the process management window on a Windows NT system.
One way to start the process management is to drag the process management
icon from the right Task pane on top of the system that you want to manage. This
procedure is shown in Figure 146 on page 96. This window provides information
about the Name of the task, Process ID, User, Thread count, Priority, Monitored
and Memory usage. A detailed description of these fields can be found in Table 4
on page 98.
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Figure 404. Netfinity Director Process Management

From this window you can take different actions. It allows you to start applications
from the menu task bar. Click Actions and you get a window where you can type
in your input, as shown in Figure 405. In our example, we wanted to start the
application clock. After starting this application it appeared in the monitor window
as shown in Figure 404.

To monitor this application right mouse click the task that is shown in Figure 404.
The context menu that appears offers you the choice to close this running
application or to add this to your monitor list for further management. Select Add
To Monitors. Click Monitors from the menu task bar and select Process
Monitor. A window should appear that shows you all the tasks that are selected
to monitor.

Figure 405. Netfinity Director Execute Command

Type in the application that you want to start. In this window you can select when
the task should create an event. This can be each time that the task is started,
stopped, or fails.
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Figure 406. Netfinity Director Process Monitors

Select when the event should be sent and click the boxes that reflect the
condition you wish to monitor. Then save the configuration information by clicking
File -> Save.

The event log shows all the events that are monitored. In this case, we see the
clock event (after the application has started, stopped or fails at least one time).
Figure 407 shows this flow:

Figure 407. Netfinity Manager event log inclusive monitor

There are additional choices you can make from this window. You can create a
filter, delete the event, and more. Use the right mouse button to see all the
options.

6.2.7.2 Netfinity Manager
Double-click the Process Manager icon in the Netfinity Manager main window to
start the process manager. Figure 409 on page 274 shows the process manager
window that provides information about the Program Name, Process ID, User ID,
Num. Threads, and Priority.

From this window you can also take actions that are similar to the ones that
Netfinity Director can take. It allows you to start, close, and monitor applications
from this window as you can see in Figure 409 on page 274.
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Figure 408. Netfinity Manager Process Manager

To start new tasks from this window, select Process -> Run command. A window
pops up and you can type in the task or application that you want to start. To
close a task, right mouse click the task and select Close Application.

To monitor the task, click Add Process Alert in the context menu. The system
prompts you with a window similar to the following:

Figure 409. Netfinity Manager add process alert
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In the Add Process Alert window select the severity of the alert and indicate when
it should occur. Then click OK. The task is now configured to send an alert.

To get an overview of the alerts that are being monitored, click Process ->
Process Alerts. The system will prompt you with a window that is similar to
Figure 410. From this window you can change any configuration or start one with
a double-click of the task.

Figure 410. Netfinity Manager Process Manager

6.2.8 Remote control
Both Netfinity Director and Netfinity Manager support remote control. There are
no big differences between the way they support it. Netfinity Director has an easy
way to start it by using drag and drop and Netfinity Manager requires you to click
through several icons to access the remote system. Start the Remote System
Manager then select a System Group Management icon where your systems are
included. Within that group you can select one of the systems (double-click) and
you have to perform a logon to access the system. More information about the
base functions can be found in 3.2.6, “Remote control” on page 87.
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Figure 411. Netfinity Director Remote Control

Both System Management tools have the same security function. They both
require user authorization for window access. The remote windows of both are
nearly identical and the functions on the action menu bar at the top of the Remote
Control window are also similar. The only difference is that the Netfinity Director
window has a Tab key and Function keys 1-12 on the bottom of the Remote
Control window. The Tab key and Function keys can’t be passed through a data
stream to the remote system from your keyboard, so they are displayed in the
Remote Control window. During an active session you can click these keys to
perform the same functions as pressing the keys on the keyboard. The Function
keys are shown in Figure 412:

Figure 412. Netfinity Director Remote Control task bar

To change the status (Active or Monitor), select Session -> Active (or Monitor)
from the top of the Remote Control window.

6.2.9 Resource Monitors
This section describes the differences for the resource monitoring service in
Netfinity Director and Netfinity Manager. The Netfinity Director resource
monitoring task allows you to monitor the Netfinity Director agents and the

Drag and
Drop
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systems with UM Services installed. Netfinity Manager monitors the Netfinity
Manager and Netfinity Services systems. For more information see 3.2.4,
“Resource monitoring” on page 80.

The following topics show where the differences are:

• Adding attributes to manage a system or a system group

• Setting monitor thresholds

• Adding the ticker

Figure 413 shows how to start the Resource Monitor Task to add attributes with
Netfinity Director:

Figure 413. Netfinity Director Resource Monitors

Perform a right mouse click for the system or system group to see the systems
that are to be managed. In our case we selected the folder All Systems and
Devices to show that Netfinity Director can handle the group function for this
task. Netfinity Manager does not support the group function. In Netfinity Director,
a context menu appears after you right mouse click. Select Resource Monitors.
You can also use the drag and drop function to start this function. If you select All
Available Recordings, you get a listing of all recordings that are currently defined
for any of the known managed systems or groups. Using the folder All Available
Thresholds enables you to view a list of all thresholds that are currently defined
for any of the known managed systems or groups.

The right pane in Figure 414 displays the selected systems on the top row of the
window. In that pane, the left-most column shows the corresponding attributes.
You can use the drag and drop function to add attributes. When you add an
attribute the system starts to collect monitor data. In our example, we collected
data for Disk, Memory, CPU Utilization, and Process Count as shown in Figure
414 on page 278.
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Figure 414. Netfinity Director Resource selection

The column Selected Resources shows the monitored attributes and the status of
the selected systems whether they are online or offline.

To remove the attributes, place the cursor on the selected resources and
right-click. Click Remove the attribute.

Figure 415 shows how to save the threshold.

Figure 415. Netfinity Director save threshold

Select File -> Save As and a window appears where you can input a name. Type
the name in this field and press Enter.

The newly created threshold is stored and then it becomes visible within the
Tasks column as shown in Figure 416:

right
mouse click

status online
or offline

collected data
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Figure 416. Netfinity Director stores attribute

Figure 417 shows the Netfinity Manager window and how the System Monitor can
be started. Double-click the icon System Monitor. Two new windows appear: the
System Monitor Service window and the CPU Utilization window. From the
service window you can determine which monitors will be displayed on the
desktop.

Figure 417. Netfinity Manager System Monitor

Select Windows from the tool bar of the System Monitor Service window. It offers
you a menu to choose the attributes that can be monitored, as shown in the
following figure:
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Figure 418. Netfinity Manager Monitors

Select your attributes and click Accept to include this change. Netfinity Manager
offers several choices for storing the collected data. It stores the data in a file the
same way that Netfinity Director does. It can also store the data in an ODBC
database, which Netfinity Director can’t. Figure 419 shows how to store the data:

Figure 419. System Management monitoring information into a database

Select System Monitor Service -> Windows -> Export to database. Select the
option to store it in a file or ODBC and click OK.

6.2.9.1 Setting monitor thresholds
The Resource monitor provides a convenient method of monitoring the activities
for a number of components in a system. This includes disk state, memory state,
or processor information. By using the Resource Monitor Threshold function you
can set threshold levels for any of the monitored components. A threshold can be

Select
Window ->
Database
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set for a single system or a complete system group. After you have assigned a
threshold, an event is triggered if the threshold is met for the system(s). Netfinity
Director and Netfinity Manager support the threshold function. In addition,
Netfinity Director can support this function for a system group.

6.2.9.2 Setting monitor threshold by Netfinity Director
Figure 420 shows how to start the threshold setting in Netfinity Director:

Figure 420. Netfinity Director threshold

Select the attribute and click the right mouse button. Select Individual
Threshold and the Threshold setting will appear.

Figure 421 appears and requires some input. The following items are needed to
create the threshold.

• Name

A name to identify this threshold in the network.

• Enabled to generate events

Selecting this box activates the threshold.

• Generate events on value changes

Select this to generate an event when the value of the tracked attribute
changes.

• Maximum queued events

Specify the number of events for this threshold to be held for the server when
the server is temporarily unavailable.

• Minimum Duration

This specifies the length of time that the threshold must be exceeded before
an alert is generated.

• Resend Delay

This specifies the length of time that the system monitors the attribute before
resending an alert.

• Above Or Equal

Right mouse click
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High Warning - Generates a critical event if the resource value is equal or
greater than the value specified in this field.

Low Warning - Generates a warning event if the resource value is equal or
greater than the value specified in this field.

• Below Or Equal - Similar in concept to the Above Or Equal field but uses the
values below or equal.

Figure 421. Netfinity Director threshold settings

Click OK to save the settings.

6.2.9.3 Setting monitor threshold by Netfinity Manager
Figure 422 shows how to start the threshold setting in Netfinity Manager:
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Figure 422. Netfinity Manager start set Threshold

Double-click the System Monitor icon (shown in Figure 417 on page 279), then
click Start System Monitors -> Show Monitors and the preselected monitors
appear. Select the monitors that you want to access. Double-click or use the
context menu to open the threshold settings.

Figure 423 on page 284 requires some input. The following entries are needed to
create the threshold:

• Threshold Name

A name to identify this threshold during the network

Note: When using Windows NT, press Enter in the threshold box to cause the
Create button to become active.

• Duration

This specifies the length of time that the threshold must exceed before an alert
is generated.

• Resend Delay

This specifies the length of time that the system monitors the attribute before
resending an alert.

• Values

You can set up to four different values, each of which will generate a different
Netfinity alert.

• Severity

The severity can help decide what action should be taken.
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Figure 423. Netfinity Manager sets threshold configure page

Click Create to proceed.

6.2.9.4 Adding the ticker
The scrolling ticker tape provides a constant, dynamically updated display of
important and critical information. Information is scrolled across the bottom of the
Netfinity Director console. Figure 424 shows the ticker display and how to
activate the ticker for Netfinity Director. Netfinity Manager doesn’t support this
function.

Figure 424. Netfinity Director console ticker

Place the mouse on a folder in the Available Resources pane and click the right
mouse button. Select Add to Selected Resources Table from the context menu.
The ticker starts to run and provides the selected information.

6.2.9.5 Removing the ticker
Figure 425 shows how to remove the ticker from the Netfinity Director console:
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Figure 425. Netfinity Director ticker removal

Place the mouse courser on the ticker display. Click the right mouse button to get
the context menu. Select either Remove All Monitors or Remove Monitor to
remove the systems separately. If all systems are removed the ticker display will
stop running.

6.2.10 Software distribution
The software distribution task icon is located in the task menu. This feature is not
supported by Netfinity Director. Software distribution is supported by Tivoli IT
Director, which means that the software distribution task icon is visible but not
functioning. It can be activated if you have a Tivoli license key. Netfinity Director
allows you to perform an upgrade to a full IT Director version. The upgrade
installation procedure is very easy and doesn’t take long. Figure 426 shows the
window main menu from which you can start to install the license key upgrade:
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Figure 426. Netfinity Director license key upgrade

Select Options -> License Administration. Figure 427 shows all license keys
that are installed:

Figure 427. Netfinity Director license keys installed

Click License -> Add License Key to get the window to insert the license key.
Figure 428 shows the window to upgrade the license key.
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Figure 428. Netfinity Director license key upgrade

Type in the license key and start the system management software again to get
access to the full IT Director version.

6.3 Accessing older UMA clients

The Universal Management Agent (UMA) is available for free installation on
licensed IBM systems only. The base UMA module must be installed on each
client to be managed. This module is installed using either the UMA typical or
custom installation option. UMA can also be installed remotely from Tivoli. See
the redbook Universal Management Agent: Functions and Integration,
SG24-5294 for more details.

The Universal Management Agent is not supported by Netfinity Director. Netfinity
Director doesn’t show systems with UMA or Universal Management Agent Plus
installed.
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Appendix A. Netfinity Director tables

This appendix shows the column names and column types of the tables created
by Netfinity Director in the DBMS.

Because IBM DB2 V5 has some limitations on the length of DB table names and
column names, the information that is displayed in bold is specific to Microsoft
SQL. All other information is common to IBM DB2 and Microsoft SQL Server 7.0.
A table comparing the actual DB table names and Netfinity Director standard
queries can be found in Table 9 on page 214.

A.1 Windows NT cluster information

Description: General information about the cluster.

IBM DB2 table name: MSCS_CLUS_INFO

MS-SQL table name: MSCS_CLUS_INFO

Table 16. DB table: Windows NT cluster information

A.2 Windows NT cluster group-resource map

Description: Describes which resources belong to which groups.

IBM DB2 table name: MSCS_GROUP_RES

MS-SQL table name: MSCS_GROUP_RES

Table 17. IDB table: Windows NT cluster group-resource map

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique cluster ID

MSCS_NAME Char(64) Cluster name

MSCS_MAJ_VER Integer Major version number

MSCS_MIN_VER Integer Minor version number

MSCS_BUILD Integer Cluster build number

MSCS_VENDOR Char(64) Cluster vendor

MSCS_CSD Char(64) Cluster CSD

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique cluster ID

MSCS_GRP_NAME Char(64) not
null

Group name

MSCS_RES_NAME Char(64) not
null

Resource name
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A.3 Windows NT cluster groups

Description: Tells which groups are currently owned by which node.

IBM DB2 table name: MSCS_GROUPS

MS-SQL table name: MSCS_GROUPS

Table 18. DB table: Windows NT cluster groups

A.4 Windows NT cluster network interfaces

Description: This is information about the network interfaces.

IBM DB2 table name: MSCS_NET_INT

MS-SQL table name: MSCS_NET_INT

Table 19. DB table: Windows NT cluster network interfaces

A.5 Windows NT cluster resources

Description: This is information about the cluster resources.

IBM DB2 table name: MSCS_RESOURCES

MS-SQL table name: MSCS_RESOURCES

Table 20. DB table: Windows NT cluster resources

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique cluster ID

MSCS_GRP_NAME Char(64) not
null

Group name

MSCS_GRP_NODE Char(64) Current owner node

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique cluster ID

MSCS_NET_NAME Char(64) not
null

Network name

MSCS_NETINT_NAME Char(64) not
null

Network interface name

MSCS_NODE_NAME Char(64) Node name

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique cluster ID

MSCS_RES_TYPE Char(64) not
null

Resource type

MSCS_RES_NAME Char(64) not
null

Resource name

MSCS_RES_DEP_NET Char(64) Resource dependent network
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A.6 Cluster membership

Description: Describes the relationship between system IDs and cluster IDs, and
which systems belong in which clusters.

IBM DB2 table name: TWG_CLUS_MEMBERSH

MS-SQL table name: TWG_CLUS_MEMBERSHIP

Table 21. DB table: cluster membership

A.7 Cluster members

Description: Here is information about the member name and type of cluster
nodes.

IBM DB2 table name: TWG_CLUSTER_MEMBE

MS-SQL table name: TWG_CLUSTER_MEMBERS

Table 22. DB table: cluster members

A.8 Component ID

This is information on the system, one entry per managed_obj_id. See also A.27,
“Physical enclosure” on page 300.

IBM DB2 table name: TWG_COMPONENT_ID

MSCS_RES_CUR_OWN Char(64) Current owner group

MSCS_RES_NODE Char(64) Current owner node

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

CLUSTER_OBJ_ID Integer not null Identifies unique cluster ID

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique cluster ID

CLUS_MEMBER_NAME Char(64) not
null

Cluster member name

CLUS_MEMBER_TYPE Char(16) not
null

Cluster member type

MEM_MANAGED_OBJ_ID
MEMBER_MANAGED_O
BJ_ID

Integer Identifies unique system ID

Column name Type Description
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MS-SQL table name: TWG_COMPONENT_ID

Table 23. DB table: component ID

A.9 Disk

This is information about all physical disks in the system, one entry per physical
unit. See also A.17, “Logical drive” on page 295 and A.25, “Partition” on page
299.

IBM DB2 table name: TWG_DISK

MS-SQL table name: TWG_DISK

Table 24. DB table: disk

A.10 IDE adapter

This is information on the IDE adapter subsystem, one entry per adapter.

IBM DB2 table name: TWG_IDE_ADAPTER

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

MANUFACTURER Char(40) Manufacturer

PRODUCT Char(40) System product number

VERSION Char(40) System version number

SERIAL_NUMBER Char(40) System serial number

UUID Char(40) Universal Unique Identifier

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

DISK_TYPE Char(32) not
null

Disk type, for example: CDROM,
FLOPPY, HARDDISK

DISK_INDEX Integer not null Index number

DISK_MEDIA_LOADED Char(10) Is a media inserted? Example: TRUE,
FALSE

DISK_REMOV_MEDIA
DISK_REMOVABLE_MEDI
A

Char(10) Is media removable? Example: TRUE,
FALSE

DISK_CYLINDERS Integer Number of cylinders

DISK_SECTOR_PR_TRK
DISK_SECTORS_PER_T
RACK

Integer Numbers of sectors per track

DISK_TOTAL_SIZE_KB Integer Capacity in KB

DISK_HEADS Integer Number of heads on disk
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MS-SQL table name: TWG_IDE_ADAPTER

Table 25. DB table: IDE adapter

A.11 IDE device

This is information about IDE devices, one entry per device per adapter.

IBM DB2 table name: TWG_IDE_DEVICE

MS-SQL table name: TWG_IDE_DEVICE

Table 26. DB table: IDE device

A.12 Installed memory

This is information on installed memory, one entry per managed_obj_id. See also
A.18, “Logical memory” on page 296 and A.19, “Memory modules” on page 296.

IBM DB2 table name: TWG_INSTALLED_MEM

MS-SQL table name: TWG_INSTALLED_MEMORY

Table 27. DB table: installed memory

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

IDE_INDEX Integer not null Index number

IDE_BUS_TYPE Char(32) Bus type

IDE_LOCATION Char(32) Location, for example: PLANAR

DEVICES_CONNECTED Integer Number of devices connected

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

IDE_ADAPTER_INDEX Integer not null Index number

IDE_DEVICE_INDEX Integer not null Index number

DEVICE_SIZE Integer Device size in kilobytes

DEVICE_TYPE Char(32) Device type, for example: CDROM

UNIT_STATUS Char(32) Unit status, for example: READY

MEDIA_STATUS Char(32) Media status, for example: PRESENT,
NOT_PRESENT

PRODUCT_ID Char(40) Product ID/description

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

PHYSICAL_MEMORY_KB Integer Total physical memory in kilobytes
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A.13 IP address

IP address information, one entry per adapter.

IBM DB2 table name: TWG_IP_ADDRESS

MS-SQL table name: TWG_IP_ADDRESS

Table 28. DB table: IP address

A.14 IPX address

IPX address information, one entry per adapter.

IBM DB2 table name: TWG_IPX_ADDRESS

MS-SQL table name: TWG_IPX_ADDRESS

Table 29. DB table: IPX address

A.15 Keyboard

Keyboard information, one entry per managed_obj_id.

IBM DB2 table name: TWG_KEYBOARD

FREE_VIRT_MEM_KB
FREE_VIRTUAL_MEMOR
Y_KB

Integer Free virtual memory in kilobytes

PAGE_SIZE Integer Page size in bytes

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

IP_INDEX Integer not null Index number

IP_ADDRESS Char(16) IP address, for example: 9.24.15.234

IP_HOSTNAME Char(254) Hostname

IP_DOMAIN Char(254) Domain

SUBNET_MASK Char(16) Subnet mask, for example: 255.255.0.0

NAMESERVER1 Char(16) Name server 1

NAMESERVER2 Char(16) Name server 2

DEFAULT_GATEWAY Char(16) Default gateway

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

IPX_INDEX Integer not null Index number

IPX_ADDRESS Char(32)

Column name Type Description
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MS-SQL table name: TWG_KEYBOARD

Table 30. DB table: keyboard

A.16 LAN network ID

Network information, one entry per managed_obj_id.

IBM DB2 table name: TWG_WINDOW_NET_ID

MS-SQL table name: TWG_WINDOWS_NETWORK_ID

Table 31. DB table: LAN network ID

A.17 Logical drive

This is information on logical drives, one entry per logical drive. See also A.9,
“Disk” on page 292 and A.25, “Partition” on page 299.

IBM DB2 table name: TWG_LOGICAL_DRIVE

MS-SQL table name: TWG_LOGICAL_DRIVE

Table 32. DB table: logical drive

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

KEYBOARD_TYPE Char(80) Type of keyboard, for example: 101KEY

CODEPAGE Integer Code page, for example: 437

TYPEMATIC_RATE Integer Characters per second

TYPEMATIC_DELA
TYPEMATIC_DELAY

Integer Repeat delay in milliseconds

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

COMPUTER_NAME Char(16) NetBIOS network address

USERNAME Char(16) Logged on username

DOMAIN Char(16) Domain

WORKGROUP Char(16) Workgroup

REG_OWNER Char(80) Registered owner

REG_ORGANIZATION Char(80) Registered organization

REG_PRODUCT_ID Char(40) Registered product ID

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

DRIVE_INDEX Integer not null Index number

DRIVE_TYPE Char(20) FLOPPY, FIXED, CDROM, REMOTE
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A.18 Logical memory

This is information about logical system memory, one entry per managed_obj_id.
See also A.12, “Installed memory” on page 293 and A.19, “Memory modules” on
page 296.

IBM DB2 table name: TWG_LOGICAL_MEMOR

MS-SQL table name: TWG_LOGICAL_MEMORY

Table 33. DB table: logical memory

A.19 Memory modules

This is information on installed memory modules, one entry per installed memory
module. See also A.12, “Installed memory” on page 293 and A.18, “Logical
memory” on page 296.

IBM DB2 table name: TWG_MEM_MODULE

MS-SQL table name: TWG_MEM_MODULE

Table 34. DB table: memory modules

DRIVE_NAME Char(64) Drive ID, for example: A:, C:, SYS

DRIVE_PATH Char(254) LAN-share name, for example:
\\server\share. NULL for local drives

DRIVE_TOT_SIZE_KB
DRIVE_TOTAL_SIZE_KB

Integer Total size of drive in kilobyte

DRIVE_FREE_SIZE_KB Integer Free size of drive in kilobytes

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

BASE_MEMORY_KB Integer Base memory in kilobyte

EXTENDED_MEMORY_KB Integer Extended memory in kilobytes

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

MODULE_INDEX Integer not null Index number

SOCKET_NAME Char(32) Socket name, for example: DIMM 0

BANK_NAME Char(32) Memory bank Name

MODULE_SIZE Double Size of memory module in megabytes

MODULE_SPEED Double Memory speed in nanoseconds

FULL_BIT_WIDTH Integer Full bit width

DATA_BIT_WIDTH Integer Data bit width

Column name Type Description
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A.20 Motherboard

Motherboard information, one entry per managed_obj_id.

IBM DB2 table name: TWG_MOTHERBRD_ID

MS-SQL table name: TWG_MOTHERBOARD_ID

Table 35. DB table: motherboard

A.21 Network adapter

This is information about network adapters, one entry per adapter.

IBM DB2 table name: TWG_NETWORK_ADAPT

MS-SQL table name: TWG_NETWORK_ADAPTER

Table 36. DB table: network adapter

A.22 On-board device

This is information about on-board-devices, one entry per device.

IBM DB2 table name: TWG_ONBOARD_DEV

FORM_FACTOR Char(10) Form factor, for example: DIMM

MEMORY_TYPE Char(16) Memory type, for example: SDRAM

MEMORY_ERROR Char(8) Indicates if there has been a failure

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

MANUFACTURER Char(40) Manufacturer

PRODUCT Char(40) Product

VERSION Char(40) Version

SERIAL_NUMBER Char(40) System board serial number

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

ADAPTER_INDEX Integer not null Index number

ADAPTER_TYPE Char(20) Adapter type, for example: ETHERNET,
TOKENRING, PPP

MAC_ADDRESS Char(12) MAC address

CANONICAL_ADDRESS Char(12) Canonical MAC address

DESCRIPTION Char(80) Adapter description

Column name Type Description
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MS-SQL table name: TWG_ONBOARD_DEV

Table 37. DB table: on-board device

A.23 Operating system

Operating system information, one entry per operating system installed.

IBM DB2 table name: TWG_OPERATING_SYS

MS-SQL table name: TWG_OPERATING_SYSTEM

Table 38. DB table: operating system

A.24 Parallel port

Parallel port information, one entry per parallel port.

IBM DB2 table name: TWG_PARALLEL_PORT

MS-SQL table name: TWG_PARALLEL_PORT

Table 39. DB table: parallel port

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

DEVICE_INDEX Integer not null Index number

DEVICE_TYPE Char(20) Device type, for example: ETHERNET,
SOUND, VIDEO, OTHER

DEVICE_STATUS Char(20) Device status

DESCRIPTION Char(80) Description, for example: ALERTPACK,
RFID, ETHERNET

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

OP_SYS_INDEX Integer not null Index number

OP_SYS_NAME Char(64) Name of operating system, for example:
WIN95, WINNT, NETWARE, OS2

OP_SYS_TYPE Char(64) Type, for example: WINDOWS_NT,
WINDOWS_9X, NETWARE, OS2

OP_SYS_VERSION Char(64) Operating system version

OP_SYS_PRIMARY Char(20) Is this the primary operating system, for
example: TRUE/FALSE

OP_SYS_REVISION Char(32) Revision, build level, service pack, for
example: 1381 SERVICE PACK 4

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

PORT_INDEX Integer not null Index number
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A.25 Partition

Partition information, one entry per partition on system. See also A.9, “Disk” on
page 292 and A.17, “Logical drive” on page 295.

IBM DB2 table name: TWG_PARTITION

MS-SQL table name: TWG_PARTITION

Table 40. DB table: partition

A.26 PCI device

This is information on PCI subsystem, one entry per PCI slot number per PCI
bus.

IBM DB2 table name: TWG_PCI_DEVICE

MS-SQL table name: TWG_PCI_DEVICE

Table 41. DB table: PCI device

BASE_IO_ADDRESS Integer Base IO address

LOGICAL_NAME Char(32) Logical name, for example: LPT1

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

PARTITION_INDEX Integer not null Index number

PARTITION_NAME Char(32) Partition name/drive letter, for example:
C:, D:, SYS

PART_TOTAL_SIZE_KB
PARTITION_TOTAL_SIZE_
KB

Integer Total size of partition in kilobytes

PART_FREE_SIZE_KB
PARTITION_FREE_SIZE_
KB

Integer Free size of partition in kilobytes

PARTITION_LABEL Char(40) Partition label

PART_FILESYSTEM
PARTITION_FILESYSTEM

Char(32) File system, for example: NTFS, FAT,
FAT32, HPFS, NETWARE

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

PCI_BUS_NUMBER Integer not null PCI bus number

PCI_SLOT_NUMBER Integer not null PCI slot number

PCI_DEVICE_NUMBER Integer not null PCI device number

MANUFACTURER Char(40) Manufacturer

Column name Type Description
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A.27 Physical enclosure

This is information about the physical system, one entry per managed_obj_id.
See also A.8, “Component ID” on page 291.

IBM DB2 table name: TWG_PHYS_CONT_GBL

MS-SQL table name: TWG_PHYS_CONTAINER_GLOBAL

Table 42. DB table: physical enclosure

A.28 Pointing device

This is information on the pointing device, one entry per managed_obj_id.

IBM DB2 table name: TWG_POINT_DEVICE

PCI_TYPE Char(40) PCI device type

CLASS_CODE Integer Class Code

VENDOR_ID Integer Vendor ID

DEVICE_ID Integer Device ID

REVISION_ID Integer Revision ID

CACHE_LINE_SIZE Integer Cache line size

LATENCY_TIMER Integer Latency timer

MIN_GNT Integer Minimum GNT

MAX_LAT Integer Maximum LAT

INTERRUPT_LINE Integer Interrupt line

INTERRUPT_PIN Integer Interrupt Pin

ROM_BASE_ADDRESS Integer ROM base address

HEADER_TYPE Integer Header type

BIST Integer Built-In-Self-Test

COMMAND_REGISTER Integer Command register

STATUS_REGISTER Integer Status register

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

ASSET_TAG Char(80) Asset tag

MACHINE_MODEL_NAME Char(80) Machine model name

MACHINE_TYPE Char(20) Machine type

MACHINE_MODEL Char(20) Machine model

MACHINE_SERIAL Char(40) Machine serial number

Column name Type Description
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MS-SQL table name: TWG_POINTING_DEVICE

Table 43. DB table: pointing device

A.29 Printer

Printer information, one entry per printer.

IBM DB2 table name: TWG_PRINTER

MS-SQL table name: TWG_PRINTER

Table 44. DB table: printer

A.30 Processor

Processor information, one entry per processor.

IBM DB2 table name: TWG_PROCESSOR

MS-SQL table name: TWG_PROCESSOR

Table 45. DB table: processor

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

INTERFACE Char(30) Interface type, for example: PS2

BUTTONS Integer Number of buttons

DOUBLE_CLICK_RATE Integer Double-click interval in milliseconds

HANDEDNESS Char(20) Handedness, for example: RIGHT

SENSITIVITY Integer Sensitivity/cm

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

PRINTER_INDEX Integer not null Index number

PORT Char(40) Port number, for example: LPT1

QUEUE Char(40) Queue

DRIVER Char(40) Driver

MODEL Char(40) Printer model

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

PROCESSOR_INDEX Integer not null Index number

PROCESSOR_TYPE Char(32) Processor type, for example: CPU,
MATH or VIDEO

FAMILY Char(32) Processor family, for example:
PENTIUMII
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A.31 SCSI adapter

SCSI adapter information, one entry per adapter.

IBM DB2 table name: TWG_SCSI_ADAPTER

MS-SQL table name: TWG_SCSI_ADAPTER

Table 46. DB table: SCSI adapter

VERSION Char(80) Processor version

MAXIMUM_SPEED Integer Maximum speed of processor in MHz

CURRENT_SPEED Integer Current speed of processor in MHz

INTERNAL_CACHE Char(20) Internal cache activated, for example:
ENABLED

EXTERNAL_CACHE Char(20) External cache activated, for example:
NOT_INSTALLED

PROCESSOR_SERIAL Char(40) Processor serial number

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

SCSI_ADAPTER_INDEX Integer not null Index number

ADAPTER_TYPE Char(40) Adapter type

LOCATION Char(40) Adapter location, for example: PLANAR

PUN Integer PUN

LUN Integer LUN

BUS_TYPE Char(40) Bus type, for example: SCSI-II

BUS_WIDTH Integer Bus width

IO_ACCESS Char(40) IO access

HOST_BUS Char(40) Host bus

HOST_BUS_WIDTH Integer Host bus width

ADDRESS_OVER_16 Char(40) Address over 16

SCB_COMMANDS Char(40) SCB commands

SCATTER_GATHER Char(40) Scatter/gather

CHS Char(40) Cylinder/head/sector addressing

MAX_SCAT_GTHR_LIST
MAX_SCATTER_GATHER
_LIST

Integer Max scatter/gather list

MAX_CDB_LENGTH Integer Max CDB length

ADD_MAJOR_LEVEL Integer ADD major level

Column name Type Description
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A.32 SCSI device

SCSI device information, one entry per device per adapter.

IBM DB2 table name: TWG_SCSI_DEVICE

MS-SQL table name: TWG_SCSI_DEVICE

Table 47. DB table: SCSI device

A.33 Serial port

Serial port information, one entry per port.

IBM DB2 table name: TWG_SERIAL_PORT

MS-SQL table name: TWG_SERIAL_PORT

Table 48. DB table: serial port

ADD_MINOR_LEVEL Integer ADD minor level

DEVICES_CONNECTED Integer Number of devices connected

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

SCSI_ADAPTER_INDEX Integer not null Index number

SCSI_DEVICE_INDEX Integer not null Index number

PUN Integer PUN

LUN Integer LUN

DEVICE_TYPE Char(32) Device type, for example: FIXED

DEVICE_SIZE Integer Device size in kilobytes

VENDOR_ID Char(40) Vendor ID/description

PRODUCT_ID Char(40) Product ID/description

PRODUCT_REV_LEVEL
PRODUCT_REVISION_LE
VEL

Char(40) Revision level

VENDOR_STRING Char(254) Vendor string

VENDOR_DATA Char(254) Vendor data

SERIAL_NUMBER Char(40) Serial number

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

PORT_INDEX Integer not null Index number

BASE_IO_ADDRESS Integer Base IO address

Column name Type Description
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A.34 Software

Software information, one entry per application.

IBM DB2 table name: TWG_SOFTWARE

MS-SQL table name: TWG_SOFTWARE

Table 49. DB table: software

A.35 System

This is information on inventory request, one entry per managed_obj_id.

IBM DB2 table name: TWG_MANAGED_OBJEC

MS-SQL table name: TWG_MANAGED_OBJECT

Table 50. DB table: system

LOGICAL_NAME Char(32) Logical name, for example: COM1

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

PROGRAM_TITLE Char(64) not
null

Program title.

INSTALL_PATH Char(154 /
254) not null

Install path, for example:
C:\winnt\system32

VERSION_ID Char(16) Version number

VENDOR_NAME Char(32) not
null

Vendor name

REVISION Char(32) Revision

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

LABEL Char(64) System name

DATE_CREATED Timestamp Date system was discovered in NF
Director

FIRST_ATTEMPT Timestamp Date/time of first attempt of inventory
request

LAST_ATTEMPT Timestamp Date/time of last attempt of inventory
request

LAST_UPDATE Timestamp Date/time of last successful inventory
request

Column name Type Description
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A.36 System BIOS

System BIOS information, one entry per managed_obj_id.

IBM DB2 table name: TWG_SYSTEM_BIOS

MS-SQL table name: TWG_SYSTEM_BIOS

Table 51. DB table: system BIOS

A.37 System location

This is information on where the system is located. This data is changed in the
local twguser.ini file, one entry per managed_obj_id. See also A.39, “System
user” on page 306.

IBM DB2 table name: TWG_SYS_LOCATION

MS-SQL table name: TWG_SYSTEM_LOCATION

Table 52. DB table: system location

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

BIOS_INDEX Integer not null Index number

BIOS_MANUFACTURER Char(40) BIOS manufacturer

BIOS_VERSION Char(128) BIOS version

BIOS_RELEASE_DATE Date BIOS date

BIOS_SM_VERSION Char SMBIOS revision

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

CITY Char(32) City

STATE Char(32) State

ZIPCODE Char(16) Zip code

COUNTRY Char(32) Country

ROOM_NUMBER Char(32) Room number

BUILDING Char(32) Building location

FLOOR Char(32) Building floor

LATITUDE Char(32) Latitude

LONGITUDE Char(32) Longitude

USER_DATA1 Char(254)

USER_DATA2 Char(254)
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A.38 System resource

This is information about the resources of the system, one entry per
managed_obj_id.

IBM DB2 table name: TWG_SYS_RESOURCE

MS-SQL table name: TWG_SYSTEM_RESOURCE

Table 53. DB table: system resource

A.39 System user

This is information about the user of this system. This data is changed in the local
twguser.ini file, one entry per managed_obj_id. See also A.37, “System location”
on page 305.

IBM DB2 table name: TWG_SYSTEM_USER

MS-SQL table name: TWG_SYSTEM_USER

Table 54. DB table: system user

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

RESOURCE_INDEX Integer not null Index number

RESOURCE_USER Integer User index

RESOURCE_SET Integer Set index

DESCRIPTION Char(80) Description

RESOURCE_TYPE Char(20) Resource type, for example: IRQ, DMA,
MEMORY

RESOURCE_NUMBER Integer Resource number

START_ADDRESS Char(16) Starting memory address

END_ADDRESS Char(16) Ending memory address

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

FIRST_NAME Char(32) First name

MIDDLE_NAME Char(32) Middle name

LAST_NAME Char(32) Last name

EMPLOYEE_ID Char(32) Employee ID

TITLE Char(32) Title

DEPT_NAME Char(32) Department name

DEPT_NUMBER Char(32) Department number

DIVISION Char(32) Division

WORK_PHONE Char(32) Office telephone number
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A.40 Video

Video subsystem information, one entry per video subsystem.

IBM DB2 table name: TWG_VIDEO

MS-SQL table name: TWG_VIDEO

Table 55. DB table: video

CELLULAR_PHONE Char(32) Cellular telephone number

FAX_NUMBER Char(32) Office fax number

PAGER_NUMBER Char(32) Office pager number

PAGER_TYPE Char(32) Office pager type

EMAIL_ADDRESS Char(128) Office e-mail address

HOME_PHONE Char(32) Home telephone number

Column name Type Description

MANAGED_OBJ_ID Integer not null Identifies unique system ID

VIDEO_INDEX Integer not null Index number

VIDEO_TYPE Char(40) Type of display in use, for example:
SVGA, VGA, XGA

VIDEO_ADAPTER Char(40) Type of adapter in use

VIDEO_MEMORY_KB Integer Amount of memory in kilobytes

COLORS Integer Number of colors displayed

HORIZONTAL_RES Integer Horizontal resolution in pixels

VERTICAL_RES Integer Vertical resolution in pixels

Column name Type Description
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Appendix B. Special notices

This publication is intended to help systems management professionals
implement Netfinity Director in their existing environments. The information in this
publication is not intended as the specification of any programming interfaces that
are provided by the Netfinity Director product. See the PUBLICATIONS section of
the IBM Programming Announcement for Netfinity Director for more information
about what publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not imply
that IBM intends to make these available in all countries in which IBM operates.
Any reference to an IBM product, program, or service is not intended to state or
imply that only IBM's product, program, or service may be used. Any functionally
equivalent program that does not infringe any of IBM's intellectual property rights
may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment
specified, and is limited in application to those specific hardware and software
products and levels.

IBM may have patents or pending patent applications covering subject matter in
this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to the IBM Director of
Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact IBM Corporation, Dept.
600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal
IBM test and is distributed AS IS. The information about non-IBM ("vendor")
products in this manual has been supplied by the vendor and IBM assumes no
responsibility for its accuracy or completeness. The use of this information or the
implementation of any of these techniques is a customer responsibility and
depends on the customer's ability to evaluate and integrate them into the
customer's operational environment. While each item may have been reviewed
by IBM for accuracy in a specific situation, there is no guarantee that the same or
similar results will be obtained elsewhere. Customers attempting to adapt these
techniques to their own environments do so at their own risk.

Any pointers in this publication to external Web sites are provided for
convenience only and do not in any manner serve as an endorsement of these
Web sites.

Any performance data contained in this document was determined in a controlled
environment, and therefore, the results that may be obtained in other operating
environments may vary significantly. Users of this document should verify the
applicable data for their specific environment.
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Reference to PTF numbers that have not been released through the normal
distribution process does not imply general availability. The purpose of including
these reference numbers is to alert IBM customers to specific information relative
to the implementation of the PTF when it becomes available to each customer
according to the normal IBM PTF distribution process.

The following terms are trademarks of the International Business Machines
Corporation in the United States and/or other countries:

The following terms are trademarks of other companies:

C-bus is a trademark of Corollary, Inc. in the United States and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and/or other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States and/or other countries.

PC Direct is a trademark of Ziff Communications Company in the United States
and/or other countries and is used by IBM Corporation under license.

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel
Corporation in the United States and/or other countries.

UNIX is a registered trademark in the United States and/or other countries
licensed exclusively through X/Open Company Limited.

SET and the SET logo are trademarks owned by SET Secure Electronic
Transaction LLC.

Other company, product, and service names may be trademarks or service marks
of others.

AIX Alert on LAN
AS/400 Asset ID
DB2 IBM
LANClient Control Manager Netfinity
Netfinity Manager NetView
OS/2 OS/390
PC 300 RS/6000
S/390 ServeRAID
SMART Reaction SP
SP1 System/390
ThinkPad ViaVoice
Wake on LAN WebSphere
XT 400
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Appendix C. Related publications

The publications listed in this section are considered particularly suitable for a
more detailed discussion of the topics covered in this redbook.

C.1 International Technical Support Organization publications

For information on ordering these ITSO publications see “How to get IBM
Redbooks” on page 313.

• Netfinity Server Management, SG24-5208

• Integration Examples for Tivoli IT Director: A First Look, SG24-5207

• Using LCCM Functions with Servers and Workstations, SG24-5292

• Universal Management Agent: Functions and Integration, SG24-5294

• Universal Manageability: Enterprise Management Integration, SG24-5388

C.2 IBM Redbooks collections

Redbooks are also available on the following CD-ROMs. Click the CD-ROMs
button at http://www.redbooks.ibm.com/ for information about all the CD-ROMs
offered, updates and formats.

C.3 Referenced Web sites

These Web sites are also relevant as further information sources:

http://www.dmtf.org

http://www.w3.org/XML

http://www.ibm.com/xml

http://www.pc.ibm.com/us/desktop/alertonlan/softreqs.html

http://www.pc.ibm.com/us/desktop/alertonlan/index.html

http://www.intel.com/network/network_strategy/aol.htm

http://www.pc.ibm.com/us/desktop/alertonlan/syssupport.html

http://www.redbooks.ibm.com

CD-ROM Title Collection Kit
Number

System/390 Redbooks Collection SK2T-2177
Networking and Systems Management Redbooks Collection SK2T-6022
Transaction Processing and Data Management Redbooks Collection SK2T-8038
Lotus Redbooks Collection SK2T-8039
Tivoli Redbooks Collection SK2T-8044
AS/400 Redbooks Collection SK2T-2849
Netfinity Hardware and Software Redbooks Collection SK2T-8046
RS/6000 Redbooks Collection (BkMgr Format) SK2T-8040
RS/6000 Redbooks Collection (PDF Format) SK2T-8043
Application Development Redbooks Collection SK2T-8037
IBM Enterprise Storage and Systems Management Solutions SK3T-3694
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http://www.redbooks.ibm.com/abstracts/sg245208.html

http://www.microsoft.com/SQL/70/whpprs/jetmsde.htm

http://www.elink.ibmlink.ibm.com/pbl/pbl

http://w3.itso.ibm.com

http://w3.ibm.com
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How to get IBM Redbooks

This section explains how both customers and IBM employees can find out about IBM Redbooks, redpieces, and
CD-ROMs. A form for ordering books and CD-ROMs by fax or e-mail is also provided.

• Redbooks Web Site http://www.redbooks.ibm.com/

Search for, view, download, or order hardcopy/CD-ROM Redbooks from the Redbooks Web site. Also read
redpieces and download additional materials (code samples or diskette/CD-ROM images) from this Redbooks
site.

Redpieces are Redbooks in progress; not all Redbooks become redpieces and sometimes just a few chapters will
be published this way. The intent is to get the information out much quicker than the formal publishing process
allows.

• E-mail Orders

Send orders by e-mail including information from the IBM Redbooks fax order form to:

• Telephone Orders

• Fax Orders

This information was current at the time of publication, but is continually subject to change. The latest information
may be found at the Redbooks Web site.

In United States
Outside North America

e-mail address
usib6fpl@ibmmail.com
Contact information is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada (toll free)
Outside North America

1-800-879-2755
1-800-IBM-4YOU
Country coordinator phone number is in the “How to Order” section at
this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada
Outside North America

1-800-445-9269
1-403-267-4455
Fax phone number is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

IBM employees may register for information on workshops, residencies, and Redbooks by accessing the IBM
Intranet Web site at http://w3.itso.ibm.com/ and clicking the ITSO Mailing List button. Look in the Materials
repository for workshops, presentations, papers, and Web pages developed and written by the ITSO technical
professionals; click the Additional Materials button. Employees may access MyNews at http://w3.ibm.com/ for
redbook, residency, and workshop announcements.

IBM Intranet for Employees
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IBM Redbooks fax order form
Please send me the following:

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not
available in all countries. Signature mandatory for credit card payment.

Title Order Number Quantity

First name Last name

Company

Address

City Postal code

Telephone number Telefax number VAT number

Invoice to customer number

Country

Credit card number

Credit card expiration date SignatureCard issued to
314 Netfinity Director - Integration and Tools



Index

A
ACPI 34
Actions menu 102
administrator rights 41
Advanced System Management 169
Advanced System Manager 240
Agent 29
Alert Type 255, 259
Application Alert Type 255, 259
Application ID 255, 259
automatic discovery 75

B
BIOS 34, 78, 176, 180, 190, 216

C
capacity management 170
Capacity Manager 170, 180, 240
CIM 33, 78, 105, 116, 243, 244
community name 26
CSV 158, 270
Custom 146

D
DB tables 213, 214, 219
DB2 46, 140, 198, 201
DB2 Node Name 205
default group 117
default groups 105
discovery 72, 73, 74, 76
DMI 33, 116, 191, 244
dynamic group 115, 116

E
EEPROM 191
event filter 104, 125, 126
Extended Attributes 122
extensions 168

F
Fail 100

G
genalert 248, 260
genevent 248, 258
group function 265, 277

I
inventory scan 75

J
Java class libraries 37
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K
keywords 239

L
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license key 42
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Lotus Approach 160
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M
maximum colors 87
maximum resolution 87
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MMC 58
mobile 1
modem 179, 180
MPM 105, 122
MPM API 235, 262
MPM parameters 74
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Network Time-Out 47
NT Event Log 120, 122, 135
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ODBC connection 212
OnNow 34
OS/2 103, 105, 181, 186, 235, 240

P
port 58
POST 180
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rack group 237
Remote System Manager 237
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Scheduler 90, 95
SDK 1
Sender ID 255, 259
ServeRAID Manager 186, 189
servers 1
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Software Dictionary 149, 153
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SQL 46, 140, 198, 206
SQL services 210
standards 1
Start 100
static groups 105, 108
Stop 100
System DSN 230
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tables 213
TCP/IP 1, 18, 29, 36, 37, 38, 48, 63, 71, 176
threshold 85, 86, 180
ticker tape 73, 128, 258, 284
Trap Destination 24
Traps 29, 33
TWGAdmin 49
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variables 131
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IBM Redbooks evaluation

Netfinity Director - Integration and Tools
SG24-5389-00

Your feedback is very important to help us maintain the quality of IBM Redbooks. Please complete this
questionnaire and return it using one of the following methods:

• Use the online evaluation form found at http://www.redbooks.ibm.com/
• Fax this form to: USA International Access Code + 1 914 432 8264
• Send your comments in an Internet note to redbook@us.ibm.com
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